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Product information

B Product desCriplion . ... . e e 9
B Kitcontents and storage . ... e 11
B Required materials not supplied .. ... ... i e e 16
B Recommended materials for quantification and quality control ............................. 18
B Recommended materials . ... ...t e 19
B WOrKflOW OVeIVIEW . ..o e e 20

CAUTION! ABBREVIATED SAFETY ALERTS. Hazard symbols and hazard types specified in
procedures may be abbreviated in this document. For the complete safety information, see the
“Safety” appendix in this document.

IMPORTANT! Before using this product, read and understand the information in the “Safety” appendix
in this document.

Product description

The lon ReproSeq™ PGS Kits — lon S5™/lon GeneStudio™ S5 Systems provide reagents and materials
for high-throughput whole-genome amplification and sequencing to detect chromosomal aneuploidies,
chromosome arm events (>48 Mbp), and copy number variations starting from a single cell. The kits are
used with the lon Chef™ System, and the lon S5™/lon S5™ XL System or one of the lon GeneStudio™
S5 Systems, which enable automated template preparation, chip loading, and sequencing to minimize
hands-on time.

The lon SingleSeg™ Kit, a component of each lon ReproSeq™ PGS Kit, includes reagents to extract,
amplify, and barcode genomic DNA for preparing libraries from up to 24 or 96 samples. The lon
ReproSeq™ PGS Kits also include reagents to prepare templates and load four chips on the lon Chef™
Instrument, and sequence the chips on an lon S5™/lon S5™ XL Sequencer or one of the lon
GeneStudio™ S5 Series Sequencers. Depending on the kit that is used, up to 384 samples can be
sequenced per Kkit.

The lon AmpliSeq™ Polyploidy Panel Kits (available separately) include 74 microhaplotype amplicons for
human identification and 368 single SNP amplicons representing the population at large. With a total of
590 SNP sites covered, the lon AmpliSeq™ Polyploidy Panel Kits unveil the unique genomic variations
present in each embryo sample, facilitating premium PGT-A analysis. By leveraging SNPs, PGT-A

lon ReproSeq™ PGS Kits — lon S5™/lon GeneStudio™ S5 Systems User Guide 9
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analysis gains valuable insights into triploidy 69,XXX, maternal contamination, and embryo identity,
facilitating the selection of embryos for in vitro fertilization research.

lon ReproSeq™ PGS Kit Samples per kit
lon ReproSeq™ PGS Kit with lon 510™ Chips (16 samples/run) 64
lon ReproSeq™ PGS Kit with lon 520™ Chips (24 samples/run) 96
lon ReproSeq™ PGS Kit with lon 530™ Chips (96 samples/run) 384

Instrument compatibility

The lon ReproSeq™ PGS Kits described in this user guide are compatible with the lon S5™/lon S5™ XL
Sequencers and lon GeneStudio™ S5 Series Sequencers. We recommend using the lon S5™ XL, lon
GeneStudio™ S5 Plus, or lon GeneStudio™ S5 Prime Sequencer for rapid turnaround between runs. Use
of the kits with the lon S5™ or lon GeneStudio™ S5 Sequencer requires more analysis time between
runs.

Software compatibility

10

The instrument software is updated to the latest available version.

The lon Torrent™ Server to that is connected to, or included with, the instrument is updated to
the latest available version of Torrent Suite™ Software. For more information, see Appendix C,
“Connections between lon Torrent™ Server and the lon Chef™ Instrument”.

If using the lon AmpliSeq™ Polyploidy Panel, the following target regions and hotspots files should
be installed in Torrent Suite™ Software.

— Target regions file — Ion AmpliSeq Polyploidy Panel wl.0.0.bed
- Hotspots file — Ton AmpliSeq Polyploidy Hotspots wl.0.0.bed

To view data and analysis results for the lon AmpliSeq™ Polyploidy Panel, the
ReproSeqSnpAnalysis plugin is installed in Torrent Suite™ Software. For more information, see
“Install or upgrade plugins” on page 140.

Note: You can configure Torrent Suite™ Software to run the ReproSeqSnpAnalysis plugin
automatically when you create a Planned Run. However, you must run this plugin manually if you
want to include sibling QC analysis results in the plugin results. For more information, see “Run the
plugin manually from the sequencing run report for Sibling QC data” on page 126.

To visualize aneuploidy results, lon Reporter™ Software 5.10 or later is required. However, for the
latest features and analysis workflows, we recommend that you use lon Reporter™ Software 5.20.

lon ReproSeq™ PGS Kits — lon S5™/lon GeneStudio™ S5 Systems User Guide




Kit contents and storage

Kit configurations

Chapter 1 Product information 5

h

Kit contents and storage

Three configurations of the lon ReproSeg™ PGS Kits — lon S5™/lon GeneStudio™ S5 Systems are
available. The kits vary in the number and size of lon SingleSeq™ Kits provided, the maximum number

of samples processed per kit, and the type of lon S5™ sequencing chip provided.

lon ReproSeq™ PGS Kit

Amount per kit

Samples per kit

lon ReproSeq™ PGS Kit with lon 510™ Chips (16 samples/run); Cat. No. A34899

lon SingleSeq™ Kit (24 reactions) 3 boxes 64l
lon S5™ ExT Chef Supplies 4 boxes

lon S5™ Chef Solutions 4 cartridges

lon S5™ ExT Chef PGS Reagents 4 cartridges

lon S5™ EXT Sequencing Solutions 1 box

lon S5™ EXT Sequencing Reagents 4 cartridges

lon 510™ Chip Kit 4 chips

lon ReproSeq™ PGS Kit with lon 520™ Chips (24 samples/run); Cat. No. A34900

lon SingleSeq™ 96 Kit (96 reactions) 1 x 2 boxes 96
lon S5™ ExT Chef Supplies 4 boxes

lon S5™ Chef Solutions 4 cartridges

lon S5™ ExT Chef PGS Reagents 4 cartridges

lon S5™ EXT Sequencing Solutions 1 box

lon S5™ EXT Sequencing Reagents 4 cartridges

lon 520™ Chip Kit 4 chips

lon ReproSeq™ PGS Kit with lon 530™ Chips (96 samples/run); Cat. No. A34901

lon SingleSeq™ 96 Kit (96 reactions) 4 x 2 boxes 384
lon S5™ ExT Chef Supplies 4 boxes

lon S5™ Chef Solutions 4 cartridges

lon S5™ ExT Chef PGS Reagents 4 cartridges

lon S5™ EXT Sequencing Solutions 1 box

lon ReproSeq™ PGS Kits — lon S5™/lon GeneStudio™ S5 Systems User Guide
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(continued)

lon ReproSeq™ PGS Kit Amount per kit Samples per kit
lon S5™ EXT Sequencing Reagents 4 cartridges 384
lon 530™ Chip Kit 4 chips

" We recommend loading 16 sample libraries per lon 510™ Chip. However, 3 boxes of the lon SingleSeq™ Kit provide reagents and
barcode adapters to prepare 72 libraries. The leftover reagents and barcode adapters can be used with the next purchased kit.

lon SingleSeq™ Kit

Use the lon SingleSeg™ Kit (Part No. A28955; 24 reactions/kit) to extract, amplify, and barcode genomic
DNA. Immediately before use, thaw tubes on ice if needed.

Component Amount Storage
Cell Extraction Buffer (green cap) 120 pL -30°C to
Extraction Enzyme Dilution Buffer (violet cap) 115.2 yL -lore
Cell Extraction Enzyme (yellow cap) 4.8 uL
Pre-Amplification Buffer (red cap) 115.2 yL
Pre-Amplification Enzyme (white cap) 4.8 uL
Amplification Buffer (orange cap) 648 uL
Ampilification Enzyme (blue cap) 12 pL
Nuclease-free Water (clear cap) 432 pL
Barcode Plate (lon SingleSeq™ Barcode Adapters loaded in wells 1 plate; 5 pL/well (Barcodes
A1-H3 or wells A1-H12) 1-24)

Use the lon SingleSeq™ 96 Kit (Part No. A34763; 96 reactions/kit) to extract, amplify, and barcode
genomic DNA. Immediately before use, thaw tubes on ice if needed.

Component Amount Storage
lon SingleSeq™ Reagents (Part. No. A52555)
Cell Extraction Buffer (green cap) 480 uL -25°C to
Extraction Enzyme Dilution Buffer (violet cap) 460.8 pL m1e%C
Cell Extraction Enzyme (yellow cap) 19.2 uL
Pre-Amplification Buffer (red cap) 460.8 pL
Pre-Amplification Enzyme (white cap) 19.2 uL
Amplification Buffer (orange cap) 3 x 864 pL
Amplification Enzyme (blue cap) 48 pL
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(continued)
Component Amount Storage
Nuclease-free Water (clear cap) 432 pL -25°C to
-15°C

lon SingleSeq™ Barcode Plate Set 1-96 (Part. No. A52556)

Barcode Plate (lon SingleSeq™ Barcode Adapters loaded in 1 plate; 5 pL/well (Barcodes 1-96) | -25°C to
-15°C

wells A1-H3 or wells A1-H12)

lon ReproSeq™ PGS Kits — lon S5™/lon GeneStudio™ S5 Systems User Guide
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About the lon SingleSeq™ Barcode Adapters

The lon SingleSeq™ Kit is designed for high throughput applications and includes a 96-well Barcode
Plate containing Barcode Adapters 1-24 or 1-96. Each well contains sufficient volume for a single use.
The plate is sealed with foil that can be pierced with a pipet tip to collect the required amount of the
Barcode Adapter for a reaction.

To minimize cross-contamination, either use all barcodes in a plate at once, or if you are using a subset,
seal the pierced wells with laboratory tape.

IMPORTANT!

. Do not substitute barcode oligonucleotides from any other source for the Barcode Adapters
contained in this kit.

. Avoid repeated freezing and thawing of the plate. Do not exceed 4 freeze/thaw cycles.

4 5 6 7 8 910 1112

Barcode Plate containing lon SingleSeq™ Barcodes 1-24. Twenty-four unique Barcode Adapters are loaded in wells A1
through H3.
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Barcode Plate containing lon SingleSeq™ Barcodes 1-96. Ninety-six unique Barcode Adapters are loaded in wells A1
through H12.

Note: Barcodes 1-24 in the lon SingleSeq™ Barcodes 1-96 plate are identical to the Barcode Adapters
in the lon SingleSeg™ Barcodes 1-24 plate.
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lon S5™ EXT Kit components

IMPORTANT! Do not substitute components from any other lon sequencing kits. This protocol was
verified using these specific materials. Substitution can adversely affect system performance.

IMPORTANT! Store all consumables and cartridges under the recommended conditions and in an
upright position. Do NOT store the lon S5™ EXT Sequencing Reagents (Part No. A30522) on dry ice or in

a closed environment where dry ice is present.

The lon ReproSeq™ PGS 510, 520, and 530 Kits support 4 initializations, and contain all materials
required for preparing and sequencing 4 lon 510™, lon 520™, or lon 530™ Chips. On arrival, inspect all
consumables and contact Technical Support if any of the products were damaged during shipping.

Contents Amount/box Storage
lon S5™ EXT Chef Supplies (Part No. A30673)

Chip Adapter 1 15°C to 30°C
Enrichment Cartridge v2 1

lon S5™ EXT Tip Cartridge 1

PCR Plate 1

PCR Plate Frame 1

Frame Seal v2 1

Recovery Station Disposable Lid v2 2

Recovery Tube 12

lon S5™ Chef Solutions (Part No. A27754)
lon S5™ Chef Solutions 4 cartridges 15°C to 30°C

lon S5™ EXT Chef PGS Reagents (Part No. A34676)

lon S5™ EXT Chef PGS Reagents 4 cartridges

-30°C to -10°C

lon S5™ EXT Sequencing Solutions (Part No. A30521)

lon S5™ EXT Wash Solution 4x15L

lon S5™ Cleaning Solution 250 mL

15°C to 30°C

lon S5™ ExT Sequencing Reagents (Part No. A30522)

lon S5™ EXT Sequencing Reagents 4 cartridges

-30°C to -10°C

lon ReproSeq™ PGS Kits — lon S5™/lon GeneStudio™ S5 Systems User Guide
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Required materials not supplied

Unless otherwise indicated, all materials are available through thermofisher.com. "MLS" indicates that
the material is available from fisherscientific.com or another major laboratory supplier.

Item Source

lon AmpliSeq™ Polyploidy Panel Kits

lon AmpliSeq™ Polyploidy Panel Kit with lon 520™ Chips (80 Samples) GS45691

lon AmpliSeq™ Polyploidy Panel Kit with lon 530™ Chips (480 Samples) GS45690

Materials and equipment required for lon SingleSeq™ & lon AmpliSeq™ Polyploidy Panel library
preparation

ViiA™ 7 Real-Time PCR System with 96-Well Block (recommended), or 4453534
Veriti™ 96-Well Thermal Cycler (0.2-mL block; for standard PCR amplification), 4452300
or

equivalent real-time or standard thermal cycler with heated lid

MicroAmp™ Optical 96-Well Reaction Plate N8010560
MicroAmp™ Optical Adhesive Film (for real-time PCR) 4360954

MicroAmp™ Clear Adhesive Film (for standard endpoint PCR)[1] 4306311

or equivalent

(Optional) MicroAmp™ Optical 8-Tube Strip, 0.2 mL2 4316567

MicroAmp™ Optical 8-Cap Strip 4323032

or MicroAmp™ Reaction Tube with Cap, 0.2 mL N8010540

or equivalent

96-Well Tray/Retainer Set specific to your instrument

Agencourt™ AMPure™ XP Reagent Fisher Scientific NC9959336
DynaMag™-2 Magnet 12321D
1.5-mL Eppendorf™ DNA LoBind™ Microcentrifuge Tubesl! Fisher Scientific 13-698-791
Qubit™ 4 Fluorometer!¥l Q33238
Qubit™ dsDNA HS Assay Kit Q32851

Q32854
Qubit™ Assay Tubes Q32856
Ethanol MLS
Low TE (10 mM Tris pH 8.0, 0.1 mM EDTA) MLS
Phosphate-buffered saline (1X PBS, Ca2*-free, Mg2*-free, BSA-free) MLS
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https://www.thermofisher.com/order/catalog/product/4360954
https://www.thermofisher.com/order/catalog/product/4306311
https://www.thermofisher.com/order/catalog/product/4316567
https://www.thermofisher.com/order/catalog/product/4323032
https://www.thermofisher.com/order/catalog/product/N8010540
https://www.fishersci.com/us/en/catalog/search/products?keyword=NC9959336
https://www.thermofisher.com/order/catalog/product/12321D
https://www.fishersci.com/us/en/catalog/search/products?keyword=13-698-791
https://www.thermofisher.com/order/catalog/product/Q33238
https://www.thermofisher.com/order/catalog/product/Q32851
https://www.thermofisher.com/order/catalog/product/Q32854
https://www.thermofisher.com/order/catalog/product/Q32856
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h
Required materials not supplied

(continued)

ltem Source
Nuclease-free Water AM9932
SYBR™ Green | Nucleic Acid Gel Stain, 10,000X concentrate in DMSO! S-7567
ROX™ Reference Dyel®] 12223-012
2,10, 20, 200, 1000 pL pipettor set and filtered tips MLS
Multichannel pipettors (2-20 pyL and 20-200 pL; 8 channel) MLS
(Optional) E-Gel™ Agarose Gels, 2%, and E-Gel™ iBase™ Power System, or Various
E-Gel™ PowerBase™ System, or equivalent
Additional materials required for templating and sequencing
lon Chef™ S5 Series Chip Balance A29022
Non-interruptible Power Supply (UPS)L¢] MLS
Gloves, powder-free nitrile MLS
Isopropanol, 70% solution MLS
Wipes, disposable lint-free MLS

" Recommended for all plate sealing other than real-time ampilification reactions for easier application and removal.
[l For standard end-point PCR amplification, standard tube strips and caps can be substituted.

B Can substitute 2.0-mL Eppendorf LoBind™ Tubes for 1.5-mL tubes.
' Qubit™ 2.0 Fluorometer and later are supported.
Bl Required if monitoring amplification by real-time PCR.

1 For laboratories that experience frequent power outages or line voltage fluctuations, we recommend that you use a non-interruptible

power supply that provides 2500 W output or higher.

Compatible lon Chip kits

The following lon Chip kits can be ordered separately for additional chips.

Description Cat. No. Quantity Storage
lon 510™ Chip Kit (4-pack) A34292 4 chips
lon 520™ Chip Kit (4-pack) A27761 4 chips 15°C to 30°C
lon 530™ Chip Kit (4-pack) A27763 4 chips

lon ReproSeq™ PGS Kits — lon S5™/lon GeneStudio™ S5 Systems User Guide
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Recommended materials for quantification and quality control

Recommended materials for quantification and quality
control

Item Source

Qubit™ Flex Fluorometer or Q33327

Qubit™ 4 Fluorometer!'l and the following kit. Q33238
* Qubit™ dsDNA HS Assay Kit (DNA samples) Q32851, Q32854

One of the following, or equivalent: Various

¢ SimpliAmp™ Thermal Cycler

* Veriti™ 96-Well Thermal Cycler!?!

* VeritiPro™ Thermal Cycler, 96-well
* ProFlex™ 96-well PCR System

lon Library TagMan™ Quantitation Kit and real-time PCR instrument 4468802
MicroAmp™ Optical 96-Well Reaction Plate with Barcode N8010560, 4306737
MicroAmp™ Clear Adhesive Film 4306311
MicroAmp™ Optical Film Compression Pad 4312639
Eppendorf™ DNA LoBind™ Microcentrifuge Tubes, 1.5-mL 13-698-791
(fisherscientific.com)
Agencourt™ AMPure™ XP Reagent NC9933872
DynaMag™-2 Magnet 12321D
Nuclease-free Water AM9932
Ethanol, Absolute, Molecular Biology Grade 050BP2818500
(fisherscientific.com)
Pipettors, 2-200 pL, and low-retention filtered pipette tips (fisherscientific.com)
resDNASEQ™ Quantitative Human DNA Kit A26366

For use with the lon AmpliSeq™ Polyploidy Panel Kit with lon 520™ Chips or lon 530™ Chipsl®!

lonCode™ Barcode Adapters 1-384 Kit A29751

DynaMag™-96 Side Magnet, or other plate magnet 12331D

Recommended sample control

Control DNA (from CEPH Individual 1347-02) 403062

01 Qubit™ 2.0 Fluorometer and later are supported.
[l This product is supported but no longer available for purchase.
B For more information, see Chapter 3, “Prepare lon AmpliSeq™ Polyploidy Panel libraries”.
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Recommended materials

Recommended materials

Unless otherwise indicated, all materials are available through thermofisher.com. "MLS" indicates that
the material is available from fisherscientific.com or another major laboratory supplier.

Item Source

Recommended additional equipment

One of the following Applied Biosystems™ real-time PCR instruments: Various
® 7500 Real-Time PCR System
e 7900HT Fast Real-Time PCR System!(!]
* StepOne™ Real-Time PCR System
* StepOnePlus™ Real-Time PCR System
* ViiA™ 7 Real-Time PCR System
¢ QuantStudio™ 3 Real-Time PCR System
¢ QuantStudio™ 5 Real-Time PCR System
* QuantStudio™ 7 Flex Real-Time PCR System
* QuantStudio™ 12K Flex Real-Time PCR System

96-well plate centrifuge MLS
Qubit™ 4 Fluorometerf?] Q33238
Control DNA (CEPH 1347-02) 403062

[ Supported but no longer available for purchase.
I Qubit™ 2.0 Fluorometer or later are supported.
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" Workflow overview

Workflow overview

Sample preparation workflow

Extract and prepare lon SingleSeq™ library

~
(page 22)

Extract gDNA from 1-10 cells using the extraction reagents provided

with the kit, preamplify the gDNA, then amplify the gDNA with barcoded

primers to generate libraries.

Pool, purify and quantify libraries.

Pool, purify and quantify libraries (page 29) }%

Create a planned run in Torrent Suite™ Software
(page 48)

Planned Runs are digital instructions that are created in Torrent Suite™
Software for controlling the template preparation and sequencing

instruments. Create a planned run to template and sequence the pooled
libraries.

Template libraries (page 66)

A
Template pooled libraries using the lon Chef™ Instrument. @

Sequence pooled libraries (page 92) .1r‘
Sequence the pooled libraries using an lon GeneStudio™ S5 Series

Sequencer.

Analyze data (page 103) N m ’

Analyze data using lon Reporter™ Software.

20 lon ReproSeq™ PGS Kits — lon S5™/lon GeneStudio™ S5 Systems User Guide



Prepare and pool lon SingleSeq™
libraries

B Before you begin .. ... e 21
B Extract and amplify the gDNA .. ... e 22
B Pool, purify, and quantify the libraries . .. ... 29

Before you begin

General procedural guidelines

Use good laboratory practices to minimize cross-contamination of products. When designing the
laboratory layout, consider the need for space separation of pre and post-amplification activities.
Dedicate laboratory supplies and/or equipment to the appropriate space to reduce significantly the
potential for contamination.

MicroAmp™ Clear Adhesive Film is easier to apply and remove from amplification plates than
MicroAmp™ Optical Adhesive Film, and is recommended for sealing plates in gDNA extraction,
preamplification, and standard endpoint amplification reactions. Use MicroAmp™ Optical Adhesive
Film to seal plates for real-time PCR amplification reactions.

Pipet viscous solutions slowly and ensure complete mixing.
Ensure that all reagents are completely thawed at room temperature, that is, no ice crystals are
visible.

Vortex all reagents, except for enzymes, for 5 seconds (mix enzymes by flicking the tube with your
finger 4 times). Briefly centrifuge in a microcentrifuge for 3-5 seconds before use.

Guidelines for the number of libraries per run

The maximum number of lon SingleSeq™ libraries you can pool and sequence on one chip depends on
the type of chip you use. Follow these guidelines:

lon Chip Recommended maximum libraries per run
lon 510™ Chip 16
lon 520™ Chip 24
lon 530™ Chip 96
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Extract and amplify the gDNA

[0

Guidelines for sample handling

Keep the cells on ice.

For single cells or low-concentration control input gDNA, do not insert pipette tip into sample. The
single cell could adhere to the tip and get removed from the sample tube.

Add liquids above the top of liquid in a tube, do not submerge the tip.
Do not vortex the cells.

After adding extraction enzyme master mix to samples, do not mix. Vortexing or pipetting up and
down can cause loss of cells on the wall of the well or pipette tip.

Keep cell lysis and amplification reactions on ice or a cold block during reaction setup.
Keep lon SingleSeq™ libraries on ice during library pooling and quantification.

Extract and amplify the gDNA

Materials required

Provided in the lon SingleSeq™ Kit (Part No. A28955 or A34763):

Cell Extraction Buffer *  Amplification Buffer

Extraction Enzyme Dilution Buffer e Amplification Enzyme

Cell Extraction Enzyme * Nuclease-free Water

Preamplification Buffer * Barcode Plate containing lon SingleSeg™

Preamplification Enzyme Barcodes 1-24 or lon SingleSeq™ Barcodes
1-96

Other materials:

22

(If performing real-time PCR amplification) MicroAmp™ 96-well Optical Reaction Plate and
MicroAmp™ Optical Adhesive Film

0.2-mL MicroAmp™ 8-tube PCR tube strips, individual MicroAmp™ PCR tubes, caps, and
MicroAmp™ 96-Well Tray/Retainer Set

Pipettors, multichannel pipettors
Pipette tips
Real-time or standard PCR thermal cycler that is equipped with heated lid

SYBR™ Green | and ROX dyes (Cat. Nos. S-7567 and 12223-012), if monitoring amplification by
real-time PCR

If performing troubleshooting, one of the following for diluting gDNA:
- LowTE

- PBS (Ca?*-, Mg?*-, BSA-free)
— Nuclease-free Water
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Extract and amplify the gDNA

Extract genomic DNA

1.

Prepare, by FACS or micro-manipulation, 1-10 cells per sample in up to 2.5 yL 1X PBS or Low TE,
then pipet the cells into wells of a 96-well optical reaction plate.

Note:
. Instead of a 96-well reaction plate, a PCR tube strip, or individual PCR tubes can be used.
. You can also sort cells by FACS directly into Cell Extraction Buffer at a density of 1-10

cells/5 pL.
. If testing with the lon AmpliSeq™ Polyploidy Panel, use 3-10 cells per sample.

(Optional) Set up one or more gDNA control reactions. Make serial dilutions of stock gDNA in low
retention tubes immediately before use to avoid sample loss due to adsorption on to tube walls.

Note: We recommend using Control DNA (from CEPH Individual 1347-02) to prepare gDNA
control libraries. However, you can prepare control libraries from other accurately quantified, high
quality, high molecular weight gDNA sources.

a. Prepare a 1:100 dilution. Add 2 pL of stock solution (50 ng/uL) of Control DNA (from CEPH
Individual 1347-02) to 198 pL of Low TE. Vortex to mix, then centrifuge briefly.

b. Add 2 pL of 1:100 dilution to 131 pL of Low TE. Vortex to mix, then centrifuge briefly.
The final concentration of Control DNA (from CEPH Individual 1347-02) is 7.5 pg/pL.

C. Add 2 pL of diluted human gDNA (7.5 pg/uL) to an open plate well.

Note: If testing with the lon AmpliSeq™ Polyploidy Panel, use DNA at =37.5 pg/pL and
confirm the concentration using the resDNASEQ™ Quantitative Human DNA Kit (Cat. No.
A26366).

Add Cell Extraction Buffer (green cap) to each sample well to bring the total volume to 5 pL.

Note:

. If sorting cells by FACS directly into Cell Extraction Buffer (1-10 cells/5 pL), add 5 pL aliquots to
each sample well.

. If using gDNA for troubleshooting, add 3 pL of the Cell Extraction Buffer to the 2 pL of diluted
gDNA added in step 2.

(Optional) Prepare a Non-Template Control (NTC) by adding 2.5 pL 1X PBS to 2.5 pL Cell
Extraction Buffer.
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Chapter 2 Prepare and pool lon SingleSeg™ libraries
Extract and amplify the gDNA

Prepare an Extraction Enzyme master mix in a 1.5-mL tube on ice according to the following table.
Scale the volume according to the number of samples (N) and NTCs you have. Vortex briefly, then
centrifuge to collect liquid at the bottom of the tube.

Note: Do not let the pipette tip touch the bottom of the well.

Component Volume per reaction Volume for N reactions!']
Extraction Enzyme Dilution Buffer (violet cap) 4.8 uL Nx4.8pL x 1.1
Cell Extraction Enzyme (yellow cap) 0.2 L N x 0.2 uL x 1.1

' 10% overage added to compensate for pipetting loss. Round to nearest 0.1 pL.

Note: To dispense Extraction Enzyme master mix with an 8-channel multichannel pipettor, aliquot
the master mix to 8 wells of a 96-well plate to serve as a reservoir. For example, aliquot 65 puL/well
if you are processing 96 samples.

. Add 5 pL Extraction Enzyme master mix to each cell or gDNA sample (10-pL final volume).

IMPORTANT! Do not mix. Vortexing or pipetting up and down can cause loss of cells on the wall
of the well or pipette tip.

- Seal the plate with MicroAmp™ Clear Adhesive Film, then centrifuge at 1,000 x g for 30 seconds to

collect liquid at the bottom of the wells.

. Place a MicroAmp™ Compression Pad on the plate, load the plate in the thermal cycler, then run

the following program:

Temperature Time
75°C 10 minutes
95°C 4 minutes
22°C Hold

Remove the plate, centrifuge at 1,000 x g for 30 seconds to collect liquid at the bottom of the
wells, then place on ice or a cold block.

Pre-amplify the gDNA

24

Prepare a preamplification master mix in a 1.5-mL tube on ice according to the following table.
Scale the volume according to the number of samples (N) and NTCs you have. Vortex briefly and
centrifuge for 30 seconds to collect liquid at the bottom of tube.

Component Volume per reaction Volume for N reactions [1]
Preamplification Buffer (red cap) 4.8 uL Nx4.8pLx 1.1
Preamplification Enzyme (white cap) 0.2 yL N x 0.2 pL x 1.1

' 10% overage added to compensate for pipetting loss. Round to nearest 0.1 L.

lon ReproSeq™ PGS Kits — lon S5™/lon GeneStudio™ S5 Systems User Guide



Chapter 2 Prepare and pool lon SingleSeq™ libraries [ 18
Extract and amplify the gDNA

Note: To dispense the preamplification master mix with an 8-channel multichannel pipettor, aliquot
the master mix to 8 wells of a 96-well plate to serve as a reservoir. For example, aliquot 65 uL/well
if you are processing 96 samples.

2. Carefully remove the film seal from the plate, then add 5-pL preamplification master mix to each
sample well (15-pL final volume).

IMPORTANT! Do not mix. Vortexing or pipetting up and down can cause loss of DNA on the wall
of the tube or pipette tip.

3. Apply a new adhesive film, then centrifuge at 1,000 x g for 30 seconds to collect liquid at the
bottom of the wells.

4. Place a MicroAmp™ Optical Film Compression Pad on the plate, load the plate in the thermal
cycler, then run the following program.

Stage Step Temperature Timel'l
Hold Activate the enzyme 95°C 2 minutes
Denature 95°C 15 seconds
Anneal 15°C 50 seconds
25°C 40 seconds
Cycle (12 cycles)
35°C 30 seconds
Extend 65°C 40 seconds
75°C 40 seconds
Hold — 4°C Hold

' Cycling time is approximately 1 hour.

IMPORTANT! The thermal cycler must be equipped with a heated lid.

5. Remove the plate, centrifuge at 1,000 x g for 30 seconds to collect liquid at the bottom of the
wells, then place on ice or a cold block.

If you are not using the lon AmpliSeq™ Polyploidy Panel, proceed to “Amplify the libraries” on
page 26.

6. If you intend to use the lon AmpliSeq™ Polyploidy Panel on preamplification material instead of final
lon SingleSeq™ libraries (recommended), transfer 6 L of each sample reaction to a separate well in
a new 96-well PCR plate.

* To prepare lon ReproSeq™ libraries, proceed to “Amplify the libraries” on page 26.

* To prepare polyploidy libraries, proceed to Chapter 3, “Prepare lon AmpliSeq™ Polyploidy
Panel libraries”.
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Extract and amplify the gDNA

Amplify the libraries

You can perform the amplification reaction on a real-time PCR instrument to monitor amplification
during the run. Monitoring can give an early indication of amplification failure in a particular sample, or
that a library is over- or under-represented before pooling.

1. If you are performing real-time PCR, prepare SYBR™ Green I/ROX dye mix. If you are performing
standard endpoint PCR, proceed to step 2, then use Nuclease-free Water instead of the dye mix,
as indicated in step 3.
a. Dilute the stock SYBR™ Green | reagent 1:1000 with Low TE buffer to make a 10X working
solution.

b. Combine 10X SYBR™ Green | working solution and 25 uM ROX Reference Dye for the number
of reactions (N) according to the following table:

Component Volume per reaction | Volume for N reactions!']
10X SYBR™ Green | working solution 0.5 L Nx0.5pL x 1.1
25 uM ROX Reference Dye (or 2.5 pM, see 1.0 yL Nx1.0pL x 1.1
below)
Nuclease-free Water (clear cap) 1.0 L Nx1.0puL x 1.1

[ 10% overage added to compensate for pipetting loss. Round to nearest 0.1 pL.

IMPORTANT! Use ROX Reference Dye at 25 puM for the following real-time PCR instruments:
7300 Real-Time PCR System, 7900HT Real-Time PCR Instrument, StepOne™, StepOnePlus™,
ABI PRISM™ 7000, and ABI PRISM™ 7700 instruments.

Dilute ROX Reference Dye to 2.5 yM with Nuclease-free Water and use 1.0 pL per reaction
for the following instruments: 7500 Real-Time PCR Instrument and ViiA™ 7 instruments, and
Agilent™ Mx3000P™, Mx3005P™, and Mx4000™ instruments.

2. Prepare the lon SingleSeq™ Barcodes 1-24 plate:
a. Thaw the plate for 10 minutes at room temperature.

b. Centrifuge the plate briefly to collect contents at the bottom of the wells.

c. Wipe the foil seal with 70% ethanol, then allow it to dry.
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Extract and amplify the gDNA

3. Prepare an amplification master mix in a 5-mL tube on ice according to the following table. Scale
the volume according to the number (N) of samples and NTCs you have. Vortex briefly, then
centrifuge to collect liquid at the bottom of tube.

Volume per reaction
onReproSen | ey | Nresctons®
libraries only libraries!2!

Amplification Buffer (orange cap) 27 uL 27 uL N x 27 pL x 1.1
Amplification Enzyme (blue cap) 0.5 L 0.5 uL Nx0.5puL x 1.1
SYBR™ Green I/ROX dye mix[3] 2.5uL 2.5uL N x25pLx 1.1
Nuclease-free water 0L 6 pL N x6pL x 1.1
Total volume per reaction 30 uL 36 pL

' 10% overage added to compensate for pipetting loss. Round to nearest 0.1 pL.

1 An aliquot to prepare polyploidy libraries was removed after preamplification. (See step 6 of “Pre-amplify the gDNA” on
page 24).

Bl Replace with Nuclease-free Water if performing endpoint PCR.

Note: To dispense the amplification master mix with an 8-channel multichannel pipettor, aliquot
the master mix to eight wells of a 96-well plate to serve as a reservoir. For example, aliquot
396 pL/well if you are processing 96 samples.

4. Remove the film seal from the sample plate, then add amplification master mix to each well (45-uL
final volume).

* For samples being used to prepare lon ReproSeq™ libraries only, add 30 pL of amplification
master mix.

* For samples being used to prepare both lon ReproSeq™ libraries and polyploidy libraries, add
36 pL of amplification master mix.

5. Pierce the foil above the desired well of the Barcode Plate (see plate map) with a pipette tip. With a
new tip, withdraw 5 pL of the lon SingleSeq™ Barcode Adapter, then add to the appropriate sample
(50-pL final volume). Repeat for each sample. Each Barcode Adapter is single-use only.

Note:

. To avoid sample misidentification later, be careful to track the correspondence of each sample
and its Barcode Adapter.

. See “About the lon SingleSeq™ Barcode Adapters” on page 14 for barcode plate handling
guidelines.

. In the following plate map, lon SingleSeq™ Barcode Plates containing Barcodes 1-24 and 1-96.
Barcode Adapters are loaded in the indicated wells.
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Extract and amplify the gDNA
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6. Adjust a pipettor to 30 pL, then mix the samples by pipetting up and down, using a new tip for
each sample. Do not introduce bubbles into the samples.

Note: If you used a non-optical reaction plate or PCR tube strip for cell lysis and preamplification,
you can transfer samples to an optical plate at this point to perform real-time PCR amplification.

7. Apply a new film seal to the plate and briefly centrifuge to collect liquid at the bottom of the wells.

8. Place a MicroAmp™ Optical Film Compression Pad on the plate, load into the thermal cycler, then
run the following program.

Step Stage Temperature Timel'l
Hold Activate the enzyme 95°C 3 minutes
Denature 95°C 20 seconds
Cycle (4 cycles) Anneal 50°C 25 seconds
Extend 72°C 40 seconds
Denature 95°C 20 seconds
Cycle (12 cycles)?
Anneal and Extend 72°C 55 seconds
Hold - 4°C Hold

' Cycling time is approximately 30 minutes.
2l Acquire fluorescence data at this step if monitoring amplification in real-time.

9. Remove the plate, centrifuge at 1,000 x g for 30 seconds to collect liquid at the bottom of the
wells, then place on ice or in a cold block.

10. (Optional) We recommend that new users run 10 pL of each ampilified library on an E-Gel™ 2%
Agarose Gel, or equivalent agarose gel, to check the quality of the amplified libraries.

Note: Unpurified library fragments typically migrate nearer to 350 bp instead of the expected
250 bp.

Proceed to “Pool, purify, and quantify the libraries”.

STOPPING POINT Sample libraries can be stored at —-30°C to —10°C before proceeding to the next step.

28 lon ReproSeq™ PGS Kits — lon S5™/lon GeneStudio™ S5 Systems User Guide



Chapter 2 Prepare and pool lon SingleSeq™ libraries #7518

[
Pool, purify, and quantify the libraries

Pool, purify, and quantify the libraries

Note: We recommend that you perform library pooling, purification, and quantification in one session.
Do not store library pools before quantification.

Materials required

70% Ethanol - freshly prepared

AMPure™ XP Reagent - warmed to room temperature

DynaMag™-2 Magnet or DynaMag™-96 Side

Low TE (10 mM Tris-HCI, 0.1 mM EDTA, pH 8.0)

Qubit™ 4 Fluorometer (Qubit™ 2.0 Fluorometer and later are supported)
Qubit™ dsDNA HS (High Sensitivity) Assay Kit

Qubit™ Assay Tubes

Warm AMPure™ XP Reagent

Warm AMPure™ XP Reagent at room temperature for 30 minutes.

Pool the libraries

1.

Pool the libraries according to the PCR method you used to amplify the libraries. Before pooling,
vortex the amplification reactions to mix, then centrifuge briefly to collect contents at the bottom of
the wells or tubes.

If you used Action

Standard endpoint | Add 5 pL of each library to a new 1.5-mL tube to create an equi-volume pool.
PCR ampilification | Vortex the tube to mix and pulse-centrifuge to collect contents at the bottom of

the tube.
Real-time PCR Calculate the median C; value of the libraries you want to pool and adjust the
amplification volumes of libraries deviating from the median C; following these guidelines:

¢ Libraries that fall within 1 C; of the median should be added at the normal
volume (5 pL).

® Libraries that fall >3 C;s later than the median should not be included in the
pool. It is likely that the input material was not present in the tube or well or
was absorbed to the tube side.

® Libraries that fall =1 but <3 C;s later than the median should be added at 2X
the normal volume (10 pL).

* Do not adjust more than 25% of the libraries in a pool (excluding libraries >
3 C;s later than median). If more than 25% of libraries fall 1 or more C;s away
from the median, adjust libraries with the most extreme C; deviations until the
25% threshold is reached.
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Pool, purify, and quantify the libraries

Note: You can use the following technique to rapidly pool 5-pL aliquots of a large number of
libraries. First use an 8-channel pipettor to transfer aliquots from up to 96 libraries into 8 wells of
a new plate, then use a standard pipettor to combine the contents of the 8 wells into a 1.5-mL
Eppendorf™ LoBind™ tube. Use a new tip for every well when you transfer the 5-pL aliquots.

2. Transfer 40 pL of the library pool to a 0.2-pL tube for purification and quantification.

Note:

. When pooling fewer than 8 libraries, the pool volume is less than 40 pL. Add Nuclease-free
Water to bring the final volume to 40 pL before library pool purification.

. When pooling more than 8 libraries, remove 40 pL from the pool for purification and
quantification. If the remaining volume is =40 pL, store at —-30°C to —10°C to use if a repeat
purification is needed.

Purify the library pool
1. Transfer 40 pL of the library pool to a fresh PCR tube.

2. Heat the 40-pL aliquot of library pool in a thermal cycler using the following program.

Step Temperature Time Number of cycles
1 70°C 2 minutes 1
2 22°C Hold 1

3. Briefly pulse-centrifuge the tube to collect the contents, then transfer to a new 1.5-mL Eppendorf™
LoBind™ tube.

4. Add 40 pL (1X volume) of room temperature AMPure™ XP beads to the library pool.
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Vortex briefly, pulse-centrifuge to collect contents, then incubate for 5 minutes at room
temperature.

Place the tube in the DynaMag™-2 Magnet, then wait 5 minutes for beads to aggregate to the side
of the tube or well of the plate.

Aspirate the supernatant carefully, then discard.

Wash beads with 250 pL of freshly prepared 70% ethanol while the tube or plate is still on the
magnet.

Incubate for 30 seconds.

Aspirate the wash solution carefully, then discard.

Repeat step 8 through step 10, thoroughly removing all ethanol after the second wash.
Allow the beads to dry at room temperature for 3—4 minutes with the tube on the magnet.

Remove the tube from the magnet, add 40 pL of Low TE, then resuspend the beads by pipetting
up and down.

Incubate the tube at room temperature for 1 minute.

Place the tube in the DynaMag™-2 Magnet, then wait 2-3 minutes for the beads to aggregate to
the side of the tube.

Transfer 35 pL of the supernatant containing the purified library pool to a new 1.5-mL Eppendorf™
LoBind™ tube and place on ice. Avoid carryover of beads.

Quantify the library pool

Quantify the lon SingleSeq™ library pool with the Qubit™ dsDNA HS (High Sensitivity) Assay Kit.
For details instructions, see the Qubit™ dsDNA HS Assay Kits User Guide (Pub. No. MAN0002326).

1.

2.

Prepare a Qubit™ working solution by diluting the Qubit™ dsDNA HS Reagent (Component A) 1:200
in Qubit™ dsDNA HS Buffer (Component B) in a plastic tube.

Prepare sufficient working solution to quantify one or more purified pools plus two standards
(volume required = (number of pools + 2) x 200 yL x 1.1).

IMPORTANT! Do not prepare the working solution in a glass container.

Prepare the standards.
a. Add 190 pL Qubit™ working solution to two labeled Qubit™ Assay Tubes used for standards.

b. Add 10 pL of Qubit™ standard (Components C) to the one tube and 10 pL of Qubit™ standard
(Components D) to the other tube.

¢. Mix by vortexing 2-3 seconds. Do not create bubbles.
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Chapter 2 Prepare and pool lon SingleSeg™ libraries
Pool, purify, and quantify the libraries

3. Prepare the sample or library.
a. Aliquot 198 pL Qubit™ working solution to labeled Qubit™ Assay Tubes used for samples.

b. Add 2 L of the library pool to the appropriate sample tube.
c. Mix by vortexing 2-3 seconds. Do not create bubbles.
4. Incubate the tubes in the dark at room temperature for 2 minutes.
5. Measure standards first to generate a standard curve, then measure the library pool.

6. Convert ng/pL to nM by multiplying the ng/uL values obtained in step 5 by 6.06 nmol/mg.
Example: Library pool concentration is 10 ng/pL
10 ng/pL (or 10 mg/L) x 6.06 nmol/mg = 60.6 nmol/L = 60.6 nM

Note: For DNA segments of 250-bp average length:
MW = (250 bp x 660,000 mg/mol/bp) = 1.65 x 108 mg/mol
Inverting 1.65 x 108 mg/mol and multiplying by 1 x 10° nmol/mol gives 6.06 nmol/mg.

7. Dilute the library pool to 1 nM.

Note: In the preceding example, add 298 pL of Low TE to 5 pL of 60.6-nM pooled library stock.
See “Library yield is low” on page 134 if library yield and concentration is lower than expected.

STOPPING POINT Diluted library pools and non-diluted library pool stock solutions can be stored
for 1 week at 4°C. For longer term, store at -20°C.
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Workflow

Workflow

Polyploidy library procedure

Prepare and amplify targets (page 35)

Amplify target regions from DNA to generate libraries.

Partially digest amplicons (page 36)
Partially digest libraries to enable adapter ligation. ’

Ligate adapters and purify (page 36)
Ligate barcode adapters to libraries and purify. /

Quantify the libraries (page 38 or page 41)

* Preamplification aliquot input—page 41
* |on SingleSeqg™ libraries — “Purify the unamplified library” on page 37 and
“Quantify the unamplified library by gPCR” on page 38

Materials required

* |on AmpliSeg™ Polyploidy Panel Kit with lon 530™ Chips (480 Samples)
* JonCode™ Barcode Adapters 385-768 Kit

¢ Qubit™ Fluorometer and Qubit™ dsDNA HS Assay Kit or
lon Library TagMan™ Quantitation Kit and real-time PCR instrument

* Other materials —See “Required materials not supplied” on page 16 and “Recommended
materials” on page 19.

Input samples

The following input samples are compatible with lon AmpliSeq™ Polyploidy Panel Kits.

* Aliquots removed after preamplification step (“Pre-amplify the gDNA” on page 24)—
Recommended.
* Individual lon SingleSeq™ libraries (“Pool the libraries” on page 29)
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Prepare DNA target amplification reactions

IMPORTANT! Primer pools and 5X lon AmpliSeg™ HiFi Mix are viscous. Pipet slowly and mix
thoroughly. We recommend PCR setup on ice or a cold block.

1. For lon SingleSeqg™ library input samples, dilute each lon SingleSeg™ aliquot 1:25 in water or Low
TE.

If you are using preamplification reaction input samples, proceed to step 2 without dilution.

2. Transfer 2 pL of each input sample to a 96-well plate.

3. Add the following components to each sample well. Prepare a master mix for multiple reactions.

Component Volume per reaction Volume for N reactions!']
5X lon AmpliSeq™ HiFi Mix(red cap) 4 uL Nx4pLx1.1
5X lon AmpliSeq™ Polyploidy Panel 4 uL Nx4pLx1.1
Nuclease-free Water 10 yL Nx10pL x 1.1
Total 18 uL

' 10% overage added to compensate for pipetting loss. Round to nearest 0.1 pL.

4. Seal the plate with a MicroAmp™ Clear Adhesive Film.

Note: To prevent evaporation during target amplification, use an applicator tool to press the film
securely around each reaction well and around the perimeter of the plate.

5. Place a MicroAmp™ Optical Film Compression Pad on the plate, then load the plate into the

thermal cycler.

Proceed to “Amplify the targets” on page 35.

Amplify the targets

To amplify target regions, run the following program.

Stage Step Temperature Time
Hold Activate the enzyme 99°C 2 minutes
20 cycles Denature 99°C 15 seconds
Anneal and extend 60°C 4 minutes
Hold — 10°C Hold
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Partially digest amplicons

IMPORTANT! FuPa Reagent is viscous. Pipet slowly and mix thoroughly. Perform this step on ice or a

cold block, then quickly proceed to incubation.

1. Tap the plate gently on a hard flat surface, or centrifuge briefly to collect the contents at the bottom

of the wells, then remove the plate seal.

2. Add 2 pL of FuPa Reagent (brown cap) to each amplified sample. The total volume is ~22 pL.

3. Seal the plate with a clear adhesive film, vortex thoroughly, then centrifuge to collect droplets.
Alternatively, mix by pipetting at least half the total volume up and down at least 5 times before

sealing the plate.

4. Place a compression pad on the plate, load in the thermal cycler, then run the following program:

Temperature Time
50°C 10 minutes
55°C 10 minutes
60°C 20 minutes
10°C Hold (for up to 1 hour)

5. Tap the plate gently on a hard flat surface, or centrifuge briefly to collect the contents at the bottom

of the wells.

STOPPING POINT Store plate at —20°C for longer periods.

Perform the ligation reaction

1. If there is visible precipitate in the Switch Solution or the tube cap after thawing, vortex or pipet up
and down at room temperature to resuspend before pipetting.

2. Briefly centrifuge the plate to collect the contents.

36
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Purify the unamplified library

3. Carefully remove the plate seal, then add the following components in the order that is listed to
each well containing digested amplicons. If preparing multiple non-barcoded libraries, a master
mix of Switch Solution and adapters can be combined before addition.

IMPORTANT!

. Add the DNA Ligase last. Do not combine DNA Ligase and adapters before adding to digested
amplicons.

. You must use the lonCode™ Barcode Adapters. Do not use the lon SingleSeq™ Barcode Plate
Set GX.

. Use only one barcode (lonCode™ Barcode Adapter) for each sample.

Order of addition Component Volume
1 Switch Solution (yellow cap) 4 UL
2 lonCode™ Barcode Adapter 2L
3 DNA Ligase (blue cap) 2 uL
- Total volume (including ~22 pL of digested amplicon) ~30 uL

4. Seal the plate with a new MicroAmp™ Clear Adhesive Film, vortex thoroughly, then briefly

centrifuge to collect droplets. Alternatively, mix by pipetting at least half the total volume up and
down at least 5 times before sealing the plate.

5. Place a MicroAmp™ Compression Pad on the plate, load in the thermal cycler, then run the
following program:

Temperature Time
22°C 30 minutes
68°C 5 minutes
72°C 5 minutes
10°C Hold (for up to 24 hours)

STOPPING POINT Samples can be stored for up to 24 hours at 10°C on the thermal cycler. For
longer periods, store at —20°C.

Purify the unampilified library

IMPORTANT! Bring Agencourt™ AMPure™ XP Reagent to room temperature and vortex thoroughly to
disperse the beads before use. Pipet the solution slowly.

Do NOT substitute a Dynabeads™-based purification reagent for the Agencourt™ AMPure™ XP Reagent.

1. Prepare 70% ethanol (350 pL x number of samples) fresh daily.

2. Briefly centrifuge the plate to collect the contents in the bottom of the wells.
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Quantify the unamplified library by gPCR

. Carefully remove the plate seal, then add 45 pL (1.5X sample volume) of Agencourt™ AMPure™ XP

Reagent to each library. Pipet up and down 5 times to mix the bead suspension with the DNA
thoroughly.

Note: Visually inspect each well to ensure that the mixture is homogeneous.

. Incubate the mixture for 5 minutes at room temperature.

. Place the plate in a magnetic rack such as the DynaMag™-96 Side Magnet, then incubate for

2 minutes or until the solution clears. Carefully remove, then discard the supernatant without
disturbing the pellet.

. Add 150 pL of freshly prepared 70% ethanol, then move the plate side-to-side in the two

positions of the magnet to wash the beads. Carefully remove, then discard the supernatant without
disturbing the pellet.

Note: If your magnet does not have two positions for shifting the beads, remove the plate from
the magnet and gently pipet up and down 5 times (with the pipettor set at 100 pL), then return the
plate to the magnet and incubate for 2 minutes or until the solution clears.

. Repeat step 6 for a second wash.

. Ensure that all ethanol droplets are removed from the wells. Keeping the plate in the magnet,

air-dry the beads at room temperature for 5 minutes. Do not over dry.

IMPORTANT! Residual ethanol drops inhibit library amplification. If needed, centrifuge the plate
and remove remaining ethanol before air-drying the beads. Under conditions of low relative
humidity, the beads air-dry rapidly. Do not over dry.

Proceed immediately to quantification.

To quantify using gPCR, proceed to “Quantify the unamplified library by gPCR” on page 38.

To quantify using the Qubit™ Fluorometer, proceed to “Quantify the amplified library using the
Qubit™ Fluorometer” on page 41.

Quantify the unampilified library by qPCR

38

Elute the unamplified lon AmpliSeg™ Polyploidy Panel library, then determine the concentration by
gPCR with the lon Library TagMan™ Quantitation Kit (Cat. No. 4468802). Unamplified libraries typically
have yields of 250 pM-1 nM. After quantification, determine the dilution factor that results in a
concentration of 250 pM.
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Elute and dilute the library

1.

Remove the plate with purified libraries from the plate magnet, then add 50 pL of Low TE to the
pellet to disperse the beads.

Seal the plate with MicroAmp™ Clear Adhesive Film, vortex thoroughly, then briefly centrifuge to
collect droplets. Alternatively, mix by pipetting at least half the total volume up and down at least
5 times before sealing the plate.

Incubate at room temperature for at least 2 minutes.

Place the plate on the magnet for at least 2 minutes.

STOPPING POINT Libraries can be stored at 4-8°C for up to 1 month. For longer term, store
at —20°C. We recommend transferring the supernatant to a new plate, then seal the plate with
MicroAmp™ Clear Adhesive Film for long-term storage.

Prepare a 100-fold dilution for quantification. Remove 2 pL of supernatant, containing the library,
then combine with 198 pL of Nuclease-free Water.

Proceed immediately to “Quantify library by gPCR and calculate the dilution factor” on page 39.

Quantify library by qPCR and calculate the dilution factor

Determine the concentration of each lon AmpliSeq™ Polyploidy Panel library by gPCR with the lon
Library TagMan™ Quantitation Kit using the following steps. Analyze each sample, standard, and
negative control in duplicate 20-pL reactions.

1.

Prepare three 10-fold serial dilutions of the E. coli DH10B Control Library (~68 pM; from the
lon Library TagMan™ Quantitation Kit) at 6.8 pM, 0.68 pM, and 0.068 pM. Mark these tubes as
standards, then use these concentrations in the gPCR instrument software.

Prepare reaction mixtures.

* 96-well plate: For each sample, control, and standard, combine 20 pL of 2X lon Library gPCR
Master Mix and 2 pL of lon Library TagMan™ Quantitation Assay, 20X, then mix thoroughly.
Dispense 11-pL aliquots into the wells of a 96-well PCR plate.

* 384-well plate: For each sample, control, and standard, combine 10 L of 2X lon Library gPCR
Master Mix and 1 pL of lon Library TagMan™ Quantitation Assay, 20X, then mix thoroughly.
Dispense 5.5-pL aliquots into the wells of a 384-well PCR plate.

3. Add diluted library or control to each well.

e 96-well plate: Add 9 L of the diluted (1:100) lon AmpliSeq™ Polyploidy Panel library or 9 pL of
each control dilution to each well (two wells per sample as noted before), for a total reaction
volume of 20 pL.

* 384-well plate: Add 4.5 pL of the diluted (1:100) lon AmpliSeg™ Polyploidy Panel library or
4.5 uL of each control dilution to each well (two wells per sample as noted before), for a total
reaction volume of 10 pL.
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Chapter 3 Prepare lon AmpliSegq™ Polyploidy Panel libraries

4. Seal the plate with a MicroAmp™ Optical Adhesive Film, vortex thoroughly, then briefly centrifuge
to collect droplets.

5. Program your real-time instrument as follows:

a. Enter the concentrations of the control library standards.

b. Select ROX™ Reference Dye as the passive reference dye.

c. Select a reaction volume of 20 pL.

d. Select FAM™ dye/MGB as the TagMan™ probe reporter/quencher.

e. The lon Library gPCR Master Mix can be used on various instruments, as listed in the
following table. The fast cycling program was developed using the StepOnePlus™ System
in Fast mode.

IMPORTANT! When quantifying libraries made from panels with 275-bp or 375-bp designs, use
standard gPCR cycling. Fast cycling can result in inaccurate quantification.

Real-time PCR System | Reaction plate | Run mode Stage Temperature Time
7500 Fast 96-well Fast Hold (UDG incubation) 50°C 2 minutes
7900 HT -
Hold (polymerase activation) 95°C 20 seconds
7900 HT Fast 96-well Fast
ViiA™ 7 384-well Standard Fast
a s 95°C 1 second
uantStudio™ 3, 5, or 7
Cycle (40 cycles)
StepOne™
48-/96-well Fast 60°C 20 seconds
StepOnePlus™
7300 Hold (UDG incubation) 50°C 2 minutes
7500 Hold (polymerase activation) 95°C 2 minutes
7900 HT
96-well Standard | Standard 95°C 15 seconds
7900 HT Fast
Cycle (40 cycles
ViiA™ 7 yele (40 cycles)
60°C 1 minute
QuantStudio™ 3, 5, or 7

6. Following gPCR, calculate the average concentration of the undiluted lon AmpliSeg™ Polyploidy
Panel library by multiplying the concentration that is determined with gPCR by 100.

7. Based on the calculated library concentration, determine the dilution that results in a concentration
of 150-250 pM.

For example:

® The undiluted library concentration is 500 pM.

* The dilution factor is 500 pM/250 pM = 2.
® Therefore, 10 pL of library mixed with 10 pyL of Low TE (1:2 dilution) yields 250 pM.

40
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8. Dilute library to 250 pM, combine, then load onto the lon S5™/lon S5™ XL Sequencer or lon
GeneStudio™ S5 Series Sequencer.

STOPPING POINT Libraries can be stored at 4-8°C for up to 1 month. For longer term, store at
-20°C.

If the libraries will be run with the lon SingleSeq™ libraries, proceed to Chapter 4, “Combine lon
SingleSeq™ and lon AmpliSeq™ Polyploidy Panel Libraries”.

If running lon AmpliSeq™ Polyploidy Panel libraries alone, proceed to Chapter 5, “Create a Planned
Run”.

Quantify the amplified library using the Qubit™ Fluorometer

Polyploidy libraries must be amplified before quantification with a Qubit™ Fluorometer to enrich
amplifiable material and obtain sufficient material for accurate quantification. Amplify the library using
Platinum™ PCR SuperMix High Fidelity, then purify. Quantify the library using a Qubit™ Fluorometer.
After quantification, determine the dilution factor that results in a concentration of 150-250 pM.

Amplify the library

1. Remove the plate with purified libraries from the plate magnet, then add 50 pL of Platinum™ PCR
SuperMix High Fidelity and 2 pL of Library Amplification Primer Mix to each bead pellet.

* The Platinum™ PCR SuperMix High Fidelity is used to elute the libraries from the beads.

* The Platinum™ PCR SuperMix High Fidelity and Library Amplification Primer Mix can be
combined before addition.

2. Seal the plate with MicroAmp™ Clear Adhesive Film, vortex thoroughly, then briefly centrifuge to
collect the contents.

Alternatively, mix by pipetting at least half the total volume up and down at least 5 times before
sealing the plate.

3. Place the plate back on the magnet for at least 2 minutes, then carefully transfer ~50 L of
supernatant from each well to a new well or a new plate without disturbing the pellet.

4. Seal the plate with MicroAmp™ Clear Adhesive Film, place a MicroAmp™ Optical Film Compression
Pad on the plate, load in the thermal cycler, then run the following program.

Stage Temperature Time
Hold 98°C 2 minutes
5 cycles 98°C 15 seconds

64°C 1 minute
Hold 10°C Hold

STOPPING POINT Samples can be stored at —20°C.
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Purify the amplified library

Perform a two-round purification process with the Agencourt™ AMPure™ XP Reagent.

* First round at 0.5X bead-to-sample-volume ratio—High molecular-weight DNA is bound to beads,
while amplicons and primers remain in solution. Save the supernatant.

® Second round at 1.2X bead-to-original-sample-volume ratio—Amplicons are bound to beads, and
primers remain in solution. Save the bead pellet and elute the amplicons from the beads.

IMPORTANT!

. Bring Agencourt™ AMPure™ XP Reagent to room temperature and vortex thoroughly to disperse the
beads before use. Pipet the solution slowly.

. Use freshly prepared 70% ethanol for the next steps. Combine 230 pL of ethanol with 100 pL of
nuclease-free water per sample.

. Do NOT substitute a Dynabeads™-based purification reagent for the Agencourt™ AMPure™ XP
Reagent.

First-round purification

1. Tap the plate gently on a hard flat surface, or briefly centrifuge to collect the contents, then remove
the plate seal.

2. Add 25 pL (0.5X sample volume) of Agencourt™ AMPure™ XP Reagent to each plate well containing
~50 pL of sample. Mix the bead suspension with the DNA thoroughly by pipetting up and down
5 times.

3. Incubate the mixture for 5 minutes at room temperature.

4. Place the plate in a magnet such as the DynaMag™-96 Side Magnet for at least 5 minutes, or until
the solution is clear.

5. Carefully transfer the supernatant from each well to a new well of the 96-well PCR plate without
disturbing the pellet.

IMPORTANT! The supernatant contains the desired amplicons. Do not discard!

Second-round purification

1. To the supernatant (from “First-round purification” on page 42), add 60 pL (1.2X original sample
volume) of Agencourt™ AMPure™ XP Reagent. Pipet up and down 5 times to mix the bead
suspension with the DNA thoroughly.

2. Incubate the mixture for 5 minutes at room temperature.

3. Place the plate in the magnet for 3 minutes or until the solution is clear. Carefully remove, then
discard the supernatant without disturbing the pellet.

IMPORTANT! The amplicons are bound to the beads. Save the bead pellet.
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4. Add 150 pL of freshly prepared 70% ethanol to each well, then move the plate side to side in the
magnet to wash the beads. Remove, then discard the supernatant without disturbing the pellet.

Note: If your magnet does not have two positions for shifting the beads, remove the plate from the
magnet and gently pipet up and down five times (with the pipettor set at 100 pL), then return the
plate to the magnet and incubate for 2 minutes or until the solution clears.

5. Repeat step 4 for a second wash.

6. Ensure that all ethanol droplets are removed from the wells. Keeping the plate in the magnet,
air-dry the beads at room temperature for 2-5 minutes. Do not over dry.

7. Remove the plate from the magnet, then add 50 pL of Low TE to the pellet to disperse the beads.

8. Seal the plate with MicroAmp™ Clear Adhesive Film, vortex thoroughly, then centrifuge to collect
droplets. Alternatively, mix by setting a pipettor to 40 pL, then pipet the mixture up and down at
least 5 times before sealing the plate.

9. Incubate at room temperature for at least 2 minutes.

10. Place the plate in the magnet for at least 2 minutes.

IMPORTANT! The supernatant contains the desired amplicons. Do not discard!

Proceed immediately to “Elute and dilute the library” on page 43.

Elute and dilute the library

1. Remove the plate with purified libraries from the plate magnet, then add 50 pL of Low TE to the
pellet to disperse the beads.

2. Seal the plate with MicroAmp™ Clear Adhesive Film, vortex thoroughly, then briefly centrifuge to
collect droplets. Alternatively, mix by pipetting at least half the total volume up and down at least
5 times before sealing the plate.

3. Incubate at room temperature for at least 2 minutes.

4. Place the plate on the magnet for at least 2 minutes.

STOPPING POINT Libraries can be stored at 4-8°C for up to 1 month. For longer term, store
at —20°C. We recommend transferring the supernatant to a new plate, then seal the plate with
MicroAmp™ Clear Adhesive Film for long-term storage.

5. Prepare a 100-fold dilution for quantification. Remove 2 L of supernatant, containing the library,
then combine with 198 pL of Nuclease-free Water.

Proceed immediately to “Qubit™ Fluorometer —Quantify the library and calculate the dilution factor” on
page 44.
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Qubit™ Fluorometer— Quantify the library and calculate the dilution factor

Analyze 10 pL of each amplified library using a Qubit™ Fluorometer and the Qubit™ dsDNA HS Assay
Kit. Amplified libraries typically have concentrations of 300-1,500 ng/mL. Libraries below 300 ng/mL
can still provide good quality sequences. We recommend the Qubit™ Flex Fluorometer when quantifying
many samples. For more information, see the Qubit™ dsDNA HS Assay Kits User Guide (Pub. No.
MANO0002326) or the Qubit™ Flex Fluorometer User Guide (Pub. No. MAN0009427).

1. Determine the concentration of each individual amplified library.

a.

Make a 1:200 working dilution of Qubit™ dsDNA HS reagent using the Qubit™ dsDNA HS
Buffer.

Combine 10 pL of the amplified lon AmpliSeqg™ library with 190 pL of dye reagent, mix well,
then incubate for at least 2 minutes.

Prepare each Qubit™ standard as directed in the user guide.

Measure the concentration on the Qubit™ Fluorometer.

. (Qubit™ 2.0 Fluorometer only) Calculate the concentration of the undiluted library by

multiplying by 20. Alternatively, use the "Calculate Stock Conc." feature on the instrument.

2. Based on the calculated library concentration (ng/mL), determine the dilution that results in a
concentration of 250 pM.

a.

Convert the concentration in ng/mL to pM.

CpM = ((Cng/mL/ D) / M) X 106

Where:

Cpwm is the concentration in picomolar (pM)

Chg/mL is the concentration in nanograms per milliliter (ng/mL)

D is the length of the DNA sample in base pairs

M is the molar mass of one base pair of DNA (660 grams/mol)
Given an average amplicon size of 175 bp, then 1 ng/mL = 8.66 pM
So, 250 pM/8.66 pM = 28.87 ng/mL

Calculate the dilution factor (Y) for a given library concentration (X).
X ng/mL/28.87 ng/mL =Y
For example:
* The library concentration is 2,000 ng/mL.
® The dilution factor is 2,000 ng/mL divided by 28.87 ng/mL = 69.3 (~70)
® Therefore, adding 5 pL of library to 345 pL of Low TE (1:70 dilution) yields ~250 pM.

3. Dilute libraries to 250 pM, then combine.

STOPPING POINT Libraries can be stored at 4-8°C for up to 1 month. For longer term, store at
—20°C.

Proceed to Chapter 4, “Combine lon SingleSeg™ and lon AmpliSeg™ Polyploidy Panel Libraries”.
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Overview of combining libraries

DNA libraries prepared with compatible lon SingleSeq™ and lonCode™ Barcode Adapters are pooled

at an appropriate ratio. The pooled libraries are templated and sequenced on an lon 530™ Chip using
the lon Chef™ Instrument with the lon S5™ ExXT Chef PGS chemistry. Run plan parameters that are
compatible with both library types are used. The run is automatically analyzed to produce PGS results
from the lon SingleSeq™ libraries. The run is then reanalyzed to produce results from the lon AmpliSeq™
Polyploidy Panel libraries.

We recommend using only the lon S5™ ExT Chef Reagents and lon S5™ EXT Sequencing Reagents
when combining lon SingleSeg™and lon AmpliSeg™ Polyploidy Panel libraries. Using other templating
and sequencing chemistry can result in unstable ratios of read counts between the two library types.
Only use the lon 510™ & lon 520™ & lon 530™ Kit — Chef for templating and sequencing when running
lon AmpliSeg™ Polyploidy Panel libraries alone without combining with lon SingleSeq™ libraries.

Barcode Compatibility

lon SingleSeq™ Barcodes 1-96 share some sequences with lonCode™ Barcode Adapters 1-384 Kit
(A29751). To avoid compatibility issues, the lonCode™ Barcode Adapters 385-768 Kit (A36546) or its
component plates can be used.

Component plate Part. No.
lonCode™ 0501-0596 in 96-well PCR Plate (red) A36524
lonCode™ 0601-0696 in 96-well PCR Plate (yellow) A36525
lonCode™ 0701-0796 in 96-well PCR Plate (green) A36526
lonCode™ 0801-0896 in 96-well PCR Plate (blue) A36527
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Library Pooling

Note: If using lon SingleSeq™ Barcodes GX (101-196, 201-296, 301-396, or 401-496), lonCode™
Barcode Adapters 1-384 Kit (A29751) are compatible, while many barcodes from lonCode™ Barcode
Adapters 385-768 Kit (A36546) are not compatible.

Library Pooling

For PGS results, it is desirable for each lon SingleSeq™ PGS library to obtain >100,000 reads. For
polyploidy results, it is desirable for each lon AmpliSeq™ Polyploidy Panel library (lonCode™ Barcode
Adapters) to obtain >200,000 reads. The total reads obtained from sequencing and the ratio of lon
AmpliSeq™ Polyploidy Panel libraries to lon SingleSeq™ PGS libraries determine the allocation of reads
in the run.

lon SingleSeq™ libraries are equal volume pooled before purification and quantification using the
Qubit™ Fluorometer. lon AmpliSeg™ Polyploidy Panel libraries are quantitated either by gPCR (no library
amplification) or Qubit™ Fluorometer and then combined in an equal molar pool. The instructions below
describe how to combine these two pools into a single pool for templating and sequencing on the

lon Chef™ Instrument and lon GeneStudio™ S5 Systems.

Combine Qubit™ Fluorometer quantitated lon SingleSeq™ libraries with qPCR
quantitated lon AmpliSeq™ Polyploidy Panel libraries

1. Dilute the lon SingleSeqg™ library pool to 40-80 pM.

2. Dilute the lon AmpliSeq™ Polyploidy Panel library pool so that its concentration is 2.5 times the
concentration of the lon SingleSeqg™ library pool.

For example, if the lon SingleSeq™ library pool is at 50 pM, dilute the lon AmpliSeg™ Polyploidy
Panel library pool to 125 pM.

3. Add 25 pL of diluted lon SingleSeqg™ library pool and 25 pL of diluted lon AmpliSeg™ Polyploidy
Panel library directly into the Library Sample Tube (50 pL total volume).

4. Vortex to mix, then centrifuge briefly.

Combine Qubit™ Fluorometer quantitated lon SingleSeq™ libraries with
Qubit™ Fluorometer quantitated lon AmpliSeq™ Polyploidy Panel libraries

1. Dilute the lon SingleSeg™ library pool to 40-80 pM.

2. Dilute the lon AmpliSeq™ Polyploidy Panel library pool so that its concentration is 5 times the
concentration of the lon SingleSeg™ library pool.

For example, if the lon SingleSeq™ library pool is at 50 pM, dilute the lon AmpliSeg™ Polyploidy
Panel library pool to 250 pM.

3. Add 25 pL of diluted lon SingleSeq™ library pool and 25 pL of diluted lon AmpliSeq™ Polyploidy
Panel library directly into the Library Sample Tube (50 pL total volume).

4. Vortex to mix, then centrifuge briefly.
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Templating and sequencing of combined lon SingleSeq™ &
lon AmpliSeq™ Polyploidy Panel libraries on lon 530™ Chips

The recommended maximum number of each library type in a combined library pool that can be
sequenced per run on an lon 530™ Chip is: 32 lon SingleSeq™ libraries + 32 lon AmpliSeq™ Polyploidy
Panel libraries.

1. Prepare a run plan template including lon SingleSeq™ Barcodes 1-96 and optional step 8 on
page 51 increasing the number of Flows to 550. For more information, see “Create a Planned
Run template for use with lon ReproSeq™ PGS Kits” on page 49.

2. Use the run plan template to create a run plan that includes sample information. For more
information, see “Create a Planned Run for use with lon ReproSeq™ PGS Kits” on page 51.

3. Proceed to Chapter 6, “Run the lon Chef™ System”.
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IMPORTANT! This sequencing kit is compatible with Torrent Suite™ Software 5.10 and later. Before
proceeding, check for updates to Torrent Suite™ Software and the sequencing instrument software, and
install the updates if available.

About Planned Runs

IMPORTANT! For more information about creating a Planned Run in Torrent Suite™ Software, including
a complete description of each field in the Create Plan step, see the Torrent Suite™ Software help
system or the Torrent Suite™ Software User Guide for the software version that you use.

Planned Runs are digital instructions that are created in Torrent Suite™ Software for controlling the
template preparation and sequencing instruments. Planned Runs contain settings such as humber

of flows, kit types, barcodes, sample information, and reference files (if any). Planned Runs are also
used to track samples, chips, and reagents throughout the workflow, from template preparation on the
lon Chef™ Instrument through sequencing on an lon S5™/lon S5™ XL Sequencer or lon GeneStudio™ S5
Series Sequencer and subsequent data analysis.

Before you create a Planned Run template for use with lon AmpliSeq™ Polyploidy Panel Kits, you must
download the lon AmpliSeq™ Polyploidy DNA Panel and the ReproSegSnpAnalysis plugin plugin. The
panel file includes the lon AmpliSeq Polyploidy DNA - lon S5 System - 530 Planned Run template
and analysis parameters that are used in this procedure. For more information, see “Upload panel files
for lon AmpliSeq™ Polyploidy Panel Kits” on page 56.
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K
Create a Planned Run template for use with lon ReproSeq™ PGS Kits

Create a Planned Run template for use with lon ReproSeq™
PGS Kits

We recommend that you create a Planned Run template for reuse when the same conditions are used
for multiple runs. Use this procedure to create a Planned Run template for use with lon ReproSeg™ PGS
Kits.

1. Sign in to Torrent Suite™ Software.
2. In the Plan tab, in the Templates screen, click Reproductive in the left navigation menu.

3. In the list of templates, find lon ReproSeq Aneuploidy - lon S5 System, then click £*
(Actions) » Copy.
The Copy Template screen opens to the Save step.

4. Enter or select the needed information.

Item Action

Template Name Enter a name for the Planned Run template.

(Optional) Set as Favorite | Select the Set as Favorite checkbox to add your custom template to the
Favorites list.

Analysis Parameters Ensure that Default (Recommended) is selected.

DNA Reference Library | Select hg19 (Human (hg19)).

Target Regions Select None.

Hotspots Regions Select None.

Monitoring Thresholds | Ensure that the values Bead Loading, Key Signal, Usable Sequence are
each set to 30.

As you make your selections, your settings are updated in the Summary pane.
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5. (Optional) In the lon Reporter step, complete the following fields if you plan to send data to lon
Reporter™ Software for further analysis after the sequencing run is complete.

Item

Selection

lon Reporter | Select your lon Reporter™ Software account.

Account

Sample Self is preselected if only one lon Reporter™ Software account or lon Reporter™ Server
grouping is available. You can select another server, if appropriate.

lon Reporter | To transfer data automatically to lon Reporter™ Software after the run is complete,
Upload select Automatically upload to lon Reporter after run completion.

Options To pause Torrent Suite™ Software before running lon Reporter™ Software, select

Review results after run completion, then upload data to lon Reporter™ Software
manually after the run.

workflow .

Existing Select one of the following.

ReproSeq PGS w1.1
ReproSeq No Gender PGS w1.1
ReproSeq Mosaic PGS w1.1

Note:

. The ReproSeq Low-Coverage Whole-Genome Baseline is automatically used
in the aneuploidy analysis workflows. As a result, there is no need to create a
custom baseline for your lon ReproSeq™ analyses.

. To customize one of the system-installed aneuploidy analysis workflows, see
the software help system or the lon Reporter™ Software User Guide for the
software version that you use.

. The Low-pass whole-genome aneuploidy w1.0 workflow is used for non-lon
SingleSeq™ libraries only.

6. In the Research Application step, ensure that DNA is selected for the Research Application and
Whole Genome is selected for Target Technique.

7. In the Kits step, ensure that lon Chef is selected for the Template Kit, then complete the following

fields.
ltem Selection
Instrument lon GeneStudio™ S5 System
Library Kit Type lon SingleSeq Kit
Template Kit lon ReproSeq™ PGS Kits—Chef

Sequencing Kit

lon S5 ExT Sequencing Kit

Control sequence

Leave blank.

Chip Type

The chip type is set to the lon 530™ Chip in the default run template and cannot
be changed in the software.

If you need to change the chip type to the lon 510™ Chip or lon 520™ Chip, you
need to create a new template. See “Create a new run template to change chip
types for a planned run” on page 141.
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Create a Planned Run for use with lon ReproSeq™ PGS Kits

(continued)
Item Selection
Barcode Set lon SingleSeq™ Barcodes 1-24 or lon SingleSeq™ Barcodes 1-96.
Flows 250
Advanced Settings | Use Recommended Defaults.

(Optional) If sequencing combined lon SingleSeg™ and lon AmpliSeq™ Polyploidy Panel libraries.
Set the number of Flows to 550.

Click Next to proceed to the Plugins step, then ensure that the FilterDuplicates plugin is
selected. For more information about the FilterDuplicates plugin, see the Torrent Suite™ Software
help system or the Torrent Suite™ Software User Guide for the software version that you use.
Click Next to proceed to the Projects step.

(Optional) In the Projects step, select the project appropriate to your run, then click Next.

In the Save step, click Copy Template to save the new Planned Run template.

The new template is now available in Torrent Suite™ Software, in the Templates screen under the
Reproductive application.

Create a Planned Run for use with lon ReproSeq™ PGS Kits

lon ReproSeq™ PGS Kits require lon Chef™ System be used for library preparation. Before you begin,
your lon Torrent™ Server must be connected to the lon Chef™ Instrument and lon S5™ System or lon
GeneStudio™ S5 System on which you will use the Planned Run. For more information, see “Prepare the
lon Chef™ System for use” on page 66.

1.

Sign in to the Torrent Suite™ Software on a computer that is connected to your lon Chef™
Instrument.

Under the Plan tab, in the Templates screen, click Reproductive in the research application list.

In the Reproductive list, click a customized Planned Run template name for use with lon
ReproSeq™ PGS Kits. Alternatively, click % (Actions) » Plan Run in the row that contains the
Planned Run template.

The Create Plan screen opens to the Plan step.

Enter, select, or verify the following information. Row numbers in the table correspond to the
callouts in the following figure.

Callout

Item Action

1

Run Plan Name Enter a name for the Planned Run template.

2

Analysis Parameters Ensure that Default (Recommended) is selected.
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Create a Planned Run for use with lon ReproSeq™ PGS Kits

(continued)

Callout Item

Action

3 Default Reference & BED Files

* Reference Library: hg19 (hg19 from zip)
¢ Target Regions: None
¢ Hotspot Regions: None

4 Use same reference & BED files
for all barcoces

Ensure that the checkbox is selected.

5 Number of barcodes

Enter the number of barcodes to be used in this run, then click &@.

6 Sample Tube Label

(Optional) Enter or scan the barcode of the lon Chef™ sample tube to
be used in the run.

7 Chip Barcode

(Optional) Enter or scan the chip barcode.

8 Pre-Implantation Genetic
Screening

Select Pre-Implantation Genetic Screening.

Template Name :

lon ReproSeq Aneuploidy - lon S5 System

Run Plan Name (required) :

@— lon ReproSeq Aneuploidy - lon S5 System

@— Analysis Parameters: @ Default (Recommended) O Custom Details +
@— Default Reference & BED Files
Reference Library: hg19(Homo sapiens) -
Target Regions: Noiic -
Hotspot Regions: e -
@— Use same reference & BED files for all barcodes
(5)— Number of barcodes : 1 °
@— Sample Tube Label : ‘ ‘
@— Chip Barcode : ‘ ‘
Enter a sample name for each barcode used (require at least one sample) & ¥ (]

@ Pre-implantation Genetic Screening

O Dinealams
8 —
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5. (Optional) Enter notes for the sequencing run in Add a note and Add LIMS Meta Data.

6. Ensure that all Monitoring Thresholds are set to 30.

7. (Optional) Click the lon Reporter step, then complete the following fields if you plan to send data
to lon Reporter™ Software for further analysis after the sequencing run is complete.

ltem Selection

lon Reporter | Select your lon Reporter™ Software account.

Account

Sample Self is preselected if only one lon Reporter™ Software account or lon Reporter™ Server

grouping is available. You can select another server, if appropriate.

lon Reporter | To transfer data automatically to lon Reporter™ Software after the run is complete,

Upload select Automatically upload to lon Reporter after run completion.

Options To pause Torrent Suite™ Software before running lon Reporter™ Software, select
Review results after run completion, then upload data to lon Reporter™ Software
manually after the run.

Existing Select one of the following.

workflow

ReproSeq PGS w1.1
ReproSeq No Gender PGS w1.1
ReproSeq Mosaic PGS w1.1

Note:

. The ReproSeq Low-Coverage Whole-Genome Baseline is automatically used
in the aneuploidy analysis workflows. As a result, there is no need to create a
custom baseline for your lon ReproSeq™ analyses.

. To customize one of the system-installed aneuploidy analysis workflows, see
the software help system or the lon Reporter™ Software User Guide for the
software version that you use.

. The Low-pass whole-genome aneuploidy w1.0 workflow is used for non-lon
SingleSeqg™ libraries only.

8. In the Research Application step, ensure that DNA research application and Whole Genome
target technique are selected.

9. In the Kits step, complete or verify the following fields.

Item

Selection

Instrument

lon GeneStudio™ S5 System.

Chip Type

The chip type is set to the lon 530™ Chip in the default run template and
cannot be changed in the software.

If you are using the default template and you need to change the chip
type to the lon 510™ Chip or lon 520™ Chip, you need to create a new
template. See “Create a new run template to change chip types for a
planned run” on page 141.

If you are using a new template, if needed, you can change the chip type
in the software.
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Create a Planned Run for use with lon ReproSeq™ PGS Kits

(continued)

Item

Selection

(Optional) Sample
Preparation Kit

Select the sample preparation kit used.

(Optional) Control
Sequence

Leave deselected.

Library Kit Type

lon SingleSeq Kit

Barcode Set

Select lon SingleSeq™ Barcodes 1-24 or lon SingleSeq™ Barcodes 1-96.

Template Kit

lonChef, and lon ReproSeq™ PGS Kits-Chef.

Flows

250

Sequencing Kit

lon S5 ExT Sequencing Kit.

Mark as Duplicate Reads

Leave deselected.

Enable Realignment

Leave deselected.

Advanced Settings

Use Recommended Defaults.

IMPORTANT! If sequencing combined lon SingleSeq™ and lon AmpliSeq™ Polyploidy Panel
libraries, ensure the number of Flows is set to 550.

10. In the Plugins step, ensure that the FilterDuplicates plugin is selected. For more information
about the FilterDuplicates plugin, see the software help system or the Torrent Suite™ Software
5.18 User Guide (Pub. No. MANO026163).

11. (Optional) In the Projects step, select the project or projects that receive data from the runs that
use this template, then click Next.

12. |n the Plan step, In the Plan step for each sample enter sample information for each sample.

Enter a sample name for each barcode used (require at least one sample) ©  § (]

(O Oncology

# Barcode

Sample Name

@ Pre-implantation Genetic Screening

Sample ID Sar

SingleSeg_001 (TAGGTGGTTC)

Sample 1
v

Centrol Type
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Iteml(]

Action

Barcode

For each sample select the Barcode from the dropdown list.

Sample Name

Accept the auto-populated sample names or click in a field, then enter
a unique sample name. We recommend sample names be unique even
between runs.

Control Type

Click Control Type to view the Control Type column, then select No Template
Control from the dropdown list to designate a sample as a no template
control.

Sample ID

(Optional) Click in the field, then nter a sample ID.

Note: Ensure that the samplelD is enabled in Torrent Suite™ Software. For
more information, see the help system for your version of Torrent Suite™
Software.

Sample Description

(Optional) Click in the field, then enter a sample description.

Referencel?!

(Optional) Click Reference to view the Reference , Target Regions, and
Hotspot Regions columns, then select the reference files for the barcode.

Annotations
(expanded)

These columns appear after Sample Receipt Date.
* (Optional) Biopsy Days
* (Optional) Cell Number
® (Optional) Couple ID
* (Optional) Embryo ID

Sample Collection
Date

(Optional) The date when the sample was collected.

Sample Receipt Date

(Optional) The date when the sample was received.

lon Reporter Select the workflow from the dropdown.

Workflow Select Show All Workflows to display more workflows in the dropdown.
Relation (Optional) Select the relation from the dropdown menu.

Gender Select the gender from the dropdown menu.

Population (Optional) Select the population from the dropdown menu.

Mouse Strains Leave blank.

Witness (Optional)

IR Set ID Leave blank.

[ Click vertical column headings (Control Type, Reference, Annotations) to reveal more columns.

[l The Reference, Target Regions, and Hotspots Regions fields are displayed only if the checkbox for Use same Reference &
BED files for all barcodes is selected (see step 4).

13. Click Plan Run.
The run is listed in the Planned Run List screen under the name that you specified and is automatically

used by the lon Chef™ Instrument when the associated lon Chef™ Library Sample Tube is loaded on the
instrument.
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Note: If you have not entered the sample tube label (see step 4), you must select a run plan. You are
prompted to do so when you set up the lon Chef™ Instrument.

Upload panel files for lon AmpliSeq™ Polyploidy Panel Kits

Before you create a Planned Run template or a Planned Run for use with lon AmpliSeq™ Polyploidy
Panel Kits, you must download the lon AmpliSeq™ Polyploidy DNA Panel and the ReproSeqSnpAnalysis
plugin from the Thermo Fisher™ Connect Platform at Thermo Fisher Connect (See “Install or upgrade
plugins” on page 60). The panel file includes the lon AmpliSeq Polyploidy DNA - lon S5 System -
530 Planned Run template and analysis parameters that are used in sequencing runs for the kits.
The following BED files must be uploaded.

* Target regions file—lon_AmpliSeq_Polyploidy_Panel_w1.0.0.bed

* Hotspots file—lon_AmpliSeq_Polyploidy_Hotspots_w1.0.0.bed

Import a Planned Run template

IMPORTANT! Do not restart the system during installation of planned run templates.

1. In the Plan tab, in the Templates screen, in the research application group pane on the left, select
AmpliSeq DNA.

2. Click Upload » Upload Design/Panel ZIP Archive.

* Favorites * Favorites m AmpliSeq.com ® | | Add New Template | Plan New Run
load Pi [
o All Upload Plans
AmpliSeq DNA
m Upload Design/Panel Zip Archive
nAmp“seq RNA S e Q- Go D Instrument: All - Sample Prep: Al ~

3. In the Import Panel from Zip Archive dialog box, click Select File, select the following templates,
then click Upload Panel from Zip Archive.

ZIP File Description

lon_AmpliSeq_Polyploidy_DNA_Panel.zip Run Plan template for the lon 530™ Chip.

The template is listed in the AmpliSeq DNA application group. Exported Planned Run templates
have "exported" appended to the front of the original template name, unless the name has been
edited in the CSV file.
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Upload a target regions file

Yo
ref

u can upload a target regions BED file from your computer to Torrent Suite™ Software to use with a
erence sequence.

Target regions files are only BED files. Supported file extensions are .bed, .zip, and .bed.gz. During file

up

load, the software validates the BED file, then helps ensure that the coordinate regions of the BED file

are valid for the selected reference genome. The new BED file is then available as an option when you
create a Planned Run.

IM

PORTANT! You must upload target regions files that match both the reference sequence and

the reference sequence version. The uploader cannot always detect mismatch errors. It is your
responsibility to avoid the following uploading errors:

.

Uploading a BED file for a reference sequence of a different version (for example, an hg18 BED with
an hg19 reference).
Uploading a BED file for a different species.

Uploading a hotspots BED file as a target regions BED file.

1.

Click £+ (Settings) » Reference Sequences, then click Target Regions in the left navigation
menu.

In the Target Regions screen, click Add Target Regions.

Reference: All - I Add Target Regions

Name Description Notes Reference Enabled Upload Date v

Target Regions

I Icn_AmpllSeq_PeJyplomy_PaneJ_wi.O.D.neul GRCh38 p2 mask1 true Jan 312023

In the New Target Regions screen, click Select File, then navigate to the file to be uploaded.

Select the reference sequence from the Reference list.

IMPORTANT!

. Be careful to select the correct reference sequence because the new target regions file can be
used only with this reference.

. The reference sequence must be uploaded and available for selection before a target regions file
can be uploaded.

(Optional) Add a description and notes.

Click Upload Target Regions File.

Wait while the file is validated. The status updates to Successfully Completed after the upload
finishes. Errors are reported in the Processing Log pane.
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)
=

(-

Original File :  /results/uploads/BED/1/lon_AmpliSeq_Polyploidy_Panel_w1.0.0.bed (30,444 byies)
Type: Target Regions
Date: Jan. 31,2023, 3:50 p.m.

Status :  Successfully Completed

Pre Processing /results/uploads/BED/1/Ion_AmpliSeq Polyploidy Panel wl.@.@.bed

Dealing with the upload file

Compressed: No

Updating Meta

Content: Target regions file in BED format

0

Validating target file: Ion_ AmpliSeq Polyploidy Panel wl.0.@.bed

0

Ton_AmpliSeq_Polyploidy Panel wl.@.@.bed: 443 lines have non-unix line endings (showing first 1@ warning).

Ion_AmpliSeq Polyploidy Panel wl.0.@.bed: line 1lg Warning DOS line ending

For large files, validation can take several minutes. Refresh your browser to check that validation is
complete.

The new file appears in the Target Regions list in the Plan step of the Planned Run workflow bar, and
in the Target Regions table in the References tab.

Upload a hotspots file

You can upload a hotspots file from your computer to Torrent Suite™ Software to use with a reference
sequence.

Hotspots files can be BED or VCF files. Supported file extensions are .bed, .vcf.gz, .zip, .bed.gz,
and .vcf.gz. During file upload, the software validates the BED or VCF file, then helps ensure that the
coordinate regions of the file are valid for the selected reference sequence. The new BED file is then
available as an option when you create a Planned Run or configure the variantCaller plugin.

IMPORTANT! Upload BED or VCF files that match both the reference sequence and the reference
sequence version. The uploader cannot always detect mismatch errors. It is your responsibility to avoid
the following uploading errors:

. Uploading a BED or VCF file to a reference sequence of a different version (for example, an hg18
BED file with an hg19 reference).
. Uploading a BED or VCF file for a different species.

. Uploading a target regions BED file as a hotspots BED file.
. Uploading a hotspots file listing loci not included in a target regions file.
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Click £+ (Settings) » Reference Sequences, then click Hotspots in the left navigation menu.

In the Hotspots screen, click Add Hotspots.

Hotspots
e Reference: All ~ I Add Hotspots
Name Description Notes Reference Enabled Upload Date v
I lon_AmpliSeq_Polyploidy_Hotspots_w1.0.0.bed I GRCh38.p2.mask1 true Jan 312023

In the New Hotspots screen, click Select File, then navigate to the file to be uploaded.

Select the reference sequence from the Reference list.

IMPORTANT!

. Ensure that you select the correct reference sequence because the new hotspots file can be
used only with this reference.

. The reference sequence must be uploaded and available for selection before a hotspots file can
be uploaded.

(Optional) Add a description and notes.

Click Upload Hotspots File.

The status updates to Successfully Completed after the upload finishes. Errors are reported in the
Processing Log pane.

Original File :  /results/uploads/BED/2/lon_AmpliSeq_Polyploidy_Hotspots_w1.0.0.bed (63,476 bytes)
Type: Hotspots
Date: Jan. 31, 2023, 3:53 p.m

Status :  Successfully Completed

Pre Processing /results/uploads/BED/2/Ion_AmpliSeq Polyploidy Hotspots_wl.@.8.bed

Dealing with the upload file

Compressed: No

Updating Meta

Content: Hotspots file in BED format

0

Validating hotspot file: Ion_AmpliSeq Polyploidy Hotspots wl.@.@.bed

0

Ion_AmpliSeq_Polyploidy Hotspots wl.@.@.bed: 819 lines have non-unix line endings (showing first 1@ warning)
Ion_AmpliSeq_Polyploidy Hotspots wl.@.8.bed: 228 lines have non-unique region names. (showing first 1@ warnings)
Ion_AmpliSeq_Polyploidy Hotspots wl.@.8.bed: line g Warning track line has no ionVersion number

Ion_AmpliSeq_Polyploidy Hotspots wl.@.8.bed: line g Warning DOS line ending
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Upload panel files for lon AmpliSeq™ Polyploidy Panel Kits

Note:

. For large files, validation can take a few minutes. Refresh your browser to check that validation
is complete.
. If you selected a VCF file for upload, the software validates it and converts it to a BED file.

The new file appears in the Hotspots list in the Plan step of the Planned Run workflow bar, and in the
Hotspots table in the References tab.

Enable an installed plugin

After installing a plugin, you must enable the plugin to make the plugin available in Torrent Suite™
Software.

1. Click £} (Settings) » Plugins.

) Install or Upgrade Plugin Rescan Plugins for Changes
Plugins
Enabled  Disabled = Either Clear
. Installed
Enabled Name Selected by Default Version Date v lon Supported Manage
R SeqSnpAnal M) 103 Feb 23 N
eproSeqSnpAnalysis o o=
P a=np ’ — 2023 o
Jan 25

variantCaller M) 5.16.0.0 : Yes &~

— 2023

2. To make the plugin available, in the Plugins list, select the Enabled checkbox next to the
ReproSeqSnpAnalysis.
The plugin is immediately available.

Install or upgrade plugins

On Thermo Fisher™ Connect Platform, an administrator can install or upgrade the following:

1. Sign into Thermo Fisher Connect.
2. Click the Apps icon ().
3. In AppConnect, under Resource Libraries, click Plugins.

4. (Optional) Click PGS at the top of screen.
The list of plugins is narrowed to only the plugins included that are in the selected category.
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Create a Planned Run Template for use with lon AmpliSeq™ Polyploidy Panel Kits

5. Download plugin and panel files.

« Categories

Cloud-based ) .
ChIP-Seq Commercial | | Epigenetics | | lon Supported | | Microbial | | MSI RNA-Seq | | Unsupported

Software

Variant Detection /

Utilities
Annotation
All plugins
Name ~ Category Downl
on AmpliSeq Polyploidy DNA Pane Commercial, PGS, lon Supported on
ReproSeqSnpAnalysis Plugin - 1.0.3 Commercial, PGS, lon Supported o0

a. Click #% to download lon AmpliSeq Polyploidy DNA Panel. Select the checkbox to indicate
that you agree to the terms and conditions, then click Download Plugin.

b. Click &3 to download ReproSeqSnpAnalysis Plugin - 1.0.3. Select the checkbox to indicate
that you agree to the terms and conditions, then click Download Plugin.

Either a compressed directory or a debian file that contains the plugin is downloaded to your local
machine.

6. In Torrent Suite™ Software, click £# (Settings) » Plugins » Install or Upgrade Plugin.

7. Click Select File, browse to the location where you downloaded the plugin file, select the file, then
click Open.

8. In the Install or Upgrade Plugin dialog box, click Upload and Install.

The plugin is now visible in Torrent Suite™ Software.

Create a Planned Run Template for use with lon AmpliSeq™
Polyploidy Panel Kits

We recommend setting up a customized Planned Run template for reuse when the same conditions are
used for multiple runs. Use this procedure to create a Planned Run template for use with lon AmpliSeq™
Polyploidy Panel Kits.

1. Sign in to Torrent Suite™ Software.
2. In the Plan tab, in the Templates screen, click Polyploidy in the left navigation menu.

3. In the Reproductive table, select lon AmpliSeq Polyploidy DNA - lon S5 System - 530, then
click £# Settings » Copy in the row of the template.
The Copy Template screen opens to the Save step.
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Create a Planned Run Template for use with lon AmpliSeq™ Polyploidy Panel Kits

4. Enter or select the required information in each field in the Save step.

Field Action
Template Name Enter a name for your custom Planned Run template.
(Optional) Set as Select the Set as Favorite checkbox to add your custom template to the
Favorite Favorites list.

Analysis Parameters | Ensure that Default (Recommended) is selected.

Library

DNA Reference Ensure that GRCh38.p2.mask1(GRCh28.p2.mask1)is selected.

DNA Target Regions | Ensure that lon_AmpliSeq_Polyploidy Panel_w1.0.0.bed is selected.

DNA Hotspot Ensure that lon_AmpliSeq_Polyploidy_Hotspots_w1.0.0.bed is selected.
Regions

Monitoring Verify that the values Bead Loading, Key Signal, Usable Sequence are each
Thresholds set to 30.

As you make your selections, your settings are updated in the Summary pane.

. Click the lon Reporter step, then ensure that None is selected for lon Reporter Account.

Sequencing runs for use with lon AmpliSeg™ Polyploidy Panel Kits can be analyzed only by the
ReproSeqgSnpAnalysis in Torrent Suite™ Software. Therefore, configuration for automatic transfer
of data to lon Reporter™ Software is unnecessary.

. Click Next.

In the Research Application step, ensure that DNA is selected for the Research Application and
AmpliSeq DNA is selected for Target Technique selections are correct, then click Next.

In the Kits step, select the required information in each field.

Option

Selection

Instrument

lon GeneStudio™ S5 Series

Chip Type

lon 530™ Chip

Sample Preparation Kit

(Optional) Select the sample preparation kit used to prepare samples.

Control sequence

Leave blank.

Library Kit Type

lon AmpliSeq 2.0 Library Kit

Barcode Set

lonCode

Template Kit

Ensure that lonChef is
selected.

lon 520™ or lon 530™ Chip

Flows

550

Sequencing Kit

lon S5™ Sequencing Kit

Mark as Duplicate Reads

Leave deselected.
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Create a Planned Run for use with lon AmpliSeq™ Polyploidy Panel Kits

(continued)
Option Selection
Enable Realignment Leave deselected.
Advanced Settings Select Customize, then select Chef Protocol - 400 for the Templating
Protocol.
Click Next.

In the Plugins step, verify that the coverageAnalysis, ReproSeqSnpAnalysis, and variantCaller
plugins are pre-selected.

Click Next.

(Optional) In the Projects step, select a project to receive data from Planned Runs that use this
template, then click Next.

In the Save step, enter a template name in the Template Name (required) field, then click Copy
Template to save your custom Planned Run template.

The new template is now available in Torrent Suite™ Software, in the Templates screen under the
Reproductive application.

Create a Planned Run for use with lon AmpliSeq™
Polyploidy Panel Kits

lon ReproSeq™ PGS Kits require lon Chef™ System be used for library preparation. Before you begin,
your lon Torrent™ Server must be connected to the lon Chef™ Instrument and lon S5™ System or lon
GeneStudio™ S5 System on which you will use the Planned Run. Fore more information, see “Prepare
the lon Chef™ System for use” on page 66.

1.

Sign in to the Torrent Suite™ Software for the lon Torrent™ Server that is connected to your
lon Chef™ Instrument.

In the Plan tab, in the Templates screen, click Reproductive in the left navigation menu.

In the Template Name column, click on your customized Planned Run template name.
The Create Plan screen opens to the Plan step.
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Create a Planned Run for use with lon AmpliSeq™ Polyploidy Panel Kits

4. Enter or select the following information.

Callout | Field Action
1 Run Plan Name Enter a Planned Run name.
2 Analysis Parameters Ensure that Default (Recommended) is selected.
3 Default Reference & BED Select the default reference sequence file and target regions
Files and hotspots BED files for your sequencing run.

4 Use same reference & BED Leave selected.
files for all barcodes

5 Number of barcodes Enter the number of barcodes to be used in this run, then
click @.
6 Sample Tube Label Enter or scan the barcode of the lon Chef™ sample tube to be

used in the run.

7 Chip Barcode (Optional) Enter or scan the chip barcode.

lon AmpliSeq Polyploidy DNA - lon S5 System - 530

Run Plan Name (required) :

T

lon AmpliSeq Polyploidy DNA - lon §5 System - 530

I

Analysis Parameters: @ Default (Recommended) (O Custom Detalls +

Default Reference & BED Files -

Reference Library: GRCh38.p2.mask1(GRCh38.p2.mask1 -

77

Target Regions: lon_AmpliSeq_Polyploidy_Panel_w1.0.0.bed -
Hotspot Regions: lon_AmpliSeq_Polyploidy_Hotspots_w1.0.0.bed ~

Use same reference & BED files for all barcodes

@—Number of barcodes : 1 (] Save Samples Table Load Samples Table

( : ) Sample Tube Label : ‘
Chip Barcode : ‘ ‘
@ i

(Optional) Enter notes for the sequencing run in Add a note and Add LIMS Meta Data.

Ensure that all Monitoring Thresholds are set to 30.

Click the lon Reporter step, then ensure that None is selected for lon Reporter Account.

Sequencing runs for use with lon AmpliSeg™ Polyploidy Panel Kits can be analyzed only by the
ReproSeqgSnpAnalysis in Torrent Suite™ Software. Therefore, configuration for automatic transfer
of data to lon Reporter™ Software is unnessary.
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Create a Planned Run for use with lon AmpliSeq™ Polyploidy Panel Kits

8. In the Plan step for each sample enter sample information for each sample.

Iteml(]

Action

Barcode

For each sample select the Barcode from the dropdown list.

Sample Name

Accept the auto-populated sample names or click in a field, then enter a unique
sample name. We recommend sample names be unique even between runs.

Control Type

Click Control Type to view the Control Type column, then select No Template
Control from the dropdown list to designate a sample as a no template control.

Sample ID (Optional) Click in the field, then enter a sample ID.
Note: Ensure that the samplelD is enabled in Torrent Suite™ Software. For more
information, see the help system for your version of Torrent Suite™ Software.
Sample (Optional) Click in the field, then enter a sample description.
Description
Referencel?! (Optional) Click Reference to view the Reference , Target Regions, and Hotspot

Regions columns, then select the reference files for the barcode.

[ Click vertical column headings (Control Type, Reference, Annotations) to reveal more columns.
[l The Reference, Target Regions, and Hotspots Regions fields are displayed only if the checkbox for Use same Reference &
BED files for all barcodes is selected (see step 4).

# Barcode

Sample Name Sample ID Sample Description

Reference

Control Type —@

1 onCode_0101 (CTAAGGTAAC) v  Sample 1

9. Click Plan Run.

The run is listed in the Planned Runs screen under the name that you specified and is automatically
used by the lon Chef™ Instrument when the associated lon Chef™ Library Sample Tube is loaded on the

instrument.
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Before you begin

Library type

Depending on the library type you are preparing, chose from the following options:

For lon SingleSeqg™ libraries only, proceed to “Prepare the lon Chef™ System for use” on page 66.

When combining lon SingleSeq™ and lon AmpliSeq™ Polyploidy Panel libraries, proceed to
“Prepare the lon Chef™ System for use” on page 66.

For lon AmpliSeq™ Polyploidy Panel libraries only, see the lon 510™ & lon 520™ & lon 530™ Kit -
Chef User Guide (Pub. No. MAN0OO16854).

Prepare the lon Chef™ System for use

66

Before you use the lon Chef™ Instrument:

Ensure that the lon Chef™ Instrument has been cleaned following the previous run. If not, clean the
instrument before loading it with consumables.

Note: For more information on the cleaning procedure, see Chapter 9, “Clean the lon Chef™
System”.

Inspect the empty compartments of the Reagents and Solutions stations for condensation.
Condensate can collect in these compartments, depending on temperature and humidity
conditions. Before loading consumables into the instrument, wipe the compartments dry with a
laboratory wipe or absorbent cloth, if needed.
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Materials required

Ensure that the lon Chef™ Instrument has a connection to your lon Torrent™ Server. On the
lon Chef™ home touchscreen, touch Settings, then lon Torrent™ Server to view the connection
status of your instrument.

Note: If the instrument is not connected, see Appendix C, “Connections between lon Torrent™
Server and the lon Chef™ Instrument” for instructions on how to configure a direct or indirect
network connection of the lon Chef™ Instrument to an lon Torrent™ Server.

Materials required

lon ReproSeq™ PGS Kit with
lon 510™, lon 520™, or lon 530™ Chip

lon Chef™ S5 Series Chip Balance
Molecular-biology grade Nuclease-free Water
P10 and P200 pipettors, and filtered tips
Waste container

Prepare the consumables

1.

Unbox the lon S5™ EXT Chef Reagents cartridge 45 minutes before use, then allow it to warm to
room temperature.

IMPORTANT! The Reagents cartridge must sit at room temperature for 45 minutes before use.

Remove the other cartridges and consumables from their packaging, then place them on the
bench next to the lon Chef™ Instrument.

Prepare the following:
® Chip Adapter and Chip Balance
® Enrichment Cartridge v2
* Jon S5™ ExT Tip Cartridge
* PCR Plate, PCR Plate Frame, and Frame Seal v2
* Recovery Station Disposable Lid v2 (2)
* Recovery Tube (12)
* Jon S5™ Chef Solutions cartridge
* Jon S5™ EXT Chef Reagents cartridge (from step 1)

IMPORTANT! Before use, gently tap the Reagents cartridge and Solutions cartridge on the bench
to force the reagents to the bottoms of the tubes.

Note: When stored under normal conditions, a precipitate can form in some tubes of the lon S5™
EXT Chef Reagents cartridge. If present, load the cartridge as directed. The precipitate dissolves
when the reagents are mixed during instrument operation.
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Add the library to the Library Sample Tube

Add the library to the Library Sample Tube

1. Pipet 2—-4 pL of the 1 nM pooled library into the lon SingleSeq™ Library Sample Tube (barcoded
tube) from Position A of the Reagents cartridge. Add Nuclease-free Water to 50 pL (final
concentration of 40-80 pM). Pipet up and down 5 times to mix.

2. Cap the Library Sample Tube and store on ice until you are ready to load the tube into the
Reagents cartridge and the lon Chef™ Instrument.

Load the lon Chef™ System

IMPORTANT!

. Rated centrifuge speeds are intended for operation only with the provided buckets and approved
consumable chips, tubes, and sample preparation reagents.

. The Chip-loading centrifuge is rated to operate at the listed rotational frequencies with the chip
buckets, chip, adapter, and chip balance. The centrifuge must be load-balanced. Proper care must
be taken to load the bucket properly. If excessive vibrations arise, check to ensure that items are
installed properly and rotors are load-balanced.

. Use only the materials supplied in the lon ReproSeg™ PGS 510, 520, and 530 Kits to run the
centrifuges at the rated speeds. Do not remove or change the rotors. Inspect the buckets before
each use to assure normal operation.

. Ensure that the instrument is powered on and has been cleaned following the last use.

. Ensure that all components are clean and dry before loading them onto the lon Chef™ Instrument.

. Ensure that the Reagents and Solutions station compartments are dry and free of condensate before
loading components.

Follow the procedure described in the following sections to load the lon Chef™ Instrument.
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100000000
1190000

Figure 1 A schematic of a loaded lon Chef™ Instrument.

@ New lon S5™ ExT Tip Cartridge

(2) Frame Seal v2 (inserted)

@ Empty tip rack (move from new Tip cartridge position)
(@ PCR Plate and PCR Plate Frame

@ lon S5™ EXT Chef Reagents cartridge

() lon S5™ Chef Solutions cartridge

@ Recovery centrifuges: Recovery Tubes and Recovery
Station Disposable Lid v2

Enrichment Cartridge v2

@ Chip-loading centrifuge: Chip Adapter/Chip assembly
and Chip Balance

Load the tip racks and PCR Plate

1. Tap @ (Open Door) in the instrument touchscreen to open the instrument door, then wait for the
latch to open.

2. Lift the instrument door to the top of the travel until the latch mechanism engages.

(D) Hold here, then lift
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3. Load an empty pipette tip rack to the Used (Waste) Pipette Tip Position, then change gloves.

(1) Used Pipette Tip Position

IMPORTANT!

. Ensure that the pipette tip rack in the Used (Waste) Pipette Tip Position does not contain any
tips. The instrument will abort the run if tips are present in the Used position.

. To prevent contamination, change gloves immediately after moving the empty pipette tip rack to
the Used (Waste) Pipette Tip Position.

Note: A small amount of dried residue may be present in the tub of the empty pipette tip rack after
a run. This will not affect the next run.

4. Unwrap a new lon S5™ ExT Tip Cartridge and remove the cover to expose the pipette tips, then
load it in the New Pipette Tip Position.

Note:

. Two lon Chef™ Piercing Tips are pre-loaded into tip positions G7 and H7 on the lon S5™ EXT Tip
Cartridge.

. Keep the cover for later use.
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5. Slide the catch forward to allow the locking bracket to pivot upward. Load the lon S5™ EXT Tip
Cartridge into the New Pipette Tip Position, pull the bracket downward, then push the catch
backward to lock the cartridge in place.

(D) New Pipette Tip Position
(2) Bracket

(3 Catch

@ New lon S5™ ExT Tip Cartridge
6. Load a new PCR plate into the thermal cycler sample block.

7. With the white dot on the PCR Plate Frame facing upward, load the PCR Plate Frame into the
thermal cycler sample block pressing down firmly on each corner, then insert a new Frame Seal v2
underneath the automated heated cover. Ensure that the PCR Plate Frame is pressed completely
down onto the thermal cycler block and that the PCR Plate Frame sits lower than the PCR Plate.

IMPORTANT! When the Frame Seal v2 is positioned correctly, its tabs project upward and
contact the heated cover.

@ Thermal cycler sample block
(@ Well A1

(3 Cover

(@) Keyed corner
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Load the Reagents and Solutions cartridges

IMPORTANT! Thaw the Reagents cartridge at room temperature for 45 minutes before use.

1. Gently tap the lon S5™ ExT Chef Reagents cartridge on the bench to force the reagents to the
bottoms of the tubes.

2. Load the cartridge into the Reagents station so that it snaps into place and is level on the deck.

IMPORTANT! Do not force the lon Chef™ cartridges into place. Each cartridge fits only one
location on the deck and in one orientation. If a cartridge does not fit, confirm that you are loading
the correct cartridge in the correct orientation.

(1) Reagents station (4°C)
(2) lon S5™ EXT Chef Reagents cartridge

3. Uncap, then load the Library Sample Tube containing 50 pL of diluted library into Position A on the
Reagents cartridge.

e N
 —  —

N\
J
N\
J
\
J
\

I

Lo

ig')

 —  —
. J

@ Position A (Library Sample Tube)
(2) Position B (2M NaOH)

@ Position C (lon S5™ EXT Pellet)
@ Position D (Empty tube)

IMPORTANT! Orient the Library Sample Tube so that the barcode is visible and oriented to the
right.
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4. Uncap the tube of 2M NaOH in Position B, the tube containing the lon S5™ ExT Pellet in Position C,
and the empty tube in Position D.

IMPORTANT! When the Reagents cartridge is loaded:

. Press down on the Library Sample Tube to ensure that it is firmly seated in the cartridge.
. Ensure that all four tubes are uncapped.

5. Gently tap the lon S5™ Chef Solutions cartridge on the bench to force the reagents to the bottoms
of the tubes.

6. Load the Solutions cartridge into the Solutions station until it snaps into place and is level on the
deck.

@ Solutions station (room temperature)
(2 lon S5™ Chef Solutions cartridge

Load the Recovery Tubes and Enrichment Cartridge v2

1. Load six Recovery Tubes (v2) into each Recovery centrifuge.

S

(CE°N°N°D} RCI XX

(1) Recovery centrifuges
(2) Recovery Tube v2

Before sealing each centrifuge, confirm that:

* The centrifuge is load-balanced with all required consumables.

IMPORTANT! The centrifuge must be load-balanced.

* The buckets are securely seated in the centrifuge rotors.
* The buckets are oriented correctly in the centrifuge so that they pivot outwards.
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2. Place a Recovery Station Disposable Lid v2 over each centrifuge by lining up the tab with the
depression on the deck, then snap into place. Ensure that the lids snap completely into place by
applying firm downward pressure along the lid perimeter.

3. Close the hinged cover of the Recovery centrifuges. Confirm that the port of each disposable lid is
positioned toward the rear of the instrument.

() Recovery Tubes installed
(2) Recovery Station Disposable Lids installed
@ Recovery centrifuge cover closed

@ Port

IMPORTANT!
. Do not obstruct or place any object on top of the Recovery centrifuge cover.

. Use only the supplied materials, including buckets and disposables, to run the centrifuges at the
rated speeds. Do not remove or change the rotors. To facilitate normal operation, inspect the
buckets before each use.

4. Load the Enrichment Cartridge v2, then press down on the cartridge to ensure that it is level with
the instrument deck.

IMPORTANT! Ensure that the Enrichment Cartridge v2 is loaded so that the lettering on the
cartridge is right-side-up.

o

1

j

@ Enrichment station
(® Enrichment Cartridge v2

@ Lettering
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Load the Chip-loading centrifuge

Note: If desired, you can label the tops of chips to distinguish them. Do not obstruct or overwrite the
chip barcode with the label.

1. Load the chip that you will use for templating and
sequencing into a centrifuge bucket, then attach a
Chip Adapter to the assembly.

a. Place the chip in the chip-loading bucket, then
align the wells of the Chip Adapter to the wells of
the chip, orienting the adapter onto the chip so
that the chip barcode is visible.

b. Place the adapter onto the chip, then insert the
stationary tabs at the reservoir end of the adapter
into the slots of the bucket.

c. Gently squeeze the flexible tabs at the other end
of the adapter into the bucket slots until the

adapter locks into place. @ Chip Adapter
® lon Chip™
d. Confirm that the tabs at all four corners of the ® Bucket
adapter are fitted into the slots in the centrifuge @ Reservoir end of Chip Adapter
bucket. Loading can fail if the adapter is not ® Ports (align with chip)
attached securely. ® Tabs

@ Keyed corner (align with bucket)

2. Load the adapter/chip/bucket assembly into Position 1 Slots
of the Chip-loading centrifuge.

(D Chip-loading centrifuge
(2) Position 1

(3) Position 2 marker holes
(@) Position 2

(®) Position 1 marker hole

Note: Position 1 of the Chip-loading centrifuge is the position 90° clockwise from the single hole
in the rotor bucket cover at rest. The chip loaded in Position 1 is loaded with ISPs prepared from
the DNA library in the Library Sample Tube loaded in Position A of the Reagents cartridge.
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3. Load an lon Chef™ S5 Series Chip Balance into Position 2 of the Chip-loading centrifuge.

lon Chef™

\ S5 Series
o Chip Balance

lon Chef™
S5 Series
Chip Balance

(D) Position 1 (Chip)

(2) Position 2 marker holes
(3) Position 2 (Chip Balance)
(@) Position 1 marker hole

IMPORTANT! When the Chip-loading centrifuge is loaded, ensure that the Chip Adapter is firmly
attached to its bucket, and that each bucket is securely seated in the centrifuge rotors.

4. Ensure the centrifuge is load-balanced, and the chip buckets are securely seated and oriented
correctly in the centrifuge so that they pivot 90° outwards when touched. Then close the lid of the
Chip-loading centrifuge.

IMPORTANT! Do not obstruct or place any object on top of the lid.
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Confirm that consumables are correctly installed

¢ Confirm that each cartridge is at the correct location and in the correct orientation.
* Press down on all cartridges to confirm that they are firmly pressed into place.

® Confirm that all tubes in the lon S5™ ExT Chef Reagents cartridge, including the tube of NaOH in
Position C, are uncapped and firmly pressed into place.

¢ Confirm that the centrifuge lids are installed correctly so that the port is oriented toward the rear of
the instrument.

* Confirm that the tube and chip buckets are seated securely in the rotor arms of the Chip-loading
and Recovery centrifuges, and that the consumables they contain are correctly installed.

CAUTION! To facilitate correct and safe instrument operation, you must confirm that all
consumables are installed correctly to the deck before you start a run. The lon Chef™ Instrument
does not verify all aspects of the consumable setup before beginning each run.
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lon Chef™ pre-run checklist
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Checklist item

(@ Thermal cycler sample block

[~ |Anew PCR Plate is loaded in the thermal cycler sample block.
[~ | APCR Plate Frame is loaded in the thermal cycler sample block.
[~ | A Frame Seal v2 is in place and oriented under the heated cover.

(@ Used Pipette Tip position

-

The tip rack from previous run is transferred from the New Pipette Tip position to the Used Pipette Tip
position.

(® Recovery centrifuge

[~ | Recovery Tubes (v2) are securely seated in the Recovery centrifuge buckets.
[~ | Recovery centrifuges are load-balanced.
[~ | Each Recovery Station Disposable Lid v2 is positioned so that the port is oriented toward the rear of the

instrument.

(@ Enrichment station

[~ | Enrichment Cartridge v2 is pressed into place at the Enrichment station so that the cartridge is firmly seated
and level with the deck.

[~ | Lettering on the cartridge is right-side up and positioned to the right of the enrichment tubes.
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(continued)

v Checklist item

(®) Chip-loading centrifuge

[~ | Adapter/chip assembly is correctly seated in the Chip-loading centrifuge bucket loaded in Position 1, with the
adaptor clips inserted into the bucket slots.

[~ | Centrifuge buckets containing the adapter/chip assembly and Chip Balance, loaded in Position 2, are securely
seated in the centrifuge rotor, and freely pivot 90° outwards.

(® Solutions station

[~ | Solutions cartridge is pressed into place at the Solutions station so that the cartridge is firmly seated and level
with the deck.

(@ Reagents station

[~ | Reagents cartridge contents have been thawed at room temperature for 45 minutes.

[~ | Reagents cartridge tubes are uncapped and pressed into place at the Reagents station so that the tubes are
firmly seated and level with the deck.

[~ | Library Sample tube is firmly seated and in the correct orientation with barcode facing the PCR Plate and cap
removed.

New Pipette Tip position

[~ | Anew lon S5™ ExT Tip Cartridge is loaded in the New Pipette Tip position.

[~ | Bracket is pulled downward to lock the tip cartridge in place.
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Chapter 6 Run the lon Chef™ System
Start the lon Chef™ run

Start the lon Chef™ run

1.

Ensure that you have loaded the instrument with all kits and consumables.

2. On the lon Chef™ Instrument home touchscreen, tap Set up run.

lon Chef

© ®
Notifications Quick Start Settings

=

3. Tap Step by step to have the instrument lead you through the instrument setup, or tap Quick Start

to skip the instrument setup screens and proceed to Deck Scan.

Set up Run

= ©

Step by step ‘ Quick start

If you selected Quick Start, proceed to step 5, otherwise proceed to step 4.

4. (Step by step setup only) In the Run Options screen, tap Prepare Chip to select the templating

80

run option.

Run Options

Prepare Library Prepare Chip
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Start the lon Chef™ run

5. Follow the on-screen instructions. When prompted, close the instrument door by first lifting it
slightly to disengage the locking mechanism, then push down on the door until the locks engage.

IMPORTANT! Do not close the door by pulling it straight down from the open position. You must
lift the door slightly before you can close it. Ensure that both sides of the door are locked after
closing it.

(D) Lift door first

@) Lower

(3) Press down to lock
After the door closes, the instrument vision system activates.

6. When prompted, tap Start check to begin Deck Scan. Wait while the instrument scans the
barcodes of all consumables and reagents to confirm their presence and compatibility.

During Deck Scan, the touchscreen displays warnings if the lon Chef™ Instrument detects missing
or incompatible consumables. You must address all warnings before the run can start. After you
address each condition, tap Yes to continue.

IMPORTANT! The Deck Scan function is not a substitute for manual inspection of the reagents
and consumables on the lon Chef™ Instrument before starting a run. To facilitate proper and safe
instrument operation, ensure that all consumables are installed correctly before you continue.

7. When the Deck Scan is complete, tap Next to display the Data Destination screen.

lon Chef

Deck Scan

Complete
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Start the lon Chef™ run

8. Ensure that the instrument displays the correct kit type, chip type, chip barcode, and Planned Run.
If the correct Planned Run does not display, tap the dropdown list . to select the appropriate
Planned Run, then tap Next.

® Data Destination

Server: hawk.itw
Kit tvpe: lon 520 & lon 530 ExT Kit-Chef
ChipID:  530v1: DBAGO0466 Chip ID: Balance Chip
Sample ID: 00026078 Sample ID:
7PORY - EDL_SAMPLE... ¥ No Selection

Template size Template size

IMPORTANT! If the kit and chip type are not correct, confirm that you are using the correct kit
and chip. If you are using the correct kit and chip, and an incorrect kit or chip type appears on the
screen, contact Technical Support.

9. On the Run Options screen, tap the appropriate option to complete the run, then enter the desired
time of run completion if needed.

Run Options

s 08:00PM PDT

Choose the approximate time

you want your run to end. Run ends: Tuesday
Current time: 2:35pm PDT

Pause

: 3 07:06PM PDT
Run will pause at the time shown

for you to analyze templating efficiency.

[ start run

The lon Chef™ Instrument provides two options for obtaining a quality control (QC) sample that
can be used to evaluate templating efficiency. Depending on your selection, the QC sample will
be made available either during or after the run. In either case, you can obtain unenriched sample
from the Library Sample Tube at Position A on the Reagents cartridge, or enriched sample from
Position E on the Enrichment Cartridge v2.

By selecting You can obtain the QC samples Apprommat;:rrtne after run
Time immediately after the run ends, at the time you specify: 4 hours 50 minutes
Pause when the instrument pauses operation before the chip 4 hours 15 minutes!!!

loading step:

' An additional 1 hour is required for chip loading to complete the run. Total run time is longer because an extra centrifugation
step is required with the Pause option.
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Start the lon Chef™ run

Note: Select Pause if you are uncertain of library quality and want to evaluate templating
efficiency before the chip is loaded. If you do not pause the run, you can collect QC samples
after the run. Save the samples until sequence analysis is complete to have them available for
troubleshooting.

10. On the Run Options screen, tap Start run to start the run.

Note: If you need to stop the run for any reason, tap Cancel, then tap Yes to confirm the
cancellation.

If the lon Chef™ Instrument encounters a problem during the run, it aborts the run and displays the
error on the instrument touchscreen. If a run fails, perform the following tasks.

a. Remove the consumables from the deck, then clean the instrument. If possible, retain the
consumables for troubleshooting.

b. Reset, then attempt to start the run again. If the run fails again, contact Technical Support to
troubleshoot the problem. Record the error message for reference.

11. Initialize the sequencer at least 50 minutes before the lon Chef™ System finishes chip loading. See
Chapter 7, “Initialize the sequencer”.

12. If you chose to pause the run to analyze the templating efficiency, remove the sample for testing
when prompted to do so by the lon Chef™ Instrument (approximately 4 hours 15 minutes into the
run).

a. When prompted to remove the QC sample, open the instrument door.

Process Paused

A

Run Paused. Please collect QC sample. Close door and press resume
when ready.

! Continue
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Start the lon Chef™ run

b. Transfer the entire volume of the QC sample from Position A of the lon S5™ EXT Chef
Reagents cartridge on the instrument deck to a new labeled microcentrifuge tube.

IMPORTANT!
. Do not remove the Library Sample Tubes from the lon S5™ EXT Chef Reagents cartridge.

. If you unintentionally close the instrument door before you obtain the QC sample, you must
wait until the end of the run before you can collect it. You cannot pause the run or open the
door after it has been closed.

000

00000000
00000000

— —
(. J

@ Position A (QC sample)

c. If you are performing quality assessment of an enriched sample, transfer the QC sample from
Position E of the Enrichment Cartridge v2 to a new labeled microcentrifuge tube.

d. Analyze the QC sample. For more information, see “Quality control of ISPs” on page 149.
€. Close the instrument door, then tap Continue to complete the run.

13. When the run is complete, unload the lon Chef™ Instrument and sequence the chip immediately.
You can collect QC samples from the Reagents and/or Enrichment cartridges if you have not done
so already.

IMPORTANT! Liquid may be present in the chip wells after the lon Chef™ run. Do NOT remove
any residual liquid from the wells.

Note: If you cannot sequence a loaded chip immediately, place the chip into a separate chip
storage container and store at 4°C until you are ready to sequence it (up to 6-8 hours maximum).
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Unload the chip for sequencing =~

Unload the chip for sequencing

1. Open the instrument door.
a. In the instrument touchscreen, tap (&) (Open Door), then wait for the latch to open.

b. Lift the instrument door to the top of the travel until the latch mechanism engages.

(D) Hold here, then lift

2. Open the lid of the Chip-loading centrifuge, then unload the adapter/chip/bucket assembly from
the instrument.

@ Remove the adapter/chip/bucket assembly

3. Unload the chip from the adapter/chip/bucket assembly.
a. Apply pressure to both ends of the Chip Adapter, then remove and discard the Chip Adapter.
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""" Unload the chip for sequencing

b. Grasp the chip by its edges, carefully lift the chip out of the bucket, then set it aside on a
clean, static-free surface. Return the bucket to the Chip-loading centrifuge.

@ Chip Adapter

(2 lon Chip™

(3 Bucket

@ Press, then remove adapter
(5 Remove from bucket carefully

4. Close the instrument door by first lifting it slightly to disengage the locking mechanism, then push
down on the door until the locks engage.

IMPORTANT! Do not close the door by pulling it straight down from the open position. You must
lift the door slightly before you can close it. Ensure that both sides of the door are locked after
closing it.

(D) Lift door first

@ Lower

(3) Press down to lock
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Unload the chip for sequencing

5. Load the chip into a sequencer, then promptly start the sequencing run.
If you cannot sequence a loaded chip immediately or plan to sequence two chips per initialization,
place the chip into a separate chip storage container and store at 4°C until you are ready to
sequence it (up to 6-8 hours maximum).

IMPORTANT!
. Liquid may be present in chip wells after the lon Chef™ run. Do NOT remove any residual liquid

from the wells.

. If you choose to store a loaded chip, remove the chip from 4°C storage (but keep it in the
storage container) at least 20 minutes before running it, allowing the chip to warm to room
temperature.
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B lon S5™ and lon GeneStudio™ S5 System component positions ............oeeeeiiiinnnn.. 88
B Before you begin ... ... e 89
B When a manual cleaning of the sequencerisrequired ............. ... .. i, 89
B nitialize the SEqUENCEY . .. .. . e e e e e e e 90

Initialization takes ~50 minutes.

Note: The instructions in this chapter also apply to both lon S5™ Systems and lon S5™ XL Systems.

lon S5™ and lon GeneStudio™ S5 System component
positions

Note: These positions also apply to lon S5™ Systems and lon S5™ XL Systems.

(1) Touchscreen

(2 Power button

@ lon S5™ Sequencing Reagents cartridge

@ Chip clamp

(®) lon S5™ Wash Solution bottle. The waste reservoir is located behind the lon S5™ Wash Solution bottle (shown on the
right).

(&) lon S5™ Cleaning Solution bottle

(@) Waste reservoir
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Before you begin

Note:

. The system uses RFID technology to verify that the proper reagents are loaded in positions 3, 5, and
6. Reagents that exceed their expiration date or usage count generate an error message prompting
you to replace the reagent before performing the run.

. RFID regulatory information is on the main screen under Options » Regulatory info.

Before you begin

The lon S5™/lon S5™ XL and lon GeneStudio™ S5 Series Sequencers are equipped to verify the
compatibility of each chip and consumable that is loaded during initialization and sequencing, and
that these components do not exceed their expiration date. To avoid exceptions during initialization,
inspect this information for each consumable before installing onto the instrument.

* Unbox the lon S5™ ExT Sequencing Reagents cartridge 45 minutes before use, then allow it to
equilibrate to room temperature.

Do not remove the lon S5™ ExT Sequencing Reagents cartridge from its packaging until
immediately before loading, so that you can return the unused cartridge to storage if your
sequencing run is delayed.

* Unbox the lon S5™ ExT Wash Solution bottle. Invert the bottle 5 times within its vacuum-sealed
bag, then swirl at an angle to mix thoroughly.

* Remove the lon S5™ ExT Wash Solution bottle from its vacuum-sealed bag, then remove the red
cap from the lon S5™ ExT Wash Solution and lon S5™ Cleaning Solution bottles immediately before
installing on the instrument.

When a manual cleaning of the sequencer is required

The lon S5™/lon S5™ XL and lon GeneStudio™ S5 Series Sequencers require that a cleaning be
performed before initialization. This is normally performed automatically at the completion of the
previous sequencing run. When two sequencing runs are performed on a single initialization, the post-
run cleaning is performed after the second sequencing run. However, if the "Enable post-run clean"
checkbox is unchecked to allow a second run, and a second run is not performed, the instrument will
not allow the subsequent initialization to proceed until a manual cleaning has been performed. See
“Perform a manual cleaning of the sequencer” on page 150 for more information on how to perform a
manual cleaning.

If a sequencer is initialized and a sequencing run is not started within 24 hours, or a run is not started
or completed due to a power failure or an abort, do not perform a manual cleaning. An instrument reset
run is required before reinitialization. See “Perform an instrument reset run with an initialized sequencer
that is loaded with an unused Reagents cartridge” on page 151 for more information.
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~ U Initialize the sequencer

Initialize the sequencer

1. In the instrument touchscreen main menu, tap Initialize.

O )

Alarms Settings

The door, chip, and Reagent cartridge clamps unlock.

2. When prompted, remove the lon S5™ ExT Wash Solution bottle to access the waste reservoir, then
remove and empty the waste reservoir.

3. Reinstall the empty waste reservoir.

4. Replace the expended lon S5™ EXT Sequencing Reagents cartridge with a new cartridge
equilibrated to room temperature.

5. Ensure the new lon S5™ ExT Wash Solution bottle is thoroughly mixed. Then remove the red cap
and install.

6. Ensure that the used sequencing chip from the previous run is properly seated in the chip clamp
and the chip clamp is pushed in all the way.
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o7
Initialize the sequencer

7. If necessary, install a new lon S5™ Cleaning Solution bottle.

Note: The lon S5™ Cleaning Solution bottle contains sufficient reagent to complete 4 cleanings.

8. Close the door, then tap Next.

The instrument confirms that the consumables and chip are properly installed and that the lon S5™
Cleaning Solution contains sufficient reagent to perform the post-run clean. Follow all on-screen
recommendations to facilitate proper installation of required consumables.

IMPORTANT! If the allowed number of post-run cleans has been met, the instrument prompts the
user to replace the lon S5™ Cleaning Solution bottle.

Note: If a Checking Reagent: Failed warning appears, see “Bottle leak check fails” on page 138.

9. When initialization is complete (~50 minutes), tap Home.

The instrument is now ready for a sequencing run.

For information on recycling and disposal of used components, see “Reagent consumables disposal”
on page 95.
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Note: The instructions in this chapter also apply to both lon S5™ Systems and lon S5™ XL Systems.

Chip handling guidelines

To place a chip in the chip clamp, perform the steps that are described in the following figure:

(D Slide the chip clamp out.
@ Remove the chip currently in the clamp.
@ Place the appropriate loaded chip in the chip clamp with the chip notch in the bottom-front corner.

Note: Do not force the chip into the clamp. If the chip does not fit easily in the clamp, confirm that the notch is
oriented as shown in the drawing.

@ Slide the metal tab in fully to engage the clamp, then close the instrument door.
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Start the sequencing run

Start the sequencing run

We recommend that you start a sequencing run as soon as possible after chip loading and instrument
initialization are complete. However, successful sequencing runs can be started up to 24 hours after
instrument initialization.

IMPORTANT!

. Do not press the power button during a run. Interrupting power to the instrument during a run can
result in sequencing run failure and loss of sample.

. We recommend that you verify the status of the Planned Run you will use as "Planned" before
inserting the loaded chip. If your Planned Run does not advance to the Planned status in Torrent
Suite™ Software after successful completion of an lon Chef™ run, see “Planned Run status does not
advance to "Planned"” on page 137.

1. After completion of initialization, tap Run in the instrument touchscreen. The door and chip clamp
unlock.

2. Remove the used sequencing chip, then secure a chip loaded with template-positive lon Sphere™
Particles in the chip clamp.

3. Push the chip clamp all the way in to engage, close the instrument door, then tap Next.

Note: Do not remove the chip from the chip clamp until completion of the run. Removing and
reinserting the chip risks introducing air bubbles in the chip.

4. Confirm that the correct Planned Run has auto-populated. If this run is the first of two sequencing
runs on this initialization, deselect the Enable post-run clean checkbox, then tap Review.

IMPORTANT!

. Failure to deselect the checkbox results in a cleaning performed automatically after the first run.
A second run is not available.

. When starting the second sequencing run on a single initialization, ensure that the Enable
post-run clean checkbox is selected so that the post-run cleaning is performed automatically.
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Start the sequencing run

Run Selection

Choose a run plan

Planned Run: AT7RKB - Oncomine_Plan

Chip Barcode: |DACA00615

Enable post-run clean

Review

5. Confirm that the remaining pre-populated settings are correct, or tap Edit to make changes if
needed.

Select Run

Confirm the selected run

Run type: AMPS Library name: hg19

Sample: Project

Chip barcode: DABF01278 Post-run clean: true

Flows: 20 Notes: This is a test of use...

Start run

6. Confirm that the instrument door is closed, then tap Start run to begin the sequencing run.

IMPORTANT! During a run, do not open the instrument door, and avoid touching the instrument.
Touching the instrument during the sequencing run can reduce the quality of the measurements.

When the sequencing run is complete, the instrument automatically performs the cleaning
procedure unless the Enable post-run clean checkbox was deselected. After cleaning, the
touchscreen returns to the main menu. Use Torrent Suite™ Software to review the results.

If you are sequencing a second chip on a single initialization, start the second run within 24 hours
of start of initialization.
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Q0
Maintain the sequencer

Maintain the sequencer

Materials required

* Lint-free wipes
* 70% isopropanol
* (Optional) 10% bleach solution

Clean or decontaminate the sequencer

In the event of a spill or leak on or inside the instrument, clean and decontaminate the sequencer.

Note: Dispose of all waste in appropriate liquid or solid waste containers.

1. Remove the lon S5™ ExT Wash Solution bottle, then remove and empty the waste reservoir.
2. Remove the lon S5™ EXT Sequencing Reagents cartridge.
3. Inspect the waste and nucleotide reagent bays for liquid.

4. Use absorbent paper to soak up as much liquid as possible, then wash the affected area with 10%
bleach solution.

5. Wipe the affected surfaces with 70% isopropanol, then allow to air-dry.

Reagent consumables disposal

IMPORTANT! Follow all applicable local, state/provincial, and/or national regulations when recycling or
disposing of lon S5™ reagent consumables.

CO, scrubber removal and disposal

To properly discard the CO, scrubber, you must first remove it from the lon S5™ Sequencing Reagents
cartridge.

1. Invert the lon S5™ Sequencing Reagents cartridge over
an appropriate receptacle to drain all remaining liquid.

2. Wearing gloves, insert the lon S5™ Cartridge Tool firmly
into the CO, scrubber until the flange stops on the top
of the cartridge.

lon S5™ Cartridge Tool
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Reagent consumables disposal

3. Pull straight up on the tool while holding the nucleotide reagent cartridge down.

4. Remove the scrubber from the cartridge tool, then discard the scrubber according to applicable

hazardous waste regulations.

The remaining nucleotide reagent cartridge should be disposed of appropriately.

Recycle lon S5™ Wash Solution and lon S5™ Cleaning Solution bottles

The lon S5™ Wash Solution and lon S5™ Cleaning Solution bottles are made of recyclable plastic.

1.

2.

96

Open the expended bottle by unscrewing the cap.
Remove the cap, sipper, and filter, then pour any residual liquid into an appropriate receptacle.
Rinse the empty bottle with water. Pour out the rinse water into the same liquid waste receptacle.

Recycle or dispose of the clean bottle, cap, sipper, and filter according to applicable regulations.
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About the cleaning protocol

The lon Chef™ System includes an automated cleaning function that must be performed following every
run. The cleaning routine is initiated from the lon Chef™ Instrument touchscreen and is designed to
minimize potential contamination. During the routine, the instrument irradiates the deck with ultraviolet
light for 1 minute after all consumables have been removed from the instrument.

IMPORTANT! Although the lon Chef™ Instrument cleaning routine provides some protection against
contamination, it is not a substitute for good laboratory technique or precautions. When preparing DNA
libraries for use or when preparing the lon Chef™ Instrument, make certain to observe sterile laboratory
procedures at all times to help ensure minimal contamination.

Materials required

* Gloves, powder-free nitrile
* Isopropanol, 70% solution
* Wipes, lint-free

Clean the lon Chef™ Instrument

IMPORTANT! Clean the lon Chef™ Instrument as described in the following pages after every run. To
prevent contamination, do not operate the instrument unless it has been recently cleaned.
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Clean the lon Chef™ Instrument

lon Chef™ Instrument stations

(1) Waste pipette tip position (®) Solutions station

@ Empty Tip Cartridge v2: move to waste pipette tip @ Recovery centrifuges
station (@ Enrichment station

@ Thermal cycler sample block Chip-loading centrifuge

(4) Reagents station

Remove and dispose of used consumables

IMPORTANT!
. Do not discard the empty lon S5™ EXT Tip Cartridge.

. Make sure to transfer the QC samples before you remove and discard the Reagents cartridge.

1. Tap @ (Open Door) in the instrument touchscreen, then wait for the latch to open.

2. Lift the instrument door to the top of the travel until the latch mechanism engages.

(D) Hold here, then lift
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Clean the lon Chef™ Instrument

3. Remove, then discard the PCR Plate with the PCR Plate Frame and Frame Seal v2 from the
thermal cycler sample block in unison.

IMPORTANT! Do not attempt to separate the PCR Plate Frame from the PCR Plate and Frame
Seal v2, as this may cause PCR product to splash and contaminate the instrument deck.

4. Remove, then discard the box of used pipette tips from the waste tip position.

IMPORTANT! Handle the disposable reservoir in the waste tip position with care. During the run,
liquid waste collects in the reservoir. Dispose of the liquid waste by tipping the reservoir on one
corner and pouring the waste into an appropriate waste container:

IMPORTANT! Do not reuse the waste pipette tip rack. Always move the empty lon S5™ ExT Tip
Cartridge from the new tip position to the waste tip position.

5. Move the empty lon S5™ ExT Tip Cartridge to the waste tip position.

6. Remove, then discard the
* Jon S5™ ExT Chef Reagents cartridge
* Jon S5™ Chef Solutions cartridge

¢ Enrichment Cartridge v2

7. Remove, then discard the consumables from the Recovery centrifuges, including the:
* Recovery Station Disposable Lid v2

* Recovery Tubes v2
8. Remove the Chip Balance from the Chip-loading centrifuge. Do not discard.

9. Close the Chip-loading centrifuge lid.
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" Clean the lon Chef™ Instrument

Inspect and clean the Recovery centrifuges and buckets

1. Inspect the Recovery centrifuges, then clean the components if excess liquid is present.

Is liquid present? Action
No Proceed to “Start the cleaning” on page 101.
Yes Clean the centrifuge bowl and buckets as described below.

IMPORTANT! Clean the Recovery centrifuges occasionally, only when excess
liquid is noticeable in the bowl and/or buckets. You do not need to clean the
centrifuges after every run.

IMPORTANT! Wear powder-free, nitrile gloves when cleaning the Recovery centrifuge.

2. Remove the buckets from the Recovery centrifuges. Clean the inside and outside of each bucket
using a lint-free wipe, then place the buckets on a clean, dry surface while you clean the
centrifuge.

(1) Bucket (@ Lint-free wipe

3. Use lint-free wipes to remove all fluid from inside the centrifuge bowl.

@ Inside rim of the centrifuge @ Bottom of the centrifuge bowls

4. Use lint-free wipes treated with 70% isopropanol to clean the following parts.
¢ Inside rim of the centrifuge.
¢ Bottom of the centrifuge bowl.
* Qutside and inside of the centrifuge buckets.
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Clean the lon Chef™ Instrument

Dry the centrifuge and buckets with lint-free wipes.

Install the centrifuge buckets, then close the Recovery centrifuge cover.

@ Buckets (cleaned and installed)

Start the cleaning

1.

2.

Close the instrument door by first lifting it up slightly to disengage the locking mechanism, then
pushing down on the door until the locks engage.

IMPORTANT! Before closing the door, ensure the covers of the Chip-loading and Recovery
centrifuges are closed.

To start the cleaning, tap Next on the lon Chef™ Instrument touchscreen that appears after run
completion.

lon Chef

00:00:00

Complete

Note: You can also clean the instrument at any time starting from the home touchscreen. Tap
Settings » Clean lon Chef.
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Clean the lon Chef™ Instrument

3. Confirm that you have removed all consumables from the lon Chef™ Instrument, except the empty
pipette tip rack in the waste tip position, then tap Next.

Clean Instrument

Step 10of 2
Unload instrument

4. With the door closed, tap Start. The instrument performs a Deck Scan before starting the cleaning
routine. The lon Chef™ Instrument stops ventilation, then illuminates the ultraviolet (UV) light in the
instrument for ~1 minute.

Clean Instrument

Step 20of 2
Check & clean

1. Close door by pushing up to unlock,
then press down to close

2. Press start to begin

CAUTION! The lon Chef™ Instrument emits UV light at 254 nm. Wear appropriate eye wear,
protective clothing, and gloves when working near the instrument. Do not look directly at the UV
light while it is illuminated during the cleaning routine.
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Reanalyze an lon SingleSeq™ & lon AmpliSeq™ Polyploidy Panel combined library run to

view the lon AmpliSeq™ Polyploidy Panel results ...........c.cooiiiie i
ReproSeqSnpANnalysis plugin . ... ..o e

Manually launch an lon Reporter™ Software analysis
workflow

If you planned your run for automatic analysis with lon Reporter™ Software, proceed to step 6.

1. Import your samples into lon Reporter™ Software.

Manually launch an lon Reporter™ Software analysis Workflow ..............c.ccvvevinn...
Visualize aneuploidy analysis results .. ...t e e et e
Copy and edit an lon Reporter™ Software analysis workflow ..............ccoivieeeeinns.

Createandadd anew filterchain ....... ... it e e et

Data analysis

See the lon Reporter™ Software help system for detailed instructions for importing your samples

and defining them in lon Reporter™ Software.

2. In the lon Reporter™ Software Home tab, click Launch analysis after the lonReporterUploader

plugin run is complete.

lon Reporter

tome mm

Dashboard

Quick links to get started

Samples
Samples represent a collection of data (sequence reads) from one or more
sequencing runs

Define sample View samples

Workflows

Workflows are a set of analysis components that have been put together to
[O automate the analysis of your data

Create workfiow View workflows.

Analyses
i+ s+ Analyses represent workflows that have been execuied on a set of samples.
Ve
d
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3. In the Workflow step, select Reproductive from the Research Category menu to view the
aneuploidy workflows. Select a ReproSeq w1.1 workflow from the list, then click Next.

* ReproSeq PGS w1.1
* ReproSeq No Gender PGS w1.1
* ReproSeq Mosaic PGS w1.1

Note:

. The ReproSeq Low-Coverage Whole-Genome baseline is automatically loaded in the aneuploidy
analysis workflows, making creation of a custom baseline for your lon ReproSeq™ analyses
unnecessary.

. To create a new aneuploidy analysis workflow, see “Copy and edit an lon Reporter™ Software
analysis workflow” on page 112.

. The Low-pass whole-genome aneuploidy w1.0 analysis workflow should be used for non-lon
SingleSeq™ libraries only.

4. In the Samples step, select one or more samples.

@ Launch Analysis

. “ n_d

Select the sample you wish to analyze. You can select multiple samples and each one will be treated as a separate analysis. Learn more

Demo_Aneuploidy Go Analyzed: All ~ Clear All

o Sample Gender Sample Type Role Imported By Imported On » Project
(] Demo_Aneuploidy_uBAM Male DNA proband User, lon Apr 29 2022 12:20 AM Unknown
n 20 v items per page 1-10f 1items

5. Click Next twice to advance to the Confirm & Launch step.

6. In the Confirm & Launch step, you can enter a name for the analysis to change the default name,
then click Launch Analysis.

7. Click Analysis » Overview and select the analysis from the Analyses list to review results of the
manually launched analysis. For more information, see the lon Reporter™ Software help system.
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Visualize aneuploidy analysis results

You can view interactive aneuploidy analysis results and customize visualizations in the lon Reporter™
Genomic Viewer (IRGV). With this viewer, you can visualize multiple analyzes at once, zoom in on
chromosomes of interest, and generate reports of the data that you view.

You must have IRGV set as the default viewer for this procedure. For more information, see “Set IRGV
or IGV as the default viewer” on page 148.

Note: When you use aneuploidy analysis workflows, if there are not enough mapped reads to calculate
Called Gender, the analysis will complete successfully and the sample coverage section in the
analysis.log file contains information on why the gender calling failed.

1. Under the Analyses tab, click Overview.

2. Select the Workflow filter and enter ReproSeq to find analyses that used a ReproSeq analysis
workflow, or select a specific analysis workflow filter, such as ReproSeq No Gender PGS w.1.1.

3. Select one or more analyses then click Visualize.
The Analysis Visualization screen opens in the IRGV & Generate Report tab.
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4. Use the interactive view to customize the visualization and generate reports, as needed.
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Figure 2 Aneuploidy analysis results

@ Analysis whole genome view. Provides a genome-wide perspective of the sample data. A chart or graph
is shown for each selected analysis. Click on the chart to zoom in on a region of the genomic data, or a
chromosome, and view more information about your selection throughout the visualization.

(2 Click on this IRGV track to view details about the selected chromosome and view more information about the
chromosome in the tracks below. Or, select data in the whole genome view or Karyogram to view data reflected
in each track below.

@ Click Shift and drag across the x-axis of the ploidy scale to zoom in on a region of the scale and change the
other data in the visualization to reflect the selection.
@ Hover over a tile in the visualization to get the following information.

¢ Start: Start coordinate for the copy number call region.
* End: End coordinate for the copy number call region.
* Ploidy: Called ploidy value. The highest allowable ploidy value calculated by the software is 10.

¢ Expected value: Expected ploidy value for this chromosome. The value is 2 for autosomes and chrX for
females. It is 1 for chrX and chrY for males.

e Start: Start position of the selected tile.
* End: End position of selected tile.
* Ploidy: The calculated ploidy value of the tile. The highest value that will be shown by the software is 11.
* Cytobands: The cytoband range of the tile.
@ Adjustable ploidy scale for selected chromosomes or chromosome regions. Change the track name or track
height for the histogram, or hide the track. See “Adjust IRGV BAM tracks” on page 148 for more information.
@ Adjustable Reference and Preferred Transcript tracks. Change the BAM track name, track height, and track
color, or collapse, squish or expand the track. See “Adjust IRGV BAM tracks” on page 148 for more information.
@ Click in a row of the Gains/Losses table to open a detailed view of a single sample visualization. See “View
single sample aneuploidy details” on page 107 for more information.
The Gains/Losses table shows the following information.
CID (Couple ID): An identifier for the parents of an embryo.
EID (Embryo ID): An identifier for the embryo biopsied and run through the ReproSeq workflow)
Cell# (Cell Num): The number of cells in the sample, if known.
MA: A calculated result the ratio of Mitochondrial DNA and Autosomal DNA.

An: Aneuploidy, shown as An(+) for a copy number gain, and An(-) for a copy number loss. The affected
chromosomes are shown in a comma-separated list.

MAPD (Median Absolute Pairwise Difference): An estimate of coverage variability between adjacent
amplicons.
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WaveSD (Waviness Standard Deviation): Standard deviation of all log2 read count ratios after subtraction of
the contribution of pairwise differences.

Zoom in and out of the chromosome Karyogram, and click Reset to return to the default chromosome view.

(9) Enter a set of chromosomal coordinates in the Search field to zoom into chromosome data, or click on a
chromosome in the Karyogram to view its chromosomal coordinates. Or, view the chromosomal coordinates
when you change the selections in the whole genome chart, IRGV, or Karyogram.

Chromosome Karyogram.

(1) Adjust the MAPD filter.

@ Select a filter chain to apply filters to the data. If you select multiple analyses generated from analysis workflows
with different filter chains that use different confidence settings, the software will apply the filter chain with the
lowest confidence setting to all selected analyses.

@ View the filter change, or filter chain query that is applied to the visualization.

View details about the filter chain, or filter chain query, the total number of genes, and the variants that were
filtered in.

@ Export the visualization, or change the IRGV preferences. See “Set IRGV preferences” on page 146 for more
information.

View single sample aneuploidy details

You can view an interactive view of details from a single sample aneuploidy analysis in the lon
Reporter™ Genomic Viewer (IRGV). This visualization provides a view of the genomic data that you
can zoom in on to view individual chromosomal data, and a table of events that were called. You can
adjust the list of events to show only events that were filtered in for the analysis by the applied filter
chain.

You must have IRGV set as the default viewer for this procedure. For more information, see “Set IRGV
or IGV as the default viewer” on page 148.

1.

2.

In the Analyses tab, click Overview.

Select the Workflow filter and enter ReproSeq to find analyses that used a ReproSeq analysis
workflow, or select a specific analysis workflow filter, such as ReproSeq No Gender PGS w.1.1.

Select one or more analyses then click Visualize.
The Analysis Visualization screen opens in the IRGV & Generate Report tab.

Click in a row of the Gains/Losses table.
The IRGV Details screen opens in a new browser tab.
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Figure 3 IRGV Details screen

@ Analysis Whole Genome View. Provides a genome-wide perspective of the data. Metrics above the view are:

@ Productive Read Count The sum of mapped reads from a sample that align to the autosomes and chrX in
females or to the autosomes and chrX + chrY in males. If the CNV finding parameter Remove Duplicates is
set to True, then the Productive Read Count metric excludes duplicates. Productive reads are the specific
reads that are used to establish the relative coverage of tiles across the sample.

(b) Confidence

@ Filter Chain The filter chain that was applied to the analysis.

(2 Click in a row of the Gains/Losses table to open a visualization with the data charts and a table of the events in
a separate tab. Select an option in the table to see all events, or only events that passed the applied filter chain.

@ Enter a chromosome coordinate in the Search field to zoom into chromosome data, or click on a chromosome
in the Karyogram to view its chromosome coordinate. Zoom in and out of the Karyogram, and click Reset to
return to the default chromosome view.

@ Select a chromosome on the Karyogram to the chromosome coordinate, narrow the focus of the whole genome
view, and update the IRGV tracks to reflect the selection.

@ IRGV tracks. Each track updates dynamically as you select data in the whole genome view or the Karyogram
view.

@ Adjustable ploidy scale for selected chromosomes or chromosome regions. Change the track name or track
height for the histogram, or hide the track. See “Adjust IRGV BAM tracks” on page 148 for more information.

@ Adjustable reference and preferred transcript tracks. Change the BAM track name, track height, and track color,
or collapse, squish or expand the track. See “Adjust IRGV BAM tracks” on page 148 for more information.

Export the visualization, or change the IRGV preferences. See “Set IRGV preferences” on page 146 for more
information.
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Change Y-axis height in Whole Genome aneuploidy visualization

You can expand the height of the Y-axis when you view whole genome aneuploidy analysis results

in lon Reporter™ Genomic Viewer (IRGV). By default the image of the data is 300 pixels high. IRGV
includes the option to double this height to 600 pixels. The expanded view is useful when you review
mosaic data, because more data is shown on a single plot and more space is available between data
points, making the mosaic data more pronounced.

1. Under the Analyses tab, click Overview.
2. Select one or more analyses in the Analysis Results screen, then click Visualize.

3. Inthe IRGV & Generate Report tab, scroll to the bottom of the visualization, then click
IRGV/Export & Preferences » Show IRGV preferences to expand the Preferences section.

Option Description

Expanded Select this option to increase the height of the Whole Genome view to 600 pixels.

Compressed | This is the default setting. Select this option to set the height of the Whole Genome view
to 300 pixels.

Smoothing, no gender, and mosaicism results in IRGV

Analysis 1, Proband:Mosaic_40SingleSeq_065_BC49_ReproSeqMosaicPGSw1.1, Mosaic_40SingleSeq_085_BC49
onfidence fiter=10

MAPD=0.104 €

"‘-‘\—-MWW ] S ——.
length: 39653kb, ploidy: 2.5, confidence: 2.40138, cytoband: 9p24.3p13.1x2.5,
chr9:10000-39663686
-

Figure 4 Example of a mosaic sample
The following lon Reporter™ Genomic Viewer (IRGV) plot shows non-integer ploidy for the short arm of chromosome 9,
indicating that the sample is mosaic.

This image shows five analyses run with various lon Reporter™ Software aneuploidy analysis workflows
that show how smoothing, no gender, and mosaicism appear in IRGV visualizations. Visualization of
aneuploidy detection is enhanced by tile-by-tile data points that appear as easier-to-see circles in the
whole-genome views. All results from IRGV aneuploidy analysis workflows use this enhanced view.

Note: Analyses 2 through 5 have smoothing of the discrete tile data turned on by default. Smoothing of
the discrete data have no effect on the calls that are made by the aneuploidy pipeline in the software.
Smoothing can be turned on or off in any analysis workflow.
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Figure 5 Examples of smoothing, No Gender and mosaicism

@ An analysis launched with the Low Pass Whole-Genome Aneuploidy analysis workflow and the Demo Aneuploidy
sample that is available in the software, with a loss of one copy of chr13 and single copy gains of chrs 14 and 15.
This analysis was run with the earlier version of an lon Reporter™ Software analysis workflow version that does not
include smoothing of the discrete tile data.

@ An analysis launched with the default ReproSeq analysis workflow and the Demo Aneuploidy sample in lon
Reporter™ Software.

@ An analysis launched with the ReproSeq No Gender analysis workflow and the Demo Aneuploidy sample. Use of the
no gender analysis workflow generates analysis results that do not record or show the called gender of the sample

in the software or in data files. Instead, a called gender value of SxChrNrml is given when the sample is either a

normal XY male or a normal XX female with no sex chromosome aberrations. A gender call is SxChrAbnrml when
the sex chromosomes deviate from normal male or normal female by either whole-chromosome or subchromosomal
aneuploid events. Aneuploidies on autosomes do not affect the called gender value, and can be present in samples
with normal sex chromosomes.
@ An analysis launched with the ReproSeq Mosaic analysis workflow and the Demo Aneuploidy sample. Some
chromosomes can look like they were called aneuploid if the copy number is called as CN loss = ploidy 1.95,
or CN Gain = ploidy 2.05 (as shown in this example on chr1), and on the Y chromosome as a slight ploidy gain. Gain

or Loss events with ploidy very near expected normal ploidy can be a result of slight differences in normalization

instead of true biological ploidy changes.
@ An analysis of a spiked-in sample that was mixed to have a chr9p event of relative copy number ploidy of 2.5 and
analyzed through the ReproSeq Mosaic analysis workflow. The two mixed samples consisted of one male and one
female, one of which had an integer copy humber gain of ploidy=3 for chr 9, although the other sample was normal
ploidy=2 for chr 9. The mixing of two samples of different genders can be seen in the observed ploidies of the X and
Y chromosomes.
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Visualization of triploid samples

Mosaic workflows call triploid male biopsies (69, XXY). Mosaic events on chrX and chrY are called in 69,
XXY samples since three copies of autosomes will be normalized to 2N at a ratio of 1.5 (3/2 = 1.5), thus
2N chrX should be called 1.33 (2/1.5 = 1.33) and 1N chrY should be called 0.66 (1/1.5 = 0.66).

MAPD=0.154 Productive Read Count= 150845 Confidence fiter=0.1 Fiter Chain=Aneuploidy Mosaicism

Example genome view plot and table from a 69, XXY sample with chrX called ploidy 1.3 and chrY called ploidy 0.7

View X and Y chromosome data in low-read samples

Aneuploidy samples with low total read counts can yield analysis results where X and Y chromosome
ploidies are not displayed and gender is not called. There are two options you can try to visualize X
and Y chromosome data in this situation, although we recommend that you interpret with caution any
analysis results showing high MAPD values.

* A low-read sample that results in no display of X and Y chromosome data can be analyzed in
a custom aneuploidy workflow with a lower value entered for the parameter "CNV Gender Min
Autosomes Count" (default = 25000). Copy your existing ReproSeq PGS workflow, then edit this
parameter by navigating to Parameters » Cnv Finding » Advanced.

Gender calling

CNV Gender Caller Enable Flag. (Do not enable for non-Aneuploidy workflows. For other
workflows, called gender results may be inaccurate)

Flag to indicate whether Gender caller should be invoked.
@ True © False
CNV Gender Threshold

Specifies threshold ratio of chrY to Autosomes for taking maleffemale call

0=<=7

CNV Gender Min Mapping QV

Specifies min mapping gv of reads to consider in gender calling

0=<= 30 <= 255

CNV Gender Min Autosomes Count

Specifies min number of required filtered reads in autosomes
0 <= 25000

CNV CHRM To Autosomes Ratio Min Mapping QV

Specifies min mapping qv of reads to consider in calculating chrM A Ratio

0=<= 30 <= 255
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* Create a custom aneuploidy workflow with the CNV parameter "Plot Y chromosome for Female
or Unknown Gender" enabled. Copy your existing ReproSeq PGS workflow, then enable this
parameter by navigating to Parameters » Cnv Finding » Advanced and selecting True for this
parameter.

Analysis

Plot ¥ chromosome for Female or Unknown Gender?

Plot Y chromosome for Female or Unknown Gender.
w%True ) False

Note: With this parameter enabled, the analysis displays X and Y chromosome data, but does not
attempt to call the gender. Also, the software calls X and Y chromosome reads as CNV gains by
default, regardless of read count.

See “Copy and edit an lon Reporter™ Software analysis workflow” for further information on how to
copy and edit an lon Reporter™ aneuploidy workflow.

Download additional examples of lon ReproSeq™ PGS data

Additional examples of lon ReproSeq™ PGS datasets and analyses can be downloaded at https://
apps.thermofisher.com/apps/publiclib/#/datasets. Sign in is required.

Copy and edit an lon Reporter™ Software analysis workflow

You can copy and edit an existing lon Reporter™ Software aneuploidy analysis workflow to create a
new analysis workflow. For example, if you copy the ReproSeq No Gender PGS w1.1 analysis workflow,
you can modify the settings to enable mosaicism detection, change the CNV sensitivity, or disable
smoothing.

1. On the lon Reporter™ Software Home tab, click View workflows, and select the Reproductive
research category, then select the Aneuploidy research application. Select the analysis workflow
of interest, then in the Details section, click Actions » Copy.

e workiows

ReproSeq Go
Reproductive - Research Application ~ ~ lon - Target - Group - Version ~ Reference ~
a Research Catego R icati Name Version = Reference = Sample Gro Modified On i =
& oo gory rsi 3 ple Group Details ¢ Actions -
[/ @ ion ® Reproducti i Aneuploid ReproSeq No Gender PGS wi.1 5.10 hg19 Single May 20 2018
09:57 PM I Copy ™ I
@ on torrent Launch Analysis —

[ @ in ® Repoductive i Aneuploidy ReproSeq PGS w1 1 5.10 hg19 Single May 20 2018

09:57 PM Tag for IRU =
ReproSeq No Ge

[} & ion ‘i:: Reproductive _ Aneuploidy ReproSeq Mosaic PGS w1.1 510 hg19 Single May 20 2018 Detects ar and large ¢
09.57 PM abnormalities from a single whole-genome

2. In the Edit screen, click Next, and make any changes that are needed in each step.
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3. In the Parameters step, click Cnv Finding, then change the CNV Sensitivity setting.

Note: Low sensitivity results in fewer false positives, but more false negatives. High sensitivity
results in fewer false negatives, but more false positives. High sensitivity is required to make
segmental aneuploidy calls of ~20 Mbp. Custom sensitivity allows you to change the CNV
Transition Penalty parameter to detect even smaller segmental CNV events more sensitively. See
“Improve detection of small segmental CNV events” on page 115 for further information.

ﬁffg Edit copy of ReproSeq No Gender PGS w1.1_cdb6cd52-f5ee-4933-a2d5-b0fb83435940
Research Reference Annotation Filters Copy Number Plugins Final Report Confirm
Warning! It's not recommended to change these defaulis unless you know what you're doing. Invalid settings will NOT be Summary
saved
Research .
8 - ) ] o Aneuploidy
These are configurable runtime parameters to optimize your workflow. Many fixed and community panels imported from Application:
AmpliSeq.com include optimized variant calling parameters. Learn more. . Sample Group: Single
Reference: hg19
? Annotation Main Advanced Annotations: Aneuploidy
Filter Chain: CNVs of Confide
» Bamstats Analysis (applies to all CNV finding algorithm types except VCIB CNV algorithm) nce = 0.1 - Ge
CNV Sensitivity mmline - CNVs o
? Cnv Finding nly
Sensitivity. Only when CUSTOM option is selected, the value of editable parameter
» Read Mapping Transition Penalty, available in Advanced tab in CNV parameters, will be utilized by the Copy Number:  ReproSeq Low-
algorithm. Coverage Whole
) LOW © MEDIUM © HIGH ® CUSTOM paczomelBasel
ne
Report Default Final Re

Cancel Template: port Template

4. Click the Advanced tab to access more analysis parameter settings.

5. Scroll to the Analysis (applies only to Aneuploidy workflows) section, then make desired
changes.
For example, you can select True under Enable Mosacism Detection to enable mosaicism
detection. When mosaicism is enabled, the software reports a CNV event as a decimal ploidy
value instead of an integer value.
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Analysis (applies only to Aneuploidy workflows)
Remove Duplicates
Remaoves duplicate reads
@ True © False
Enable Mosaicism Detection

Enable Mosaicism Detection

@ True |© False

Enable Smoothing
Enable Smoothing

@ True © False
Hide called gender

Hide gender called by CNV gender calling

@ True © False

To enable mosaicism detection and/or smoothing in a No Gender analysis workflow, copy and edit
the ReproSeq No Gender w1.1 analysis workflow as described. You cannot enable gender hiding
in the other ReproSeq analysis workflows because the Hide called gender setting is locked as
False (gender is called), and cannot be set to True.

Analysis (applies only to Aneuploidy workflows)
Remove Duplicates

Removes duplicate reads

@ True © False

Enable Mosaicism Detection
Enable Mosaicism Detection

@ True © False

Enable Smoothing

Enable Smoothing

@ True © False

Hide called gender

Hide gender called by CNV gender calling

True |@ False

To show Y chromosome data for every sample, whether it is female, male, or unknown, set Plot Y
chromosome for Female or Unknown Gender to True.

The default value for this setting is False, which shows Y chromosome data only if the sample is
male.
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Analysis
Plot Y chromosome for Female or Unknown Gender?

Plot Y chromosome for Female or Unknown Gender.

‘%True ) False

6. Click the Annotation, Bamstats, and Read Mapping links to access additional analysis workflow
parameters. When you have completed your edits, click Next to proceed to the Confirm step.

Note: Do not change parameters from the default settings unless you understand how the change
can affect your analysis.

7. Rename the analysis workflow, then click Save Workflow.
The analysis workflow appears in the list of available lon Reporter™ Software analysis workflows.

Improve detection of small segmental CNV events

You can improve the detection of small segmental CNV events if you adjust the CNV Transition
Penalty parameter in lon ReproSeq™ analysis workflows for use with aneuploidy research. The CNV
Transition Penalty parameter establishes the trade-off between false-positive and false-negative rates.
The transition penalty is a probability that the copy-number state changes for any given random tile. A
smaller probability results in calling of only larger CNV segment sizes, or calling of only segments that
include greater support for the changed state, that is, a greater difference in copy number value from
the current ploidy state.

Low sensitivity results in fewer false positives, but more false negatives. High sensitivity results in fewer
false negatives, but more false positives. High sensitivity is required to make segmental aneuploidy calls
of ~20 Mbp. Custom CNV Sensitivity allows you to change the CNV Transition Penalty parameter to
detect even smaller segmental CNV events more sensitively.

IMPORTANT! Do not change parameters from the default settings unless you understand how the
change can affect your analysis.

You can change the CNV Transition Penalty parameter to any value that does not exceed the highest
allowable for this parameter:

* -1.05 for nonmosaic analysis workflows

e -2.31 for mosaic analysis workflows
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1. In the Workflows tab, click Overview.

2. In the list of analysis workflows, select Aneuploidy from the Research Application list, select the
software version that you use, then sort the list by predefined analysis workflows.

3. Select the analysis workflow of interest, such as the lon ReproSeq™ PGS analysis workflow, then
in the Workflows tab, click Overview, then in the Workflows table, click the row for an analysis
workflow that you want to copy, then click £¢ (Actions) » Copy.

4. In the Create Workflow screen, advance to the Parameters step, then click the Cnv Finding link.
In the Analysis section Main tab, change the CNV Sensitivity setting to Custom, then enter new
values for the parameter.

5. Click Advanced, scroll to the CNV Transition Penalty parameter, then enter the desired value.
The approximate recommended values are:
e -2.33 for mosaic ploidy calling
* -15 for low sensitivity
® -5 for medium sensitivity
e -2.0 for nonmosaic ploidy calling

¢ -3.0 for high sensitivity in mosaic and nhonmosaic analysis workflows

6. In the Confirm step, click Save Workflow.
The following results show a sample analyzed twice with two customized workflows—one with the
CNV Transition Penalty parameter set to -3, and a second with the parameter set to -2.

In this visualization, a 7.9-Mb deletion that is called on chromosome 6 is visible with the slightly higher transition
penalty. |
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Adjust the tile size

Further improvement in sensitivity to detect small segmental CNV events can be obtained by
decreasing the tile size. This adjustment must be accompanied by selection or creation of a CNV
Baseline with a corresponding smaller tile size. Pre-built CNV baselines corresponding to smaller tile
sizes are included in lon Reporter™ Software and are ready to use in customized aneuploidy analysis
workflows. Follow these steps to adjust the tile size parameter in an aneuploidy workflow.

1. In the Create Workflow or Edit workflow screen, navigate to Parameters » CNV Finding. Under
the Advanced tab, scroll to the Analysis (applies only to Aneuploidy workflows) section.
Analysis (applies only to Aneuploidy workflows)
Remove Duplicates
Removes duplicate reads
@ True © False
Enable Mosaicism Detection
Enable Mosaicism Detection
o True @ False
Enable Smoothing
Enable Smoothing
@ True © False
Set Tile Size for Aneuploidy Workflow

Set Tile Size for Aneuploidy Workflow. The tileSize used for creating the Aneuploidy
Baseline must maich the tileSize selected here.

1== <= 100000000

Hide called gender

Hide gender called by CNV gender calling
True @ False

2. For a tile size of 0.5 Mbp, enter 500000 in the Set Tile Size for Aneuploidy Workflow field.
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3. Navigate back to the Copy Number step of the workflow screen, then select ReproSeq Low-
Coverage Whole-Genome (99M read) Baseline - 0.5 Mbp tile from the Baseline dropdown list.

Research Reference Annotation Filters Copy Number Plugins Final Reg

Baselines provide a reference point against which CNVs can be detected. This is required if you wish to detect CNVs in a
single sample analysis. If not provided no CNVs will be called. Learn more...

Baseline Settings

ion ReproSeq Low-Coverage Whole-... ~ Name: ReproSeq Low-Coverage Whole-Genome Baseline

B L L L L S S S I EE I L ]

CNVBase_WholeGenome_3_20_2018_10_45_AM

jon Low-Coverage Whole-Genome Baseline

ReproSeq Low-Coverage Whole-Genome (99M read) Baseline - 0.5 Mbp tile

jon ReproSeq Low-Coverage Whole-Genome (99M read) Baseline - 1 I\)r[fp tile

ma RPanrnSan | maTrvarana Whala-MRannma Q0K raadl Racalina - 7 Mhn tila

4. In the Confirm step, click Save Workflow.
Example of increased sensitivity: a 4.5-Mb deletion is called on chromosome 1 with tile size set to
0.5 Mbp.

MAPD=0.14 Productive Read Count=236651 Confidence fiter=0.1 Filter Chain=CNVs of Confidence >= 0.1 - Germline - CNVs only

a5

: PGS w1.1,v5.10, TP =-2

35
25
2?' ” —— e - v e - s e — aate anandh Anenadiaal =

15

25

2.5 MAPD=0.266 Productive Read Count=236651 Confidence filter=0.1 Filter Chain=CNVs of Confidence >= 0.1 - Germiine - CNVs only

2
4 -— . H H

15 PGS w1.1,v5.10, TP =-2; 0.5 Mbp tile size
25
:

118 lon ReproSeq™ PGS Kits — lon S5™/lon GeneStudio™ S5 Systems User Guide



Chapter 10 Data analysis M

Create and add a new filter chain

Create and add a new filter chain

Modify the CNV Confidence Range

ReproSeq aneuploidy analysis workflows have the CNV Confidence Range set at 0.1 to 1.0E7 as the
default setting. To specify another range for more stringent (1.0 to 1.0E7) or less stringent (0.01 to
1.0E7) CNV filtering, you must first create a new filter chain, then edit an analysis workflow to include

the filter chain.

1. In lon Reporter™ Software, in the Workflows tab, click Presets.

lon Reporter

“ m finalyses forktiows .

Overview

‘i‘ffﬁ Workflows

2. Click Create Preset » Filter Chain.

3. In the Create Filter Chain dialog box, select CNV Confidence Range - CNVs Only from the
dropdown list, and enter the confidence range that the filter chain will use, then click Set.

Create Filter Chain

Name Description

Reference
- GRCh38
@hg19
CNV Confidence Range - CNV... ~

Range: 0.0 — — 1.0E7
From 1.0
To 1.0E7
[#] Include boundary values
[T] Include unannotated variants
Set
L
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4. Enter a name for the filter chain, then click Save.

Create Filter Chain

Name Description

ReproSeq_04302017]

Reference
- GRCh38
@hg19

CNV Confidence Range - CNV... + FilterChain Query

CNV Confidence Range - CNVs Only
Range: 0.0 — — 1.0E7 € Rang Y

From 10
To 1.0E7 Selected Filters
[¥] Include boundary values Name Value
[0 Include unannotaled variants CNV Confidence Range - CNVs Only 1.0 == CNV Confidence Range - CNVs Only <= 1.0E7 i1
Set

oo [ |

5. Select the analysis workflow that you want to edit to add the new filter chain from the list in the lon
Reporter™ Software Workflows tab, then click Edit » Actions in the Details section.

@ ion Research Category Research Application Workflow Name Version Reference Sample Group Modified On Details
Reproductive i Ansuploidy ReproSeq No Gender PGS w1.1_ 5.4 hg19 single Apr 302017
Mosaicism 04:52 PM
) Reproductive £ Aneuploidy hg19 Single Apr 26 2017 Aneuploidy
09:17 AM
ReproSeq No Gender PG
— Detects aneuploidies ang|  -2Unch Arklysis
B Reproductive H Aneuploidy hg19 Single Apr 26 2017 abnormalities from a singli ~ Lock
08:54 AM

with low coverage (Minimu  Tag for RU

Anna ncina an infarmatine

6. In the Filters step of the Edit Workflow screen, select the filter chain that you want to add to the
analysis workflow, then click Next.

7. Click through the remaining steps to make any additional edits, then name the edited analysis
workflow in the Confirm step, and click Save Workflow.

‘%g Edit Workflow copy of ReproSeq No Gender PGS w1.1_c1b4216a-3943-4fef-899¢-84249a012517
Research Application Reference Annotation Filters Copy Number Plugins Final Report Parameters
Workflow configured! Summary
Review the selected options, name your workflow and then save it
Research M " )
Application: G

Workflow Name: copy of ReproSeq No Gender PGS w1 1_Mosaicism|
Sample Group:  Single

Description:  Detects aneuploidies and large chromosome abnormalties from a single whole-  * Reference: hg19
genome sample with low coverage (minimum 0.01x). Normalization is done using Annotaions:  Aneuploidy
an informatics baseline generated from multiple normal samples. For use with the

Fiters: CNVs of Confidence »= 0.1 - Germiine -
CNVs only
Save Wo
el Copy Number:  ReproSeq Low-Coverage Whole-Geno
me Baseline

 Previo Cancel Report
ancel e Default Final Report Template
Template:
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Create an Expected Normal Ploidy Buffer filter chain

For more information, see lon Reporter™ Software help system.

Chapter 10 Data analysis ¥
Create and add a new filter chain

Changing the transition penalty parameter can increase sensitivity of the analysis to detect segmental
mosaic CNV events. However, a side effect of this enhanced sensitivity is increased frequency of false
positives. To filter false positives, you can create an Expected Normal Ploidy Buffer (ENPB) filter chain
and add it to your lon Reporter™ workflow.

By default, the ENPB filter is set to filter out all copy number variant segments of gain or loss

within 0.2 ploidy value of expected normal. With this setting, ploidy changes between 2.2 and 1.8

on autosomes and female X chromosomes are filtered, as are changes between 1.2 and 0.8 on male X
and Y chromosomes. You can customize the amount of buffer by adjusting the range values when you
configure the filter chain. The confidence parameter in the ENPB filter overrides any other confidence
filtering in effect within the buffer zone. ENPB filter chains can be selected in the Filter Chain dropdown
list in the IRGV visualization tab.

1.

In the lon Reporter™ Workflows tab, click Presets.

lon Reporter

“ m finalyses forktiows .

Overview

‘f{fﬁ Workflows

In the Create Preset dropdown list, select Filter Chain.

Import Preset ~ Create Preset ~

Annotation Set

Copy Number Basge

Final Report Template

Details

Annotation sets provide content that is used to annotate your variants. See the help
guide for more information

Select a row to view further details and actions

In the dialog, select Expected Normal Ploidy Buffer from the dropdown list on the left, then

adjust the values in the From and To fields, if needed.

Note: You can type "Expected" in the Choose Filter field to do a quick search of the dropdown

list.
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P55 Create and add a new filter chain

Create Filter Chain Create Filter Chain
Name Description
Name Description
Required Optional
Required Optional
Reference
Reference ©GRCh38
©GRCh38 @hg19
@ng19 9 Expected Normal Ploidy Buffer ~ +
Choose Filter v
o Expected Normal Ploidy Buffer
Expected
Enabled
From 02
To 0.2

4. Scroll to the Confidence section of the dialog, adjust the confidence range parameters, if needed,
then click Set.

Create Filter Chain

To 0.2

Include boundary values

[7] Include unannotated variants

Confidence
Enabled
Range: 0.0 — — 1.0E7
From 01

To 1.0E7

Include boundary values
[7] Include unannotated variants

set
A
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Reanalyze an lon SingleSeq™ & lon AmpliSeq™ Polyploidy Panel combined library run to view the lon AmpliSeq™ Polyploidy Panel
results

5. Enter a name for the filter chain, click Save.

Create Filter Chain
ENPB Optiona
Reference

JGRCh38
@nhg19

m

Expected Normal Ploidy Buffer ~ ~ FilterChain Query

Expected Normal Ploidy Buffer

Expected Normal Ploidy Buffer

[¥] Enabled
Range: -50.0 — — 50.0 Selected Filters
From -
02 Name Value
To 0.2 =
Expected Expected Normal Ploidy Buffer < -0.2 or m
Normal Ploidy Expected Normal Ploidy Buffer > 0.2 AND 0.1
[¥] Include boundary values Buffer <= Confidence <= 1.0E7

—

6. Go to step 5 on page 120 in “Modify the CNV Confidence Range” to add the filter chain to your
workflow.

Reanalyze an lon SingleSeq™ & lon AmpliSeq™ Polyploidy
Panel combined library run to view the lon AmpliSeq™
Polyploidy Panel results

After completion of a combined lon SingleSeq™ & lon AmpliSeg™ Polyploidy Panel library sequencing
run, you need to reanalyze the results in Torrent Suite™ Software to view the lon AmpliSeq™ Polyploidy
Panel library results. To reanalyze the sequencing results you need to edit the Run Plan to include lon
AmpliSeq™ Polyploidy Panel library information, then start a reanalysis.

1. Sign in to Torrent Suite™ Software.
2. In the Data tab, click Completed Runs & Reports.
3. Search, filter, or sort the list to find the run report of interest.

4. Click the report name link for your completed sequencing run to open the Run Report.
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Reanalyze an lon SingleSeq™ & lon AmpliSeq™ Polyploidy Panel combined library run to view the lon AmpliSeq™ Polyploidy Panel

results

5. Click Report Actions » Edit Run Plan, then edit the run plan.

a. For each run planning step complete or verify the following fields.

Item

Action

Research Application step

Set Target Technique to AmpliSeq DNA.

Kits step

1. Set Library Kit Type to lon AmpliSeq Library Kit Plus.
2. Set the Barcode Set to lonCode.

Plugins step

1. Ensure the following plugins are selected.
® coverageAnalysis
* variantCaller
* ReproSegSnpAnalysis
2. Ensure the FilterDuplicates plugin is deselected.

b. Configure the variantCaller plugin. Click Configure next to the plugin name, set the following
values, then click Save Plugin Settings.

® Chip Type - 530

® Library Type — AmpliSeq

® Variant Frequency — Germ Line

® Parameter Settings — Generic - S5/S5XL (510/520/530) - Germ Line - Low Stringency

6. In the Save step, make the following choices.

ltem Selection
Analysis Parameters: Custom
Reference Library: GRCh38.p2.mask1
Target Regions: lon_AmpliSeq_Polyploidy Panel_w1.0.0
Hotspot Regions: lon_AmpliSeq_Polyploidy_Hotspots_w1.0.0
Use same reference & BED files for all barcodes Ensure this is selected.

7. Click Custom to view the detailed custom analysis parameters. Then edit the Pre-BaseCaller for
calibration and BaseCaller parameters to remove: --extra-trim-left 30

8. Update each sample library with an lonCode barcode assignment.

If you have many samples, you can update the existing sample set by importing the sample
information using a CSV file. For more information, see “Create a Sample Set by importing samples

from a CSV file” on page 142.

9. Click Update Run & Reanalyze.
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ReproSeqSnpAnalysis plugin

After a sequencing run is complete, you can manually run the ReproSeqSnpAnalysis plugin in Torrent
Suite™ Software to perform an analysis, regardless of whether the plugin was run automatically after a
run. You may need do this to run an updated version of the plugin or to configure the plugin for use with
Sibling QC.

For general information about manually running the ReproSeqSnpAnalysis plugin, see “Run the plugin
manually from the sequencing run report” on page 125.

For detailed instructions about running the ReproSegSnpAnalysis plugin for Sibling QC, see “Run the
plugin manually from the sequencing run report for Sibling QC data” on page 126.

Run the plugin manually from the sequencing run report

This procedure provides general instructions for manually running the ReproSeqSnpAnalysis plugin.

For detailed instructions about running the ReproSeqSnpAnalysis plugin for Sibling QC, see “Run the
plugin manually from the sequencing run report for Sibling QC data” on page 126.

1. Sign in to Torrent Suite™ Software.

2. In the Data tab, click Completed Runs & Reports, then click the report name link for the
completed sequencing run.

3. Click Plugins » Select Plugins to Run, then click ReproSegSnpAnalysis plugin.

4. In the Configure Plugin screen, the following plugin options are displayed. If needed, change the
options, then click Submit to start the analysis.

* Reference Genome: GRCh38.p2.mask1. (Prepopulated from the run and cannot be changed.)

¢ variantCaller run: Prepopulated with the last run of the variantCaller plugin. (Optional) If the
prepopulated run is not the correct run, select a different run from the dropdown list.

* Target Regions: lon_AmpliSeq_Polyploidy_Panel_w1.0.0 (Prepopulated from Run Plan.)

* Target Hotspots: lon_AmpliSeq_Polyploidy_Hotspots_w1.0.0 (Prepopulated from Run Plan.)

¢ Barcode to Couple ID: Used when Sibling QC is required from a run. See “Run the plugin
manually from the sequencing run report for Sibling QC data” on page 126.

If the plugin does not require configuration, analysis starts immediately without a confirmation
screen.
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Run the plugin manually from the sequencing run report for Sibling QC data

When Sibling QC information is needed from a run, a Couple ID file must be uploaded for the sample.
This can only be done manually when the run is complete.

The Couple ID CSYV file is a comma-separated table that specifies the barcodes to use with the
corresponding family name (Couple ID) for the sample.

Before manually running the ReproSeqSnpAnalysis plugin, ensure that a Couple ID file for the run with
the following information has been created. Use a text editor to create the CSV file that contains a
header with "Barcode,Couple ID", followed by rows that include barcodes and the couple ID with
which they are associated as shown in the following example.

0 ~N O VAW N =

A B
Barcode Couple ID
lonCode 0201 V104
lonCode 0202 V104
lonCode_0208 U1463
lonCode_0216 U1463
lonCode_0217 U13291
lonCode 0218 U13291
lonCode 0219 U13291

Note: If viewed using a spreadsheet program, the comma-separated fields of the file are displayed in
separate cells as shown in the preceding figure.

1.

2.

Sign in to Torrent Suite™ Software.

In the Data tab, click Completed Runs & Reports, then click the report name link for the
completed sequencing run.

Click Plugins » Select Plugins to Run, then click ReproSeqSnpAnalysis plugin.

In the Configure Plugin screen, the following plugin options are displayed. Change the options if
needed, then click Submit to start the analysis.

* Reference Genome: GRCh38.p2.mask1 (Prepopulated from the run and cannot be changed.)

¢ variantCaller run: Prepopulated with the last run of the variantCaller plugin. (Optional) If the
prepopulated run is not the correct run, select a different run from the dropdown list.

* Target Regions: lon_AmpliSeq_Polyploidy_Panel_w1.0.0 (Prepopulated from Run Plan.)
* Target Hotspots: lon_AmpliSeq_Polyploidy_Hotspots_w1.0.0 (Prepopulated from Run Plan.)

* Barcode to Couple ID: To upload the Couple ID file, click Choose File, navigate to the
location of the Couple ID file, then click Open.

Review ReproSeqSnpAnalysis plugin results

126

Results from the ReproSeqSnpAnalysis plugin are included in the sequencing run report for the lon
AmpliSeq™ Polyploidy Panel in Torrent Suite™ Software, if the plugin was configured to run automatically
in the Planned Run.
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On the run report screen, in the ReproSeqSnpAnalysis section you can:

* Review the summary of the ReproSeqSnpAnalysis plugin run for each barcode used.

* Review the Sibling QC, Status, Polyploidy, Contamination (maternal contamination), Ploidy
Confidence, Contamination Level (maternal contamination), and MHAP 3rd Alleles.

* Download data files for all barcodes and each individual barcode or sample.

You can also access the detailed ReproSegSnpAnalysis plugin summary report for each barcode
or sample from the ReproSeqSnpAnalysis section on the run report screen. In the detailed
ReproSeqgSnpAnalysis plugin summary report screen, you can:

* View Polyploidy analysis for each barcode.

* Review Sibling Similarity Dendrogram and Sibling Similarity Heatmap.

* Download Barcode Summary Report, Sibling QC Cluster Summary, Sibling QC Pairwise
Similarity Matrix, and Sibling QC k-Cluster Analysis Matrix.

This procedure applies only to sequencing runs that use lon AmpliSeq™ Polyploidy Panel Kits.

1. Sign into Torrent Suite™ Software.

2. In the Data tab, click Completed Runs & Reports.

3. Inthe list of runs, locate the run of interest, then click the link in the Report Name column.

4. In the left navigation menu, click ReproSeqSnpAnalysis plugin to view the plugin results.

* Review the following data for each sample in the run.

Information for barcodes in ReproSeqSnpAnalysis plugin results

Column

Description

Barcode name

The barcode used for the sample.

Sample

A unique identifier for a specific sample.

Couple ID

An optional attribute to identify a group of biologically related samples.
Sibling QC results depend upon on identification of the sibling groups
through the Couple ID attribute. For example, this attribute can indicate a
group of sibling samples or a repeat sample from the same source. If the
Couple ID attribute is not set, the sample name is used as the default value.
Any unrelated samples used as controls should include a distinct value, or
no value, for Couple ID. The value Excluded can be assigned to indicate
that this sample should be ignored for Sample QC analysis. In this case the
Sample QC result will also show Excluded.

Note: Couple IDs are added when the run is planned.
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Information for barcodes in ReproSeqSnpAnalysis plugin results (continued)

Column

Description

SiblingQC

Conclusion about the sibling QC based on alleotypical clustering that is
compared to the expected family grouping that is based on the Couple ID
attribute. This result is not available until all samples have been individually
analyzed. A single sample that is incorrectly annotated for Couple ID, or is
otherwise not the expected sample, such as specifying a Couple ID on an
unrelated or distant family member sample, might have a large distribution on
the Sibling QC analysis.

Values are Pass, Merge, Split, and Fail. Samples with a value of Pass are
those samles that are included in a single similarity cluster with all other
expected family members. Samples with a value of Merge are also are
included in a single similarity cluster with all other expected family members,
but also contain samples from other families. Samples with a value of Split
are members of the majority family within their cluster but one or more
expected family members are within other clusters. Samples with a value

of Fail are not in the majority family of those in which the sample is clustered.

Status

Sample normality status conclusion. Values are Normal Abnormal, and
NOCALL.

Polyploidy

A polyploidy call based on consolidated analysis methods. Values can be:
Diploid, Triploid, Haploid, or NOCALL.

Contamination

Contamination level summary call. Values are High, Low, None, and
NOCALL.

Ploidy Call
Confidence

Qualative ploidy call confidence based on the difference in Assignment
probability scores, agreement with curve fitting and normaility assessment,
mean allele reads, and the number of heterozygous SNP alleles frequencies
that are called. Values are High, Low and Very Low.

Contamination
Level

Predicted contamination based on 2x median MHAP third allele frequencies.

MHAP 3rd Alelles

Microhapolotype targets with a third allele detected, after coverage and
frequency thresholds are applied.

Click a barcode to review a Single Sample Report

Metrics of sample run quality in ReproSeqSnpAnalysis plugin results

Column

Description

Sample Run QC Metrics

Sample Status

Overall call status for the sample that is based on run quality metrics,
anueploidy and/or contamination analysis.

The software uses a default value of 100 minimum number of reads. A low
value, for example, below 50%, is a general indicator of poor run quality
and might reflect the final contamination call.

Values are Normal, Abnormal, Contaminated and NOCALL. A NOCALL
means there is insufficient data to make a confident call, which indicates
that the sample might need to be retested.
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Metrics of sample run quality in ReproSeqSnpAnalysis plugin results (continued)

Column

Description

Amplicons with
sufficient reads

Percentage of all panel amplicons that had at least the minimum number
reads. The software uses a default value of 100 minimum number of
reads. A low value, for example, below 50%, is a general indicator of poor
run quality and might reflect the final cohtamination call.

Alleles mean read
depth

Mean read depth over all targeted SNP and Microhaplotype alleles. A low
value indicates a low quality run.

Maternal
Contamination
Report

Contamination status

Overall contamination assessment that is based on detection of additional
alleles. Values can be High, Low, None or NOCALL. A High call is based
on having both a Predicted contamination of at least 30% with at least 3
Third alleles detected. A None call means there is no significant evidence
for contamination, whereas a Low call means some contamination is
detected but not enough to meet both thresholds for a High call. A
NOCALL means there was insufficient microhaplotype target coverage for
a confident call.

Predicted
contamination

Predicted contamination that is based on 2x median allele frequency.
Analysis assumes that the mother is the most likely source for DNA
contamination. Other sources are likely to produce more alternative alleles
and a higher contamination prediction.

Third alleles detected

Number of Third alleles detected, after read and frequency filters are
applied. When default settings are used, a third allele is detected if at
least 5% of the reads are for the alternative allele.

Amplicons with
sufficient reads

Percentage of all microhaplotype (MHAP) amplicons with at least 50
reads. Only amplicons that meet the threshold value of a minimum
number of 50 reads are used for contamination prediction. If fewer than
50% of the panel amplicons meet this threshold, the result will be a
NOCALL.

Polyploidy Report

Polyploidy Status

Summary polyploidy call. Values are Diploid (normal), Triploid or Haploid.
Higher levels of polyploidy, for example tetraploidy, are not specifically
assessed but are likley to result in Triploid calls. The call is primarily
based on the Assignment probability call but might be a NOCALL if the
Call confidence is very low, based on margins, reads and consensus

in complementary analysis. Triploid samples are very likely to also be
assessed as maternally contaminated.

Call confidence

Qualative ploidy call confidence based on the difference in Assignment
probability scores, agreement with curve fitting and normaility
assessment, mean allele reads, and the number of heterozygous SNP
alleles frequencies that are called. Values are High, Low and Very Low.

Hom allele calls

Total number homozygous SNP hotspots called by the variantCaller
software module and haplotype calls from contamination analysis, filtered
by AF range and quality.
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Metrics of sample run quality in ReproSeqSnpAnalysis plugin results (continued)

Column

Description

Het allele calls used

Total number heterozygous SNP hotspots called by the variantCaller
software module, filtered by AF range and quality.

Hets AF mean

The mean average of the variant heterozygous SNP allele frequencies.
This value is expected to be close to 50% unless there are very few reads
or the sample is Haploid.

Sharpiro test

Call based on the Shapiro-Wilk Test p.value. The null hypothesis is that
the data is distributed normally so a value of 0.05 or greater is used to
indicate the distribution is probably normal.

Hets AF StdDev

The standard deviation in heterozygous SNP allele frequencies. Indicator
of both quality of the run and/or normality of the distribution.

Normal vs. GMM

Call made based on fitting the MAF frequency histogram to a normal
curve or 2 gaussian curves to the data at expected 1/3 and 2/3 mean
variant allele frequencies.

Assignment
probability

Triploidy call based on the mean probablisic assignment of individual
allele frequencies to diploid or triploid samples.

Heterozygous Allele Fi

requency Distribution and Normality Assessment Metrics

/N

Allele frequency histogram for filtered heterozygous calls with a normal fit
curve that is superimposed.

aaaaaaaaaaaaaaaa

ik: 19.4

AsgnProb: 1.2464

Allele frequency histogram for filtered heterozygous calls with a double-
gaussian fit curve that is superimposed. The software uses expected
variant frequencies at 33.3% and 66.7% to generate this graphic.

Download RepreSeq
Analysis Report
summary statistics

Click to download a text summary of the combined Alleleic Imbalance
Report statistics presented above.
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Metrics of sample run quality in ReproSeqSnpAnalysis plugin results (continued)

Column

Description

Download a
summary table of
all allele calls by
chromosome

Click to download a tab-sepatated text table of all variants call summary
for by chromosome, which includes the additonal Microhyplotype allele
calls. The UPD90 is a call for evidence of UPD per chromosome and

is "Yes" if there are at least 90% homozygous allele calls (50% is
expectation) and at least 10 allele calls.

Note: Calls for UPD are not supported by software.

Download a table

of detetected alleles
from contamination
analysis

Click to download a tab-sepatated text table of alleles and their counts for
each amplicon.

Download and review the following reports, graphs and matrixes.

Item

Description

Barcode Summary
Report

A table of the barcode summary that is shown in the ReproSeqSnpAnalysis
plugin results.

Sibling Similarity

Graphic that shows alleleotypic similarity of hierarchial clustering for sibling

Dendrogram QC results.

Sibling Similarity Heatmap that shows alleleotypic similarity clustering.

Heatmap

SiblingQC Cluster Table that compares alleleotypic similarity analysis to expected family
Summary groupings.

SiblingQC Pairwise
Similarity Matrix

Table of alleleotypic similarity values between each pair of samples.

SiblingQC k-Cluster
Analysis Matrix

Table that shows sibling alleltype cluster analysis at all target numbers of
families. The expected number is that defined by the number of individual
sample Couple IDs that are assigned. This output shows samples that

are grouped into subgroups by similarity, as shown by the dendrogram
heirarchy. It is intended for use with troubleshooting results in which
Sibling QC indicates that a sample does not have a Pass status, or for
samples in which expected family relationships are uncertain. A divergence
of family groupings between samples at lower cluster (k) sizes will often
highlight samples that are inconsistent.

Dendogram view

You can download a dendogram diagram that shows the alleotypic similarity of hierarchial clustering for
sibling QC results.

In the run plan for this examle, 12 Couple ID values were assigned as sample attributes. The Couple IDs
define either sibling sets or technical replicates.

The relatively short length of the lines for a clustered set of samples demonstrates the high similarity of
sample replicates.
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Example dendogram

Allelotypic Similarity Dendrogram at 12 Cluster Groups

® T3_R02_NA12564_Diploid_03_BC134

# T3 R02 NA12563 Diploid O3 BC133
® T3_R02_NA12565_Diploid_03_BC135
® T3_R02_NA12562_Diploid_03_BC116

RO2_NA12552_Diploid_03_BC115

2_NA12550_Diploid_03_BC113

T3_R02_NA12551_Diploid_O3_BC114

|
I € T3 R02 NA12887 Diploid 03 BC141

® T3 R0O2_NA12885 Diploid_03_BC140
® T3_R02_NA12893 Diploid_03_BC143
® T3_R02_NA12888_Diploid_03_BC142
T3_R02_NA12619_Diploid_O3_BC138
T3_R02_NA12617_Diploid_O3_BC136
T3_R02_NA12618_Diploid_O3_BC137
T3_R02_NA12623 Diploid_03 BC139
T3_R02_NA07018 Diploid_ 03 BC122

T3

RO2_NA06980_Diploid_03_BC121

R02_NA07047_Diploid_03_BC124

| 4

=
T3_R02_NA07036_Diploid_03 BC123
T3_R02_NA01672_Triploid_O3_BC103
T3_R02_NA01672_Triploid_O3_BC102 @
T3_R02_NA01672_Triploid_03_BC104
T3_R02_NA01672_Triploid_03_BC101
T3_R02_NG05025_Triploid_03_BC132
T3_R02_NG05025_Triploid_03_BC129
T3_R02_NG05025_Triploid_03_BC131
T3_R02_NG05025_Triploid_03_BC130
T3_R02_NA10606_Triploid_03_BC127
T3_R02_NA10606_Triploid 03 BC126
T3_R02_NA10606_Triploid_0O3_BC128
T3_R02_NA10606_Triploid_0O3_BC125
T3_R02_NA10013 _Triploid_O3_BC106
T3_R02_NA10013_Triploid_O3_BC105
T3_R02_NA10013 Triploid_O3_BC108
T3_R02_NA10013 Triploid_O3_BC107

T3_R02_NG06226_Triploid_03_BC119
T3_R02_NG06226_Triploid_03_BC118
T3_R02_NG06226_Triploid_03_BC120
T3_R02_NG06226_Triploid_03_BC117

. Ff'ﬁrf‘ﬁrmrmﬂﬂ

® T3_R02_NA11045_Diploid_O3_BC148
® T3_R02_NA11042_Diploid_O3_BC147
® T3_R02_NA11039_Diploid_O3_BC146
T3_R02_NA11037_Diploid_O3_BC144
® T3_R02_NA11038_Diploid_O3_BC145

Inlp

@ In this example, the dendogram diagram shows 12 clusters, and each cluster is identified by a unique font color.

@ The colored dots at the start of the sample name is associated with the expected family groupings that are based on
the Couple ID.
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Heatmap example
Degrees of similarity between all possible sample pairs are shown by a heatmap.

Example heatmap

Allelotypic Similarity

ID Color

The colored bar on the left side of the heatmap signifies the Couple ID group for the sample that is listed on the right side.
Similarities are represented by the row of colors that correspond to each other sample, and each is identified by the index

of the corresponding sample that is listed on the right side.
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lon Reporter™ Software results

lon SingleSeq™ library preparation

Observation

Possible cause

Recommended action

Library yield is low

Genomic DNA was amplified
inefficiently.

Use the Human CEPH Genomic DNA Control at 15—
60 pg input as a positive control in pre-amplification
and amplification reactions to determine whether
DNA is amplifiable in your system.

Use real-time PCR to monitor amplification.

Check the quality and quantity of positive control
and sample libraries after amplification by running
10 pL aliquots on 2% agarose gels.

Amount of starting material was
insufficient due to loss or
mishandling of cells.

Increase the number of cells in your sample.

Keep the cells on ice.

Do not insert pipette tip into sample - cell(s) may
adhere to the tip after addition of reagent.

Agencourt™ AMPure™ XP Reagent
was over-dried during cleanup.

Do not dry the Agencourt™ AMPure™ XP Reagent
more than 4 minutes.

Percentage of ethanol in wash of
Agencourt™ AMPure™ XP Reagent
was less than 70%.

Prepare 70% ethanol from newly-opened ethanol
reagent bottle.

If preparing from an ethanol reagent bottle that has
been frequently used and has possibly absorbed
water from air, increase the percentage of ethanol in
the wash from 70% to 75%.

Barcode balance in
a pool is poor.

Variation in gDNA input in a pool of
samples was too high.

Avoid pooling single cell samples with multiple cell
samples; that is, pool single-cell samples together
and pool multiple-cell samples in a second pool if
possible.

134
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Setup and operation of the lon Chef™ System

Observation

Possible cause

Recommended action

Instrument does
not display the
home screen when
powered on

Multiple causes are
possible.

1. Power off the instrument, wait 30 seconds, then power
on the instrument.

2. If the instrument fails again, contact Technical Support.

The instrument door
cannot be opened

An obstruction was present
on or around the door
mechanism.

Remove the obstruction blocking the door, then operate the
instrument normally.

A hardware or software
error occurred.

Contact Technical Support to report the problem and for
further assistance.

The instrument stops
during a run

The instrument
encountered an internal
error.

1. Record the error displayed on the instrument display,
then tap OK.

2. Contact Technical Support to report the problem and
for further assistance.

A consumable was
improperly loaded.

Ensure that all consumables are loaded according to the
instructions provided.

Liquid residue is
present in the
Recovery centrifuge
following a run

During normal instrument
operation, a noticeable
coating of liquid can collect
on the bowl and buckets

of the Recovery centrifuge
following repeated runs.

Remove the residue as instructed in “Clean the lon Chef™
Instrument” on page 97.
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Observation

Possible cause

Recommended action

Instrument will not
begin a run

The instrument has
encountered a Deck Scan
error (one or more
consumables are absent or
loaded improperly).

1. Confirm that the touchscreen does not display any
Deck Scan warnings. If alarms are present, note the
error(s) displayed, replace the missing consumable as
directed, tap No when prompted then tap Next to
cancel the run. After returning to the home screen,
restart the run.

2. If the error persists, confirm that:

¢ All buckets are seated correctly in the rotors of the
Recovery and Chip-Loading Centrifuges.

* All cartridges are loaded correctly and are level on
the instrument deck.

* The barcodes of the lon Chef™ Library Sample
Tubes are visible and positioned correctly.

* All tubes are both present and uncapped on the
lon S5™ ExT Chef PGS Reagents (sample tubes,
NaOH tube, and the empty tube).

3. If the error persists after you check the consumables on
the instrument deck, do one of the following:

¢ [f you are confident that the lon Chef™ Instrument
is set up correctly and you are comfortable
disregarding the warnings, tap YES following Deck
Scan to proceed with the run.

* [f the instrument cannot begin the run, contact
Technical Support for further assistance.

The instrument has
encountered an internal
error.

1. Record the error displayed on the instrument display,
then tap OK.

2. Contact Technical Support to report the problem and
for further assistance.

Instrument displays
one or more alerts

The instrument detected
one or more problems

After the instrument completes the run, contact Technical
Support. If possible, capture an image of the alert or error

during a run during the run. message to help troubleshoot.
IMPORTANT! The detected problem might impact the
performance of the sequencing run.
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Observation

Possible cause

Recommended action

Instrument displays
one or more alerts
during a run
(continued)

* Network connection
to the server was
interrupted.

* User name or
password was
incorrect.

1. Tap the Instrument status button to view the alert(s).

2. In the Instrument status screen, confirm that the name
of the Torrent Server connection is red.

3. Contact your network administrator to confirm that:

* The Torrent Server can be accessed from the
network port used by the lon Chef™ Instrument. If
not, troubleshoot the network connection.

* The user name and password used by the
lon Chef™ Instrument are valid. If not, contact the
server administrator to renew the credentials.

4. If the alert persists, capture an image of the alert or
error message, if possible, to help troubleshoot, then
contact Technical Support for further assistance.

Planned Run status
does not advance to
"Planned"

Details: The status
of a successfully
completed run
remains listed

as "Reserved"

in Torrent Suite™
Software.

Connectivity was
temporarily lost or
interrupted between the
lon Chef™ Instrument and
Torrent Suite™ Software.

Manually change the status of the run to "Planned".

Sign in to the Torrent Suite™ Software.

2. In the Plan tab, click Planned Runs.

3. For the Planned Run of interest, click £# » Completed
on Chef.

The status changes to "Planned".

lon ReproSeg™ PGS Kits — lon S5™/lon GeneStudio™ S5 Systems User Guide 137




Appendix A Troubleshooting
Set up and operation of lon S5™/lon GeneStudio™ S5 Series System

Set up and operation of lon S5™/lon GeneStudio™ S5 Series
System

Instrument alarms and events

Observation Possible cause Recommended action
Red "Alarms" and/or * Available software | Tap the red Alarms icon to see detailed messages.
Events” message in updates were * |f a message states "Newer Software Available":
Main Menu detected.

IMPORTANT! After updates are installed, the instrument

* Connectivity must be restarted.

issues were
detected. a. In the main menu, tap Settings » Check for
¢ Instrument did not Updates.
detect required b. Select the Released Updates checkbox, then tap
files or hardware. Update.

c. When installation is complete, follow the onscreen
prompts to restart the instrument.

Note: In some cases, the instrument restarts
automatically after software installation.

¢ [f a message states "No Connectivity to Torrent Server",
"No Connectivity to ftp server”, or "Network Manager not
connected", disconnect and re-connect the ethernet cable,
confirm that the router is operational, and verify that the
network is up and running.

* For any other messages:
a. Power off the instrument: On the home screen, tap
Settings » System Tools » Shut Down » Shut Down.
b. Wait 30 seconds, then press the button on the side of
the instrument to power on the instrument.

¢ |[f the red "Alarms" and/or "Events" message still appears
in the main menu, contact Technical Support.

Initialization — General errors

Observation Possible cause Recommended action
Bottle leak check * Bottle seal was not tight. 1. Finger-tighten the bottles.
fails ¢ Bottle was damaged or 2. If the bottle continues to leak, replace the bottle.
defective. 3. If leak check continues to fail, contact Technical
Support.
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lon Reporter™ Software results

Observation Possible cause Recommended action
High MAPD value (>0.3) is observed | Low library read Sequence poorly represented samples
representation (<50,000 to a higher depth by increasing their
reads per sample) occurred. proportional concentration in the sample
library pool.
Reduce the number of samples run per
chip.
Library read representation Repeat preparation of sample libraries.
was normal (>100,000 reads
per sample), but library
quality was poor.
Chromosome X and Y data are The sample exhibited very Sequence poorly represented samples to a
missing in IRGV plots, preventing low total read counts, higher depth.
gender call resulting in no display of X
These samples also tend to show and Y chromosome data. Rgduce the number of samples run per
high MAPD values. See “View X chip-
and Y chromosome data in low-read Navigate to Parameters » CNV
samples” on page 111 for further Finding » Advanced » Gender section
information. and lower the value of the "CNV Gender

Min Autosomes Count" parameter.

Navigate to Parameters » CNV
Finding » Advanced » Analysis and set
the "Plot Y chromosome for Female or
Unknown Gender" parameter to True.
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Install or upgrade plugins

140

On Connect, an administrator can install or upgrade the following.

The ReproSeqSnpAnalysis plugin plugin for use with the lon AmpliSeg™ Polyploidy Panel. This in
Torrent Suite™ Software plugin is supported by Thermo Fisher Scientific but is not preinstalled in
the Torrent Suite™ Software.

You can download the lon-supported ReproSeqSnpAnalysis plugin in Torrent Suite™ Software if

you sign into an account on Connect, and click View all apps, then click the Plugins resource
library.

. Sign in to the Thermo Fisher Connect.

Click the Apps icon (:::).
In AppConnect, under Resource Libraries, click Plugins.

(Optional) Click a category at the top of screen.
The list of plugins is narrowed to only the plugins included that are in the selected category.

Click # to download the ReproSeqSnpAnalysis plugin plugin. Select the checkbox to indicate that
you agree to the terms and conditions, then click Download Plugin.

Either a compressed directory or a debian file that contains the plugin is downloaded to your local
machine.

In Torrent Suite™ Software, click £ (Settings) » Plugins » Install or Upgrade Plugin.
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Create a new run template to change chip types for a planned run

7. Click Select File, browse to the location where you downloaded the plugin file, select the file, then
click Open.
8. In the Install or Upgrade Plugin dialog box, click Upload and Install.

The plugin is now visible in Torrent Suite™ Software.

Create a new run template to change chip types for a
planned run

The default run template provided with the system is locked and changes to the chip type cannot be
made in the software.

Use this procedure to create a new template and change the chip type to be used in a Planned Run to a
lon 510™ Chip or lon 520™ Chip for use with lon ReproSeq™ PGS Kits.

Note: The new template is unlocked and future changes to the chip type can be made in the software.

—

. Sign in to Torrent Suite™ Software.
2. In the Plan tab, in the Templates screen, click Reproductive in the left navigation menu.

3. In the list of templates, find lon ReproSeq Aneuploidy - lon S5 System, then click £*
(Actions) » Export.

4. Save the CSV file to your computet.

5. Using a text editor, open the CSV file and make the following changes, then save the updated file.

* On line 2, change the name of the template by editing the text that follows “Template name
(required),exported lon ReproSeq Aneuploidy - lon S5 System”.

* On line 8, edit the text “Chip type (required),530”, to change the chip number to 510, or 520.

6. From the Torrent Suite™ Software, Plan Templates page, click Upload, then click Upload
Templates.

7. In the Upload Templates dialog, click Select file, navigate to select the updated template CSV
file, then click Load.

The new template is now available in Torrent Suite™ Software, in the Templates screen under the
Reproductive application.
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Create a Sample Set by importing samples from a CSV file

If you have many samples, you can import new samples into Torrent Suite™ Software, or update existing
samples, using a CSV file that contains sample information. If you do not yet have a samples file, you
can create one from an available CSV template that is available in Torrent Suite™ Software. During this
process, you can also create a new Sample Set for the new samples.

1. In the Plan tab, click Samples, then click Import Samples from File.
Templates Planned Runs
Enter Samples Manually Sample Attributes v
Sample Sets

Q- Go Clear Plan Run

If you do not yet have a samples file, create a new samples file from an available samples CSV file.
For more information, see “Create a samples file from a template” on page 142.

2. Upload the samples file, and optionally add a new Sample Set to receive the samples.

a. In the Import Samples section, click Select file, then navigate to sample import file, then
upload the sample import file.

b. Select a Sample Set CSV file, then click Open.

c. Select a Sample Set to receive the samples.

(Optional) To add a new Sample Set to receive the samples, click Add Sample Set, then
complete the Sample Set information.

For information about how to define a Sample Set, see “Sample attributes” on page 143.

3. Click Save & Finish.
The system loads, parses, and validates the file, then, if no errors are found, saves the samples
and Sample Sets.

Create a samples file from a template

If you do not already have a samples file on your computer to use to import samples from a CSV file,
then you can download a samples template and use it to create a samples file.

1. In the Plan tab, click Samples, then click Import Samples from File.

“ Flan m “ n

Import Samples from File Enter Samples Manually Sample Attributes v
Sample Sets

Q- Go Clear Plan Run
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2. In step 1 of the Import Samples section, click Sample File Format to download a sample CSV

template.

The sample file format CSV contains the version of the CSV file in the top row, and sample
attributes in separate columns.

3. To create a new CSV file, copy and paste the contents of your existing sample CSV file into the
new file format.

4. Open the CSV template and enter sample information into the cells.

For information on how to define the samples, see “Sample attributes” on page 143.

5. Save the file to your computer so that is available for use to create a Sample Set.

Sample attributes

When you create a Sample Set, you can enter sample attributes into Torrent Suite™ Software manually
or import samples with a CSV file. Most of the sample information is optional except for Sample
Name. However, some information is required if you transfer data to lon Reporter™ Software, and those
attributes required by lon Reporter™ Software are indicated in the following table.

Attribute

Description

Sample Name

(Required)

The unique name of the sample.

Use any combination of alphanumeric characters, plus spaces, periods (.), hyphens (-),
and underscores ().

This attribute is used by lon Reporter™ Software.

A 255-character limit must be followed for lon Reporter™ Software name validation. If
you are using lon Reporter™ Software, and the actual sample name already exists in
that software, a string such as _v1 or _v2, and so on, is added to the sample name.

Sample External

(Optional) If you manage samples in an external system, for example, a Laboratory

ID Information Management System (LIMS), enter the identifier from that system.

PCR Plate A unique identifier for the 96-well plate used for library preparation and templating.

Position  Select a plate position of A to H.

Barcode Kit The name of the barcode kit used to make a library from the sample. The same barcode
kit must be used for all samples in a Sample Set.

Barcode The name of the specific barcode in the selected barcode kit. Assign a unique barcode

to each sample in a Sample Set.
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(continued)
Attribute Description

Sample ID A unique identification code (SamplelD) for each barcode in a sample. This helps to
track samples or possibly identify misassignment between samples and barcodes in a
sequencing run. The SamplelD is passed to lon Reporter™ Software.
If you manage samples in an external system (for example, a LIMS), you can use the
identifier from that system.
This attribute cannot be changed.
Note: This attribute is optional in Torrent Suite™ Software. However, this value can
be required for planned runs that include automatic upload of data to lon Reporter™
Software.

Control Type The control type used when preparing the sample. If a value is selected, the sample is

identified as a control sample.
e MSI On-Chip Control
¢ No Template Control

Basic Annotations

Description Typically, one or two sentences that describe the sample.

Nucleotide Type | The nucleic acid type or RNA variant type that is associated with the sample:
¢ Unspecified

e DNA
* RNA
e TNA
¢ Fusions

Sample Source The source from which the sample is extracted.

* Blood
* FFPE
e Other

Panel Pool Type |The type of pool that is used by the assay.
¢ Dual Pool
¢ Single Pool
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(continued)

Attribute Description

Gender The biological gender of the sample.

This attribute is used by lon Reporter™ Software.
* Female
* Male

e Unknown

IMPORTANT! If you are using lon Reporter™ Software, do not leave this blank.

Select Unknown if the gender is not known. Several analysis workflows in lon
Reporter™ Software, for example, copy number variation detection and genetic disease
research, are limited when the gender is not known. The analysis workflows can return
unexpected results when the gender is incorrectly specified for a sample.

Type The relationship type for this sample. Type is used in conjunction with Relationship
Group, described below. For example, a relationship group can contain two samples,
one with a type Tumor and another with a type Normal.
The following sample relationships are supported by lon Reporter™ Software:

e Control

* Father

* Mother

¢ Normal

* Sample

¢ Self—Use Self for both a single sample and for the proband sample in a trio. A
single sample is not related to other samples and is analyzed by itself.

* Tumor

Relationship Use Relationship Group to designate a group of multiple related samples within the
Group same Sample Set. For example, DNA and RNA samples from the same sample would
have the same Relationship Group number.

Use a whole number to define a sample as part of a relationship group. It is used in
conjunction with Type. For example, a Sample Set can contain 6 samples, consisting
of 3 groups of 2 related samples each (of types Tumor and Normal). In this case, you
would designate the two samples in each group as part of group 1, 2, or 3. This is
identical to the Set ID in the lonReporterUploader plugin.

Extra Annotations (used for specialized applications, such as preimplantation genetic screening (PGS)
research or oncology research)

Sample The date that the blood sample was drawn.
Collection Date

Sample Receipt | The date that the laboratory received the blood sample.
Date

Cancer Type The type of cancer that is present in the sample.
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(continued)
Attribute Description

Population The super population code assignment for a sample, as defined
by the human 1000 genomes project ( www.internationalgenome.org/faqg/
which-populations-are-part-your-study/). The population is relevant to the analysis
of samples by the TCRB-LR assay workflow in lon Reporter™ Software. The TCRB-
LR analysis workflow produces a haplotype group assignment for samples having a
population attribute of "European”.

Mouse Strains The name of a mouse strain. Choose from a select number of the most common
strains. In lon Reporter™ Software 5.12, the selected mouse strain will not affect lon
Reporter™ Software analysis workflows.

Cellularity % The percentage of tumor cells in the sample. This is a whole number between 1 and
100.

Biopsy Days The post-fertilization time at which the biopsy was taken from an embryo. This is a
whole number.

Cell Number The cell count of the biopsied material.

Couple ID An identifier for the couple. For use with the Reproductive research application.

Embryo ID An identifier for the embryo. For use with the Reproductive research application.

User-defined Attributes

<user defined> If you create additional sample attributes, each attribute is listed here and in the CSV
file. Attributes that are marked as mandatory must be entered for each sample. If you
create an attribute of type integer, only numeric characters (whole numbers) can be
entered for that attribute.

Set IRGV preferences

You can modify the elements that are included in lon Reporter™ Genomic Viewer (IRGV) analysis
visualizations with preferences. To set the preferences, you must first visualize an analysis in the viewer.

1. Under the Analyses tab, click Overview.

2. Select one or more analyses in the Analysis Results screen, then click Visualize.
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In the IRGV & Generate Report tab, scroll to the bottom of the visualization, then click
IRGV/Export & Preferences » Show IRGV preferences to expand the Preferences section.

You can set the following IRGV preferences.

Option

Description

Default mapd
value

This value will be used as default value in the mapd filter.

Default sort
order [1]

The preferred sort order for Aneuploidy analyses (NR, CID, EID or BIOPSY) for the
summary table and tracks. NR sorts by the analysis nr, CID sorts by couple ID, EID
sorts by embryo ID and BIOPSY sorts by biopsy days.

Analysis limit for
BAM tracks

Maximum number of analysis that will include BAM tracks in IRGV (if available).
Loading higher number of tracks would result in longer loading time and also a
crowded view.

Analysis limit for

Maximum number of analysis that will include BED tracks in IRGV (if available).

BED tracks Loading higher number of tracks would result in longer loading time and also a
crowded view.
Limit for By default, the maximum limit of 25000 is used. Reduce this number if you do not

coverage data

want to see the coverage data, or you have problems with the browser, such as
freezing.

Max number
tracks in karyo

By default, 5 tracks are shown. You can set a value of 1 to 10. When you increase
the number of tracks, more space is used in the Karyo view.

Max Ploidy in
Whole Genome
View

Maximum value of the Y-axis (ploidy) in the Whole Genome View graphs.

Display Fixed
Ploidy Lines

You can choose to display fixed ploidy lines at copy number=1 and copy
number=3 across the Whole Genome View.

* true—Select this default setting to display fixed ploidy lines at CN=1 and
CN=3 across the Whole Genome View.

* false—Select this setting to display ploidy lines that are not fixed.

Whole Genome
View Height

You can double the height of the Y-axis when you view whole genome data in
IRGV. The Enlarged view is useful to review mosaic data, because more data is
shown on a single plot and more space is available between data points, so that
the mosaic data more pronounced.

* Compressed—Select this default setting for IRGV images that are 300 pixels
high.

* Expanded—Select this setting for IRGV images that are 600 pixels high.

' This preference can be set only when multiple analyses are selected.

For each value that you want to change in the Preferences section, click Edit next to the value
that you want to change, then enter a new value into the Edit Preferences dialog box, then click

OK.

- When your edits are complete, click Save Preferences.

The preferences are reset to the default settings if you click Reset Preferences.

lon ReproSeq™ PGS Kits — lon S5™/lon GeneStudio™ S5 Systems User Guide

147




Appendix B Supplemental procedures
Set IRGV or IGV as the default viewer

The selected preferences are applied to all analyses that you visualize immediately after you save

your changes.

Set IRGV or IGV as the default viewer

You can set a preference for your account that determines whether lon Reporter™ Genomic Viewer
(IRGV) or Integrative Genomics Viewer (IGV) opens by default when you visualize analyses.

IGV is the genomic viewer that is made by the Broad Institute. IRGV is the faster-loading genomics
viewer that is built into lon Reporter™ Software.

1. Click £3 (Settings) » Account Preferences.

2. In the Account Preferences dialog box, in the IGV launch preference row, select IGV or IRGV,
then click Save.

A visualization opens when you perform the following actions.

To view . ..

Do this. ..

A visualization of one or

) 1. In the Analyses tab, in the Overview screen, enable the checkbox in for the analysis
more analyses in IRGV. you want to visualize, then click Visualize in the upper right corner of the screen.
The visualization opens in the Analysis Visualization screen in IRGV.
A visualization of agene | 1, |, the Analysis Visualization screen, click Variants Table, then click on the locus of

of interest in a separate
browser tab.

interest in the Locus column.

¢ |f the Account Preference is set to IRGV, IRGV is launched in a separate
browser window.

* |f the Account Preference is set to IGV, a JNLP file is downloaded when you
click the locus in the Variants Table. Double-click the file to launch IGV as a
standalone application on your computer.

Adjust IRGV BAM tracks

You can adjust the BAM read coverage track in an lon Reporter™ Genomic Viewer (IRGV) visualization to
make it easier to view the data. When you adjust the BAM read coverage track, it changes the amount
of data that is shown in the plot. For example, you can see more BAM tracks when you use the Squish

setting.

For best results, use the Expanded option to click and view hover help with details about variants and
base calls that are visualized in each read coverage track.

Note: A maximum of 500 aligned reads are shown in each BAM track in lon Reporter™ Genomic Viewer
(IRGV). To see more than 500 aligned reads, use Integrative Genomics Viewer (IGV).
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In an open Analysis Visualization, in the IRGV & Generate Report tab, click £# Actions next to the
read coverage track, then select an option to adjust the view of the track.

Option Description

Expanded | Select this option to view the read coverage track with the maximum visible height for each
BAM track.

Squish Select this option to view reads in the coverage track in a single line that has minimal height for
each BAM track.

Collapse |Select this option to view no BAM tracks and view only the coverage density at the top of the
BAM track.

Quality control of ISPs

Quality control using the Guava™ easyCyte 5 Benchtop Flow Cytometer

The Guava™ easyCyte 5 Benchtop Flow Cytometer can be used for quality assessment of unenriched
and enriched lon Sphere™ Particles generated for up to 400 to 600 base-read sequencing on an lon
S5™/lon S5™ XL Sequencer or lon GeneStudio™ S5 Series Sequencer.

¢ Unenriched sample — Obtain the QC sample from the Library Sample Tube on the lon S5™ ExT
Chef Reagents cartridge at position A.

* Enriched sample — Obtain enriched sample from the tube on the Enrichment Cartridge v2 at
position E.

For details, see the lon Sphere™ Particles Quality Assessment for the lon Proton™ and lon S5™ Systems
Using the Guava™ easyCyte 5 Benchtop Flow Cytometer User Bulletin (Pub. No. MANO0O7496),
available at thermofisher.com.
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Perform a manual cleaning of the sequencer

A cleaning protocol is normally performed automatically at the completion of each sequencing run. If a
cleaning is necessary, perform the following procedure.

1.

150

On the home screen, select Settings » Clean Instrument.
The instrument door unlocks allowing access to the consumables.

Remove the lon S5™ ExT Wash Solution bottle to access the waste reservoir, then remove and
empty the waste reservoir.

Reinstall the empty waste reservoir and a used lon S5™ ExT Wash Solution bottle.

Ensure that the lon S5™ ExXT Sequencing Reagents cartridge and lon S5™ ExT Wash Solution bottle
are properly installed.

IMPORTANT! Perform the cleaning with a used reagent cartridge and wash solution bottle
installed. The cleaning procedure pumps cleaning solution into the wash solution bottle and
reagent cartridge making them unsuitable for sequencing.

Place a used sequencing chip in the chip clamp, then push the chip clamp in all the way to
engage.

. Close the instrument door, then tap Next.

Cleaning takes ~35 minutes to complete. On completion the instrument door automatically unlocks
and the chip and cartridge clamps disengage.

. Proceed to Chapter 7, “Initialize the sequencer”.
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Perform an instrument reset run with an initialized sequencer that is loaded with an unused Reagents cartridge

Perform an instrument reset run with an initialized
sequencer that is loaded with an unused Reagents
cartridge

Cleaning is normally automatically performed at completion of a sequencing run. If an lon S5™/lon
S5™ XL Sequencer or lon GeneStudio™ S5 Series Sequencer is initialized, an instrument reset run is
required to ensure proper cleaning before reinitialization in one of the following situations.

* A sequencing run is not started within 24 hours after initialization.

* A sequencing run is not completed due to a power failure or an abort, and <200 flows occurred
before the stoppage.

Do NOT perform a manual cleaning with an unused, initialized lon S5™ ExT Sequencing Reagents
cartridge.

Note:

. If a power failure or abort occurs during the second of two runs started after a single initialization, a
manual cleaning is sufficient (see “Perform a manual cleaning of the sequencer” on page 150).

. If the number of flows that occurred before a power failure or abort is unknown, perform an
instrument reset run.

To perform an instrument reset run, use the following procedure before reinitialization.

1. In the instrument touchscreen main menu, tap Run.
The instrument door unlocks and the chip clamp disengages.

2. Ensure that a used sequencing chip is in the chip clamp, then push the chip clamp in all the way to
engage.

3. Close the instrument door, then tap Next.

4. When prompted, select Planned Run (none). Ensure that the Enable post-run clean checkbox is
selected, then tap Review.

5. In the Select Run screen, tap Edit, then in the Detail screen set the number of flows to 200.
Ensure that the Post-Run/Clean checkbox is selected, then tap Close.

6. Tap Start run, then tap Accept to confirm that Post-Run Clean is enabled, and to start the run.

When the instrument reset run completes, the instrument automatically performs the cleaning
procedure. After cleaning, the touchscreen returns to the main menu.
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Maintain the lon Chef™ System

For further information on the following lon Chef™ System maintenance procedures, see the lon Chef™
Instrument User Guide (Pub. No. MANOO18668), available at thermofisher.com.

Install a firmware update
Change the instrument name
Replace the ultraviolet lamp
Perform an XYO calibration
Perform a Z calibration

Note: You must install the lon Chef™ Instrument firmware update in Torrent Suite™ Software 5.12 or
later to access the XYO calibration and Z calibration routines.

Install a firmware update

152

To optimize proper operation of the lon Chef™ Instrument, we recommend periodically confirming

that your instrument is running the most current firmware. We occasionally release updates to the
instrument firmware, which can include important changes to the lon Chef™ System operation. To

ensure that your instrument is running the most current firmware, check the firmware version, then
update if needed.

1.

2.

On the lon Chef™ Instrument touchscreen, tap Settings.
On the Settings screen, tap Check for updates.

On the Software Update screen, tap Release to search the server for updates to the lon Chef™
Instrument firmware.

Software Update

@ Release Component

C* us InstrumentServer-123
lonChef_gui-62
0S_update-27
GM_update-23

IS_scripts-61

Update

Note: Users are also notified of the availability of firmware updates on the Notifications screen.

Select the available component update, tap Update, then wait for the instrument to complete the
update.

Note: If the lon Chef™ Instrument is operating on an isolated network and cannot connect to our
website, you must transfer the firmware update manually. To perform a manual update, transfer the
firmware files to a USB drive and insert the drive into the USB port at the rear of the instrument.
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Appendix B Supplemental procedures
Maintain the lon Chef™ System

Tap USB on the Software Update screen, select from the list of available software components,
then tap Update.

When finished, the lon Chef™ Instrument displays the update status.

5. Power off and on the lon Chef™ Instrument to complete the update.

IMPORTANT! If you are updating the firmware manually, remove the USB drive before powering
on the lon Chef™ Instrument.

Check the lon Chef™ Instrument firmware

1. On the lon Chef™ Instrument touchscreen, press Settings.
2. On the Settings screen, press Check for updates.

3. On the Software Update screen, press Release to search the server for updates to the lon Chef™
Instrument firmware.

Software Update

@ Release Component

C* us InstrumentServer-123
lonChef_gui-62
0S_update-27
GM_update-23
IS_scripts-61

| Update

Note: Users are also notified of the availability of firmware updates on the Notifications screen.

4. Select the available component update, press Update, then wait for the instrument to complete
the update.

Note: If the lon Chef™ Instrument is operating on an isolated network and cannot connect to our
website, you must transfer the firmware update manually. To perform a manual update, transfer the
firmware files to a USB drive and insert the drive into the USB port at the rear of the instrument.
Press USB on the Software Update screen, select from the list of available software components,
then press Update.

When finished, the lon Chef™ Instrument displays the update status.

5. Power off and on the lon Chef™ Instrument to complete the update.

IMPORTANT! If you are updating the firmware manually, remove the USB drive before powering
on the lon Chef™ Instrument.
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Change the instrument name

The following procedure describes how to change the name that is used to identify the lon Chef™
Instrument both on the network and in the data that it generates.

1. In the lon Chef™ Instrument home screen, tap Settings.
2. In the Settings screen, tap Instrument settings.

3. In the Instrument Settings screen, tap Set Instrument Name. Tap in the Instrument name field,
enter a new instrument name using the keypad that appears, then tap Save.

Note: Use only alphanumeric characters. Do not use special characters or spaces in the name.

Instrument Name

Instrument name

4. In the next screen, tap Save again. Power off and on the lon Chef™ Instrument to effect the name
change.

Replace the ultraviolet bulb

Replace the ultraviolet (UV) bulb after about 500 hours of use. Contact your local field service engineer
to schedule a bulb replacement.
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Transfer a Planned Run . ... .. . 166
Undo a Planned Run transfer (administrator) ........... ... . i i 168
Undo a Planned Run transfer (USEr) . ......coiiiiiii it i e e e et iaaaas 169

This chapter describes how to connect the standalone lon Torrent™ Server component of the PGM™,
lon Proton™, lon S5™ XL, or lon GeneStudio™ S5 Prime System to an lon Chef™ Instrument.

Overview

This document describes how to configure the lon Chef™ Instrument to connect with a lon Torrent™
Server. The guide also explains how to connect an lon Chef™ Instrument to the internal lon Torrent™
Server in lon S5™, lon GeneStudio™ S5, and lon GeneStudio™ S5 Plus sequencers. When you connect
to a lon Torrent™ Server, you can use Torrent Suite™ Software to plan and monitor instrument runs,
review run reports, and download run results from the connected instruments.

You can use the following types of network connections to connect a lon Chef™ Instrument to an lon
Torrent™ Server or a lon Torrent™ Server that is embedded in an lon GeneStudio™ S5 Sequencer:

* Alocal area network (LAN) by DHCP IP connection
* Adirect connection
* Alocal area network (LAN) by Static IP connection
If you add multiple lon Torrent™ Servers to a network, you can configure connections between servers,

if you use Torrent Suite™ Software 5.6 and later. Connections that use an lon Mesh configuration,
enable you to do the following:

* Share Planned Runs with lon Torrent™ Servers that are included in the lon Mesh configuration.

* Track reagent and cartridge usage across lon Chef™ Instrument flexible workflows from different
lon Chef™ Instruments connected to different lon Torrent™ Servers.

* View and monitor all runs of interest across multiple lon Torrent™ Servers on the screen in Torrent
Suite™ Software.
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About the lon Chef™ Instrument

The lon Chef™ Instrument is factory-configured for IPv4 TCP/IP communication and includes a fast
Ethernet adapter (100 Mbps) with a RJ45-type connector for integrating the device into a LAN. If the
instrument is connected to a LAN, an active network port must be available/assigned in place before
the scheduled installation date.

If you are activating a newly installed LAN port for your lon Chef™ Instrument, ensure that the LAN has
been configured to allow HTTP-443, SSH-22, and FTP-8021 traffic. For additional information, see the
"Networking Requirements" section of the lon Chef™ Site Preparation Guide (Pub. No. MANO0O07956).

About the lon Torrent™ Server

The lon Torrent™ Server is an integral part of the system and includes a quad-port gigabit NIC for direct
communication with the network or instruments such as lon Chef™, lon PGM™, lon Proton™, or lon
S5™ XL/lon GeneStudio™ S5 instruments. When the lon Torrent™ Server is connected to the network,

lon Torrent™ Servers that are on the same software versions and subnet can transfer Planned Runs from
one lon Torrent™ Server to another.

Networking guidelines and best practices

We recommend that you consult a network administrator before connecting the lon Chef™ Instrument to
your laboratory network. See the lon Chef™ System Site Preparation Guide (Pub. No. MANO007956) for
more information about the lon Chef™ Instrument networking requirements.

Network setup workflow

Collect the required network information.
v

Connect the lon Chef™ Instrument to the configured LAN port.
v

Configure the lon Chef™ Instrument with the required information.
v

Monitor the lon Chef™ Instrument to test the network connection.

v

Share Planned Runs and monitor consumables with lon Mesh.
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Network connection examples

This guide provides a basic description of how to integrate the lon Torrent™ Server and the
lon Chef™ Instrument into several possible network architectures. Because your network can contain
advanced features, such as a firewall or network domains, we recommend that you consult a network
administrator before connecting the lon Chef™ Instrument to your laboratory network. See the lon Chef™
System Site Preparation Guide (Pub. No. MAN0007956) for more information.
This guide explains the following types of connections:

® DHCP IP (indirect connection)

¢ Direct connection

¢ Static IP (indirect connection)

Collect the required network information

Before you begin the procedures in this guide, obtain the following information from your network
administrator:

* Network policy for obtaining IP addresses (DHCP IP or static IP).

¢ If the network requires static IP addresses, obtain the static IP address, subnet mask, gateway
address, and DNS server name for the LAN port.

Note: For the Planned Run sharing and file transfer protocol (FTP) functionality to be successful, the
subnet must be the same on all lon Torrent™ Servers and lon Chef™ Instruments on the LAN.

Materials required

An ethernet cable with RJ45 connectors (CAT6 Ethernet cable for a 100Mbit/s network connection or a
CATS5 for 100Mbit/s connection).

See lon Chef™ System Site Preparation Guide (Pub. no. MAN0O0Q7956) for additional information.
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General requirements

The following diagrams illustrate common network configurations to which an lon Chef™ Instrument
and lon Torrent™ Server might be added. See the Jon Chef™ System Site Preparation Guide (Pub. No.
MANOO007956) for more information.

DHCP IP
DHCP Server
@ Network
oy
lon Chef Torrent Server

If using DHCP for the LAN port, make sure that the port is set to auto-populate when the lon Chef™
instrument is connected and ensure that all the below requirements are met.

Static IP

Network

e
lon Chef Torrent Server

If the network requires static IP addresses, obtain the static IP address, subnet mask, gateway address,
and DNS server name for the LAN port.

For planned run sharing and FTP functionality to be successful, the subnet must be the same on all lon
Torrent™ Servers and lon Chef™ instruments on the LAN.
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Direct connection

Network
. i .
lon Chef Torrent Server

To configure the direct connection between an lon Chef™ instrument and a lon Torrent™ Server, you will

need a Category 6 cable of sufficient length.

Another direct connection configuration option consists of one lon Chef™ instrument, one lon Torrent™

Server and two lon S5™ XL Sequencers. However, this configuration is not recommended due to

increased analysis times.

Network

Torrent Server

lon Chef

LD (D
Il W

([ ] [ ]

S5 XL 1 S5 XL 2
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lon Chef™ Instrument connection options

When the lon Chef™ Instrument is connected to a server, an icon (£) on the lower left side of the home
screen appears.

on Chef

Connect the lon Chef™ Instrument to the server in one of three ways: DHCP IP (non-direct), Direct, or
Static IP (non-direct).

Connect the instrument directly to the server

You can connect the lon Chef™ Instrument directly the lon Torrent™ Server.

1. Verify the connection of the lon Chef™ Instrument to the lon Torrent™ Server.

a. Plug the connector from the instrument directly into one of the available ports on the back of
the server.

The instrument is assigned a default IP address, for example 192.168.201.1, based on the
server port that you connect to.

b. On the Home screen, tap Settings » Instrument Settings » About » About Instrument, then
verify the IP address for the server connection on the instrument.

About Instrument

Chef Release: IC.5.10.0.RC.1

Ul: 10-00-06
FPGA:
Camera:

Name:

TsLink:

2. Connect the instrument.
a. On the Home screen, tap Settings » Torrent Server.
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b. Verify that the server settings are correct. Ensure that the Torrent Suite™ Software password is
correct.

The Torrent Suite™ Software URL is the IP address of the port you connected to on the back
of the server (192.168.20x.1).

Torrent Server settings

Torrent Server connection

ionadmin(@192.168.201.1 Connected

Update site

The server and instrument are now connected.

3. To set the password, tap Manage, then enter the password to the ionadmin account password on
the selected lon Torrent™ Server.

Manage Connections

t630-1ab01 ite

Username (br r ionadmin

Password [browser) FrEE

4. Tap Save.
The lon Torrent™ Server is connected directly to the lon Chef™ Instrument. An icon (&) appears on the

Home screen on the lower left side. You can now use lon Mesh to share Planned Runs and monitor
consumables.

lon ReproSeg™ PGS Kits — lon S5™/lon GeneStudio™ S5 Systems User Guide 161



Appendix C Connections between lon Torrent™ Server and the lon Chef™ Instrument
lon Chef™ Instrument connection options

Connect the instrument by static IP

If you connect to the lon Chef™ Instrument to the lon Torrent™ Server through the company LAN that

is configured as a Static IP, you need to configure the Static IP, Gateway, Netmask, and DNS Server
Names. (Only one DNS server is required for the instrument.) You also need to modify the server firewall
settings. See “Edit the lon Torrent™ Server firewall tables to allow the LAN port IP” on page 164 for
more information.

1. Go to Settings » Instrument Settings » Network » Configuration.
2. Select Static IP.

3. Enter the addresses and tap Done.

® Network Configuration

IP configuration DHCP (@ Static IP

IP address| 10.45.18.73
Netmask| 255.255.255.0

Gateway | 192.168.1.1

DNS 192.168.1.1

The lon Chef™ Instrument is connected to the lon Torrent™ Server.

Connect by network to the lon Torrent™ Server

To connect to the lon Torrent™ Server through the company LAN, you need to target ServerPortIP
(Eth1), see “Add the lon Torrent™ Server IP address” on page 163 for more information. When the LAN
is set to DHCP, the IP, Gateway, Netmask, and DNS Name Servers populate automatically. You will also
need to modify the lon Torrent™ Server firewall settings. See “Edit the lon Torrent™ Server firewall tables
to allow the LAN port IP” on page 164 for more information.

1. On the Home screen, tap Settings » Instrument Settings » Network Configuration.

2. Select the appropriate IP configuration:

Option Description

DHCP | Dynamic Host Configuration Protocol is a client/server protocol that automatically provides
an Internet Protocol (IP) host with its IP address and other related configuration information
such as the subnet mask and the gateway.

Static IP | Static Internet Protocol (IP) address is a permanent number assigned to a computer by an
Internet Service Provider (ISP).
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3. Ensure that the information is correct, then tap Done.

Network Configuration

The lon Torrent™ Server is connected to the company LAN, an icon (&) on the lower left side of the
home screen appears. You can now use lon Mesh to share Planned Runs and monitor consumables.

Add the lon Torrent™ Server IP address

The first time that an instrument is connected to a lon Torrent™ Server, or any time the connection
configuration is changed, for example from a direct connection to a connection over a network, you
must add the IP address of the server to the instrument. To add the lon Torrent™ Server IP address from

the lon Chef™ Instrument. After you complete this procedure the IP address is available to select on the
lon Chef™ Instrument.

1. Sign in to Torrent Suite™ Software.
2. Click £} (Settings) » Services.

3. Record the server IP address that is displayed on the System Services screen.
Later you will enter the IP address on the instrument screen.

Services

System Services

Hostname P Status Job Count Uptime

tas-docs 10.45.19.226 Running 0 3 days, 22 hours, 31 minutes, 58 seconds
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4. Return to the lon Chef™ Instrument user interface, then tap Manage. The Manage Connections
dialog opens.

Torrent Server settings

Torrent Server connection

ionadmin(@t630-lab01.ite Connected

Update site updates.ite/icu-internal

5. Enter the server IP address or lon Torrent™ Server host name in the Server field and repeat for
Update site. Click Save.

Manage Connections

Server | 10.45.19.226

Username (browser) jonadmin

rd (browser) RAACIDIATD

The lon Torrent™ Server host name or IP address is linked to the lon Chef™ Instrument.

Edit the lon Torrent™ Server firewall tables to allow the LAN
port IP

When connecting through a LAN, the lon Torrent™ Server firewall settings need to be modified for both
DHCP and Static LAN connections.

Note: When directly connected, instruments are on the 192.168.20x.x subnet from which all traffic is
enabled, so modification of firewall settings is not required.

Any exception would mean that editing the local firewall tables to include the LAN IP is required. Also,
if the lon Chef™ Instrument is getting a DHCP address from your network, you need to create an
exception for the entire DHCP subnet.
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Create a firewall exception for an lon Torrent™ Server

Consult your system administrator or Thermo Fisher Field Service Engineer (FSE) or Field Application
Specialist (FAS) for this procedure. On the lon Torrent™ Server, edit the /etc/iptables.custom file and
add a firewall rule to allow all traffic from the IP address of the lon Chef™ Instrument. (This is a blank file
initially and is intended for custom firewall configuration.)

IMPORTANT! Only edit the /etc/iptables.custom file and not /etc/iptables.rules,
because /etc/iptables.rules is overwritten when software is updated.

1. Enter sudo”nano”/etc/iptables.custom, then add the three lines below:

*filter
—A INPUT -s XXX.XXX.XXX.XXX —-J ACCEPT
COMMIT

Note: -A INPUT -s xxx.xXx.xxX.xxx -7J ACCEPT adds the rule to the format. Enter the
IP address of the lon Chef™ instrument in place of "xxx.xxx.xxx.xxx". When finished editing,
save changes by pressing CTRL + O and CTRL + X.

2. After this command, manually apply the change:

sudo”iptables-restore”--noflush”"<"/etc/iptables.custom

Note: You can also list the firewall rules with: sudo”~iptables-L.

If this command returns with no output, it means it succeeded.

3. If the lon Chef™ Instrument is getting a DHCP address from your network, create the exception for
the entire DHCP subnet.

The example below assumes that the DHCP address for the lon Chef™ Instrument is 172.16.48.0
and the DHCP subnet range is 172.16.48.1 to 172.16.48.254. Add these three lines:

*filter
-A INPUT -s 172.16.48.0/24 -j ACCEPT
COMMIT

4. Restart the server.

5. (Optional) If you need to make corrections, repeat this process and completely drop all rules and
start fresh. Enter the following:

sudo”®iptables-F

sudo”iptables-restore”<"/etc/iptables.rules
sudo”iptables-restore--noflush”</"etc/iptables.custom

Removing a rule from either of these files would remove it from the active firewall rules, because
the iptables-restore command does not overwrite rules, it adds them to all active rules.
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Transfer a Planned Run

You can execute a Planned Run on the lon Chef™ Instrument connected to the origin server, and then,
when the run is complete, transfer the Planned Run to a destination server for sequencing.

Alternatively, you can create the Planned Run on an origin server and then transfer it to a destination
server for both the lon Chef™ run and the sequencing run.

1. Sign into Torrent Suite™ Software on the origin lon Torrent™ Server, then go to Plan » Planned Run
List.

2. Click %¥ (Actions) for the Planned Run you want to transfer, select Transfer, then select the
destination lon Torrent™ Server.

Planned Runs
All | by Template | by Sample

Q-  Go Clear

Last
Select RunCode Run Plan Name & Barcodes Application Project Sample f:{?j'e e g;'?ude Moditied » SRS
VXEVS test plan lanxpress n testing 4 Samples . 2?1;"1;(‘05 planned [ R
| Review
4]
mylD myARIcopy lonXpress testing 3 Samples ég{]‘slpa‘h Edit
another tub a01an1) ©°F
oU6Ga BC_nolR sampla for setl lonxpress B libvai test 2 Samples - | ® = 1205p)  Delete
el 2
my local server Transker
DIAT oncomine_pan lonXpress 1 Samples ... 1ot server I pEnneT T g

3. A confirmation dialog appears. Check the information, then click Transfer.

Note: You can no longer access this Planned Run on the origin server after it has transferred.

Confirm Transfer Planned Run
test plan

Are you sure you want to move this Planned Run to Torrent Server test server ?

Transferred planned run will no longer be available on this Torrent Server.

Cancel Transfer

4. A status window displays the results of the transfer:

* The green box lists the samples that are successfully processed, and the required target BED
files that are on the destination server.

* The red box lists any required BED files or plugins that are not present on the destination
server. To perform the run successfully, you must edit the transferred Planned Run on the
destination server and manually add the missing BED files or plugins.
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test plan

Successfully created test plan on Torrent Server test server
-...processed Samples: Sample 2, Sample 3, Sample 1
....Tound BED files: target.bed

..found IR account lonEast IR (Mersion: 4.2 | User: lon User | Org: IR Org)

Planned run data is incomplete, please Edit test plan to fix the following errors
Unable to find bedfile: HSMv12.1_hotspots.bed for reference: hg19

Unable to find bedfile: atarget bed for reference: hg19

Close

5. To edit the transferred Planned Run and add missing files:
a. Download required files from the destination server.

b. In the References tab, click £ (Actions) » Edit from the dropdown list for the Planned Run.

c. In the Edit Plan screen, select the files or plugins if needed, then click Update Plan.

Note: You can also navigate to the Edit Plan screen by clicking the Edit test plan link in the
status page above.

lon ReproSeg™ PGS Kits — lon S5™/lon GeneStudio™ S5 Systems User Guide 167



Appendix C Connections between lon Torrent™ Server and the lon Chef™ Instrument
Undo a Planned Run transfer (administrator)

Undo a Planned Run transfer (administrator)

1. On the destination lon Torrent™ Server, delete the transferred Planned Run from either the Planned
Run screen or the admin screen.

2. On the origin server, locate the plan on the , uncheck PlanExecuted and change PlanStatus to
Planned.

Change planned experiment

AanName iesl_plan
PlanGUID S7ea8 10070 4b0S-Hat ] S BO0STSase
FlanShortiDr VIENWS

PlanExecuted

FlanStatus ‘W
Ui rmhe
Flar PN
Date Date: | 3014-12-05
Time: 140707
PlanExecutedDate Diale
Time
Matalata [t — " o - —ps .

ChipBarcode

SeqetBarcode

ExpMame

o UsePreBeadling

o UsaPostBeadfing

e b

AutoMName
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Appendix C Connections between lon Torrent™ Server and the lon Chef™ Instrument
Undo a Planned Run transfer (user)

Undo a Planned Run transfer (user)

If you transferred a Planned Run in error, you can transfer it back to the origin server or to another
server.

1. On the destination Torrent Server, navigate to Plan » Planned Run List and locate the transferred
Planned Run.

In the row that contains the Planned Run for which you want to undo the transfer, click (Settings)
£* » Transfer, then select the lon Torrent™ Server to which you will transfer the run.
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Safety

WARNING! GENERAL SAFETY. Using this product in a manner not specified in the user
documentation may result in personal injury or damage to the instrument or device. Ensure that
anyone using this product has received instructions in general safety practices for laboratories and
the safety information provided in this document.

. Before using an instrument or device, read and understand the safety information provided in the
user documentation provided by the manufacturer of the instrument or device.

. Before handling chemicals, read and understand all applicable Safety Data Sheets (SDSs) and use
appropriate personal protective equipment (gloves, gowns, eye protection, and so on). To obtain
SDSs, visit thermofisher.com/support.

Instrument safety
General

CAUTION! Do not remove instrument protective covers. If you remove the protective instrument
panels or disable interlock devices, you may be exposed to serious hazards including, but not limited
to, severe electrical shock, laser exposure, crushing, or chemical exposure.

Physical injury

CAUTION! Moving Parts. Moving parts can crush, pinch and cut. Keep hands clear of moving parts
while operating the instrument. Disconnect power before servicing.
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Appendix D Safety
Instrument safety

Electrical safety

WARNING! Ensure appropriate electrical supply. For safe operation of the instrument:

. Plug the system into a properly grounded receptacle with adequate current capacity.
. Ensure the electrical supply is of suitable voltage.

. Never operate the instrument with the ground disconnected. Grounding continuity is required for
safe operation of the instrument.

WARNING! Power Supply Line Cords. Use properly configured and approved line cords for the
power supply in your facility.

WARNING! Disconnecting Power. To fully disconnect power either detach or unplug the power
cord, positioning the instrument such that the power cord is accessible.

Cleaning and decontamination

CAUTION! Cleaning and Decontamination. Use only the cleaning and decontamination methods
specified in the manufacturer's user documentation. It is the responsibility of the operator (or other
responsible person) to ensure the following requirements are met:

. No decontamination or cleaning agents are used that could cause a HAZARD as a result of a
reaction with parts of the equipment or with material contained in the equipment.

. The instrument is properly decontaminated a) if hazardous material is spilled onto or into the
equipment, and/or b) prior to having the instrument serviced at your facility or sending the
instrument for repair, maintenance, trade-in, disposal, or termination of a loan (decontamination
forms may be requested from customer service).

. Before using any cleaning or decontamination methods (except those recommended by the
manufacturer), users should confirm with the manufacturer that the proposed method will not
damage the equipment.

Ultraviolet (UV) Safety

lon ReproSeq™ PGS Kits — lon S5™/lon GeneStudio™ S5 Systems User Guide

The lon Chef™ System uses a UV lamp which emits light at 254 nm. Under normal operating conditions,
the UV lamp is powered on when performing the cleaning protocol. Safety interlocks are used to help
ensure that the UV lamp is not powered when the door is open.

171



Appendix D Safety
Safety information for instruments not manufactured by Thermo Fisher Scientific

Safety information for instruments not manufactured by
Thermo Fisher Scientific

Some of the accessories provided as part of the instrument system are not designed or built by Thermo
Fisher Scientific. Consult the manufacturer's documentation for the information needed for the safe use
of these products.

Instrument safety — lon S5™ and lon GeneStudio™ S5
System

For detailed information on lon S5™ and lon GeneStudio™ S5 System instrument safety symbols and
alerts, safety and electromagnetic compatibility standards, and general instrument safety, see the
Safety appendix of the lon S5™ and lon S5™ XL Sequencer User Guide (Pub. No. MANOO10811), or the
lon S5™ Sequencer User Guide (Pub. No. MANOO17528), available at thermofisher.com.

Chemical safety

WARNING! GENERAL CHEMICAL HANDLING. To minimize hazards, ensure laboratory personnel
read and practice the general safety guidelines for chemical usage, storage, and waste provided
below. Consult the relevant SDS for specific precautions and instructions:

. Read and understand the Safety Data Sheets (SDSs) provided by the chemical manufacturer
before you store, handle, or work with any chemicals or hazardous materials. To obtain SDSs, see
the “Documentation and Support” section in this document.

- Minimize contact with chemicals. Wear appropriate personal protective equipment when handling
chemicals (for example, safety glasses, gloves, or protective clothing).

. Minimize the inhalation of chemicals. Do not leave chemical containers open. Use only with
adequate ventilation (for example, fume hood).

. Check regularly for chemical leaks or spills. If a leak or spill occurs, follow the manufacturer's
cleanup procedures as recommended in the SDS.

. Handle chemical wastes in a fume hood.

. Ensure use of primary and secondary waste containers. (A primary waste container holds the
immediate waste. A secondary container contains spills or leaks from the primary container.
Both containers must be compatible with the waste material and meet federal, state, and local
requirements for container storage.)

. After emptying a waste container, seal it with the cap provided.

. Characterize (by analysis if necessary) the waste generated by the particular applications, reagents,
and substrates used in your laboratory.

. Ensure that the waste is stored, transferred, transported, and disposed of according to all local,
state/provincial, and/or national regulations.

. IMPORTANT! Radioactive or biohazardous materials may require special handling, and disposal
limitations may apply.
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Appendix D Safety
Biological hazard safety

Biological hazard safety

WARNING! BIOHAZARD. Biological samples such as tissues, body fluids, infectious agents,

and blood of humans and other animals have the potential to transmit infectious diseases.

Conduct all work in properly equipped facilities with the appropriate safety equipment (for example,
physical containment devices). Safety equipment can also include items for personal protection,

such as gloves, coats, gowns, shoe covers, boots, respirators, face shields, safety glasses, or
goggles. Individuals should be trained according to applicable regulatory and company/ institution
requirements before working with potentially biohazardous materials. Follow all applicable local,
state/provincial, and/or national regulations. The following references provide general guidelines when
handling biological samples in laboratory environment.

. U.S. Department of Health and Human Services, Biosafety in Microbiological and Biomedical
Laboratories (BMBL), 6th Edition, HHS Publication No. (CDC) 300859, Revised June 2020
www.cdc.gov/labs/pdf/CDC-BiosafetymicrobiologicalBiomedicalLaboratories-2020-P.pdf

. Laboratory biosafety manual, fourth edition. Geneva: World Health Organization; 2020 (Laboratory
biosafety manual, fourth edition and associated monographs)
www.who.int/publications/i/item/9789240011311
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Documentation and support

Customer and technical support

Visit thermofisher.com/support for the latest service and support information.
¢ Worldwide contact telephone numbers
* Product support information
- Product FAQs
- Software, patches, and updates
— Training for many applications and instruments
* Order and web support
* Product documentation
— User guides, manuals, and protocols
— Certificates of Analysis
— Safety Data Sheets (SDSs; also known as MSDSs)

Note: For SDSs for reagents and chemicals from other manufacturers, contact the
manufacturer.

Limited product warranty

Life Technologies Corporation and its affiliates warrant their products as set forth in the

Life Technologies' General Terms and Conditions of Sale at www.thermofisher.com/us/en/
home/global/terms-and-conditions.html. If you have questions, contact Life Technologies at
www.thermofisher.com/support.
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